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These are the main categories in the PhotoFinish help system. Choose a category to see a list of topics 
you can choose from.

 

 

 

 

To learn about PhotoFinish Help features, point to the picture of the key and press the left mouse button.

To learn more about using Windows on-line help, choose How to Use Help from the Help menu in the 
Help program.



Glossary Terms 

Below is the list of glossary terms used in PhotoFinish. To read a definition, point to the word you want 
and press the left mouse button.
active picture window
background color
backup copy
cascading menu
check box
chrominance quantization
click
Clipboard
CMY
color selection box
color tolerance
command button
CONFIG.SYS
constrain
Control menu
cutout
defined area
device independence
double-click
dpi
Draft mode
drag
drop-down list
frame markers
gradient
gray scale
grouped tools

halftone pattern

handles

HLS

icon

list box

luminance quantization

maximize

menu bar

mini-scroll bar

minimize

moiré pattern

natural art tools 

option button

Palette

picas

picture window



pixels

points

posterize

press 

Pressure 

Preview

primary color

printer halftone

Quality mode 

Rate of Flow 

retouch tools

RGB

scanner configuration file

secondary color

soft tools 

Spacing 

temporary files

text box

thumbnail

tile pattern

title bar

Toolbox 

Transparency 

virtual memory

work area 
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The Image Menu 

You use the Image menu commands to enhance pictures, change the color format of pictures, flip, rotate, 
and resize pictures or cutouts, and to clear a picture to the background color. You use Filter commands to 
apply filters, Special Effect commands to apply special effects, and Tune commands to tune up pictures 
or cutouts.
To choose an Image menu command, click Image and choose the command you want. Some commands 
are on cascading menus.
Image Menu Commands 
AutoEnhance: Automatically improves the quality of a picture.

Auto Brightness/Contrast: Automatically adjusts brightness and contrast in the entire picture.

Auto Crop: Automatically crops the entire picture.

Auto Remove Moiré: Automatically removes moiré patterns in the entire picture.

Auto Saturation: Automatically adjusts color saturation in the entire picture.

Auto Sharpen: Automatically sharpens an entire picture.

Auto Straighten: Automatically straightens an entire picture.

Filter Samples: Displays samples of the effects on the picture or cutout of all the available filters.

Filter Add Noise: Creates a textured effect in pictures or cutouts.

Filter Blend: Smoothes pictures or cutouts.

Filter Blur: Blurs pictures or cutouts.

Filter Diffuse: Scatters colors in pictures or cutouts.

Filter Maximum: Brightens blocks in pictures or cutouts.

Filter Minimum: Darkens blocks in pictures or cutouts.

Filter Posterize: Reduces the number of colors in pictures or cutouts.

Filter Remove Moiré: Eliminates unusual patterns that may occur during the scanning process in pictures 
or cutouts.

Filter Remove Spots: Erases spots and blotches in pictures or cutouts.

Filter Sharpen: Enhances detail in pictures or cutouts.

Special Effect Samples: Displays samples of the effects on the picture or cutout of all the available special
effects.

Special Effect Apply Paper: Applies a paper texture to pictures or cutouts.

Special Effect Black Hole: "Pulls" pictures or cutouts toward the center of the area.

Special Effect Crumple: "Crumples" pictures or cutouts.

Special Effect Crystallize: Changes blocks in pictures or cutouts to the most common color. The effect is 
similar to impressionistic paintings.

Special Effect Edge Detect: Enhances edges in pictures or cutouts.

Special Effect Emboss: Embosses pictures or cutouts.

Special Effect Facet: Changes blocks in pictures or cutouts to the middle color. 

Special Effect Fisheye Lens: "Punches" pictures or cutouts, creating an effect similar to using a fisheye 
lens on a camera.

Special Effect Mosaic: Creates a mosaic effect in pictures or cutouts.



Special Effect Motion Blur: Creates movement in pictures or cutouts.

Special Effect Outline: Outlines shapes in pictures or cutouts.

Special Effect Pixelate: Creates a block-like effect in pictures or cutouts.

Special Effect Texturize: Applies a textured effect to pictures or cutouts.

Special Effect Twist: Rotates blocks in pictures or cutouts.

Tune Samples: Displays samples of the effects on the picture or cutout of all the available Tune 
commands.

Tune Brightness and Contrast: Adjusts brightness and contrast in pictures or cutouts.

Tune Color/Gray Map: Adjusts color inaccuracies in pictures or cutouts.

Tune Equalize: Redistributes the shades of colors in pictures or cutouts.

Tune Hue and Saturation: Adjusts for color inaccuracies in pictures or cutouts.

Tune Negative: Reverses colors in pictures or cutouts.

Clear: Replaces the current picture with the selected background color.

Convert To: Converts pictures to another color mode.

Transform Flip Horizontal: Flips pictures or cutouts horizontally.

Transform Flip Vertical: Flips pictures or cutouts vertically.

Transform Rotate: Rotates pictures or cutouts by degrees.

Transform Free Resize: Resizes cutouts freehand.

Transform Resize: Resizes pictures or cutouts by a specified amount.

Info: Displays information about the picture.

Resolution: Changes the resolution of the picture.

Related Topics:
Using Filter Commands
Using Special Effect Commands
Using Tune Commands



Image AutoEnhance Command -- Improving the Quality of a Picture 

To automatically correct your entire picture:    
1 Click Options to change the enhancements PhotoFinish applies to your picture.     
2 Choose Begin.    
3 Choose Accept to keep your changes.    

Related Topics:
Auto Brightness/Contrast command 
Auto Crop command 
Auto Remove Moiré command 
Auto Saturation command 
Auto Sharpen command 
Auto Straighten command 



Changing Your AutoEnhance Options 

To specify the auto enhancement options:

1 Click on the box next to the enhancement you want.     
2 Choose OK to use your new selections.

Related Topics:
AutoEnhance command 



Image Auto Brightness/Contrast Command -- Automatically Adjusting Brightness 
and Contrast    

To automatically adjust brightness and contrast in the entire picture:     
Choose Auto Brightness/Contrast from the Image menu. 

Related Topics:
Tune Brightness and Contrast command 



Image Auto Crop Command -- Automatically Cropping 

To automatically trim the edges of a picture:     
Choose Auto Crop from the Image menu. 

Related Topics:
Crop command 



Image Auto Remove Moiré Command -- Automatically Removing Moiré Patterns 

To automatically remove moiré patterns from the entire picture:     
Choose Auto Remove Moiré from the Image menu.

Related Topics:
Filter Remove Moiré command 



Image Auto Saturation Command -- Automatically Adjusting Color Saturation 

To automatically adjust the saturation in the entire picture:     
Choose Auto Saturation from the Image menu.

Related Topics:
Tune Hue and Saturation command 



Image Auto Sharpen Command -- Automatically Sharpening an Image 

To automatically sharpen the entire picture:     
Choose Auto Sharpen from the Image menu.

Related Topics:
Filter Sharpen command 



Image Auto Straighten Command -- Automatically Straightening an Image 

To automatically straighten the entire picture:     
Choose Auto Straighten from the Image menu.

Related Topics:
Transform Rotate command 



Using Filter Commands 

You use filters to enhance images and create special effects in pictures or cutouts. Selecting the right filter
is easy with the Filter Samples command. The Filter Samples dialog box displays sample buttons you can
use to see how each command can change your picture.
Filters are only one aspect of image enhancement. PhotoFinish also has tools and other commands you 
can use to edit your pictures.
Keep the following in mind when using filters:

All filters are available with gray scale or 24 bit color pictures. Diffuse and Remove Spots are 
available with 256 color pictures. Remove Spots is the only filter available with black and white pictures.

Filters work best when your picture is 24 bit color or gray scale. You can convert your picture to 
one of these color modes.

Filters work fastest with a gray scale picture. Filters require more time with a 256 color picture 
than a 24 bit color picture.

Preview allows you to view changes to your picture before they are made.
Use the Local Undo tool to remove changes in smaller areas, along contours, and pixel-by-pixel.
Undo cancels everything you have done since the last time you chose a tool or command.

Related Topics:
Filter Add Noise command
Filter Blend command
Filter Blur command
Filter Diffuse command
Filter Maximum command
Filter Minimum command
Filter Posterize command
Filter Remove Moiré command
Filter Remove Spots command
Filter Sharpen command
Using Special Effect Commands
Using Tune Commands



Image Filter Samples Command -- Viewing Filter Samples 

To view and select a filter sample:

1 Click Show Samples to display samples of the available filters.     
2 Use the horizontal scroll bar to view samples of more filters.
3 Click the sample you want to use and choose OK.     

Related Topics:
Filter Add Noise command
Filter Blend command
Filter Blur command
Filter Diffuse command
Filter Maximum command
Filter Minimum command
Filter Posterize command
Filter Remove Moiré command
Filter Remove Spots command
Filter Sharpen command
Using Filter Commands
Using Special Effect Commands
Using Tune Commands



Image Filter Add Noise Command -- Adding Texture to Your Picture 

To add texture to pictures or defined areas:    

1 Select the sample button that is closest to the effect you want.     
2 Click the Expand or Shrink button to display more samples based on your selection. Click the 
Recenter button to move the selected sample to the middle of the display.
3 Choose Advanced to manually adjust the settings of the selected button.    
4 Choose OK.    

Related Topics:
Using Filter Commands
Using Special Effect Commands
Using Tune Commands



Image Filter Blend Command -- Blending with the Blend Filter 

To blend pictures or defined areas:    

1 Select the sample button that is closest to the effect you want.     
2 Click the Expand or Shrink button to display more samples based on your selection. Click the 
Recenter button to move the selected sample to the middle of the display.
3 Choose Advanced to manually adjust the settings of the selected button.    
4 Choose OK.    

Related Topics:
Blend Paintbrush tool
Using Filter Commands
Using Special Effect Commands
Using Tune Commands



Image Filter Blur Command -- Blurring Your Picture 

To blur pictures or defined areas:    

1 Select the sample button that is closest to the effect you want.     
2 Click the Expand or Shrink button to display more samples based on your selection. Click the 
Recenter button to move the selected sample to the middle of the display.
3 Choose Advanced to manually adjust the settings of the selected button.     
4 Choose OK.    

Related Topics:
Using Filter Commands
Using Special Effect Commands
Using Tune Commands



Image Filter Diffuse Command -- Diffusing Your Picture 

To scatter colors in pictures or defined areas:    

1 Select the sample button that is closest to the effect you want.     
2 Click the Expand or Shrink button to display more samples based on your selection. Click the 
Recenter button to move the selected sample to the middle of the display.
3 Choose Advanced to manually adjust the settings of the selected button.     
4 Choose OK.    

Related Topics:
Using Filter Commands
Using Special Effect Commands
Using Tune Commands



Image Filter Maximum Command -- Applying the Maximum Filter 

To apply the Maximum filter to pictures or defined areas:    

1 Select the sample button that is closest to the effect you want.     
2 Click the Expand or Shrink button to display more samples based on your selection. Click the 
Recenter button to move the selected sample to the middle of the display.
3 Choose Advanced to manually adjust the settings of the selected button.     
4 Choose OK.    

Related Topics:
Using Filter Commands
Using Special Effect Commands
Using Tune Commands 



Image Filter Minimum Command -- Applying the Minimum Filter 

To apply the Minimum filter to pictures or defined areas:    

1 Select the sample button that is closest to the effect you want.     
2 Click the Expand or Shrink button to display more samples based on your selection. Click the 
Recenter button to move the selected sample to the middle of the display.
3 Choose Advanced to manually adjust the settings of the selected button.     
4 Choose OK.    

Related Topics:
Using Filter Commands
Using Special Effect Commands
Using Tune Commands



Image Filter Posterize Command -- Posterizing Your Picture 

To apply the Posterize filter to pictures or defined areas:    

1 Select the sample button that is closest to the effect you want.     
2 Click the Expand or Shrink button to display more samples based on your selection. Click the 
Recenter button to move the selected sample to the middle of the display.
3 Choose Advanced to manually adjust the settings of the selected button.     
4 Choose OK.    

Related Topics:
Using Filter Commands
Using Special Effect Commands
Using Tune Commands



Image Filter Remove Moiré Command -- Removing Moiré Patterns from Your 
Image 

To remove moiré patterns in pictures or defined areas:    

1 Select the sample button that is closest to the effect you want.     
2 Click the Expand or Shrink button to display more samples based on your selection. Click the 
Recenter button to move the selected sample to the middle of the display.
3 Choose Advanced to manually adjust the settings of the selected button.     
4 Choose OK.    

Related Topics:
Auto Remove Moiré command 
Using Filter Commands
Using Special Effect Commands
Using Tune Commands 



Image Filter Remove Spots Command -- Removing Spots from Your Image 

To remove unwanted spots in pictures or defined areas:

1 Select the sample button for the spot size to remove.    
2 Choose OK.    

Related Topics:
Eraser tool
Using Filter Commands
Using Special Effect Commands
Using Tune Commands



Image Filter Sharpen Command -- Sharpening with the Sharpen Filter 

To sharpen pictures or defined areas:    

1 Select the sample button that is closest to the effect you want.     
2 Click the Expand or Shrink button to display more samples based on your selection. Click the 
Recenter button to move the selected sample to the middle of the display.
3 Choose Advanced to manually adjust the settings of the selected button.    
4 Choose OK.    

Related Topics:
Auto Sharpen command 
Sharpen Paintbrush tool
Using Filter Commands
Using Special Effect Commands
Using Tune Commands 



Using Special Effect Commands 

You use the Special Effect commands to add special effects to pictures or cutouts. Selecting the right 
special effect is easy with the Special Effect Samples command. The Special Effect Samples dialog box 
displays sample buttons you can use to see how each command can change your picture.
The Special Effect commands are only one aspect of image enhancement. PhotoFinish also has tools 
and other commands you can use to edit your pictures.
Keep the following in mind when using the Special Effect commands:

All Special Effect commands are available with gray scale or 24 bit color pictures. Black Hole, 
Crumple, Crystallize, Fisheye Lens, Outline, Pixelate, and Twist are available with 256 color pictures. 
Outline is the only Special Effect command available with black and white pictures.

Special Effect commands work best when your picture is 24 bit color or gray scale. You can 
convert your picture to one of these color modes.

Special Effect commands work fastest with a gray scale picture. They require more time with a 
256 color picture than a 24 bit color picture.

Preview allows you to view changes to your picture before they are applied.
Use the Local Undo tool to remove changes in smaller areas, along contours, and pixel-by-pixel.
Undo cancels everything you've done since the last time you chose a tool or command.

Related Topics:
Special Effect Apply Paper command 
Special Effect Black Hole command 
Special Effect Crumple command 
Special Effect Crystallize command 
Special Effect Edge Detect command 
Special Effect Emboss command 
Special Effect Facet command 
Special Effect Fisheye Lens command 
Special Effect Mosaic command 
Special Effect Motion Blur 
Special Effect Outline command 
Special Effect Pixelate command 
Special Effect Texturize command 
Special Effect Twist command 
Using Filter Commands 
Using Tune Commands 



Image Special Effect Samples Command-- Viewing Special Effect Samples 

To view and select a special effect sample:

1 Click Show Samples to display samples of the available filters.     
2 Use the horizontal scroll bar to view samples of more filters.
3 Click the sample you want to use and choose OK.     

Related Topics:
Special Effect Apply Paper command 
Special Effect Black Hole command 
Special Effect Crumple command 
Special Effect Crystallize command 
Special Effect Edge Detect command 
Special Effect Emboss command 
Special Effect Facet command 
Special Effect Fisheye Lens command 
Special Effect Mosaic command 
Special Effect Motion Blur 
Special Effect Outline command 
Special Effect Pixelate command 
Special Effect Texturize command 
Special Effect Twist command 
Using Filter Commands 
Using Special Effect Commands 
Using Tune Commands 



Image Special Effect Apply Paper Command -- Applying a Paper Texture 

To apply a paper texture to pictures or defined areas:     

1 Click Paper to load a different paper.     
2 Select the sample button that is closest to the effect you want.     
3 Choose Advanced to manually adjust the settings of the selected button.     
4 Choose OK.    

Related Topics:
Special Effect Texturize command 
Using Filter Commands
Using Special Effect Commands
Using Tune Commands



Image Special Effect Black Hole Command -- Applying the Black Hole Effect 

To apply the Black Hole special effect to pictures or defined areas:    

1 Select the sample button that is closest to the effect you want.     
2 Click the Expand or Shrink button to display more samples based on your selection. Click the 
Recenter button to move the selected sample to the middle of the display.
3 Choose Advanced to manually adjust the setting of the selected button from 1 to 100.    
4 Choose OK.    

Related Topics:
Special Effect Fisheye Lens command 
Using Filter Commands
Using Special Effect Commands
Using Tune Commands



Image Special Effect Crumple Command -- Adding a Crumple Effect 

To apply a crumple effect to pictures or defined areas:     

1 Select the sample button that is closest to the effect you want.     
2 Choose Advanced to manually adjust the settings of the selected button.     
3 Choose OK.     

Related Topics:
Using Filter Commands
Using Special Effect Commands
Using Tune Commands



Image Special Effect Crystallize Command -- Crystallizing Your Picture 

To crystallize pictures or defined areas:    

1 Select the sample button that is closest to the effect you want.     
2 Click the Expand or Shrink button to display more samples based on your selection. Click the 
Recenter button to move the selected sample to the middle of the display.
3 Choose Advanced to manually adjust the settings of the selected button.     
4 Choose OK.    

Related Topics:
Using Filter Commands
Using Special Effect Commands
Using Tune Commands



Image Special Effect Edge Detect Command -- Enhancing Edges 

To enhance edges in pictures or defined areas:     

1 Select the sample button that is closest to the effect you want.     
2 Choose Advanced to manually adjust the settings of the selected button.     
3 Choose OK.    

Related Topics:
Special Effect Outline command
Using Filter Commands
Using Special Effect Commands
Using Tune Commands



Image Special Effect Emboss Command -- Embossing Your Picture 

To emboss pictures or defined areas:     

1 Select the sample button that is closest to the effect you want.     
2 Choose Advanced to manually adjust the settings of the selected button.     
3 Choose OK.    

Related Topics:
Using Filter Commands
Using Special Effect Commands
Using Tune Commands



Image Special Effect Facet Command -- Adding Facets to Your Picture 

To apply facets to pictures or defined areas:     

1 Select the sample button that is closest to the effect you want.     
2 Click the Expand or Shrink button to display more samples based on your selection. Click the 
Recenter button to move the selected sample to the middle of the display.
3 Choose Advanced to manually adjust the settings of the selected button.     
4 Choose OK.    

Related Topics:
Using Filter Commands
Using Special Effect Commands
Using Tune Commands



Image Special Effect Fisheye Lens Command -- Applying the Fisheye Effect 

To apply the Fisheye Lens special effect to pictures or defined areas:     

1 Select the sample button that is closest to the effect you want.     
2 Click the Expand or Shrink button to display more samples based on your selection. Click the 
Recenter button to move the selected sample to the middle of the display.
3 Choose Advanced to manually adjust the setting of the selected button from 1 to 100.    
4 Choose OK.    

Related Topics:
Special Effect Black Hole command 
Using Filter Commands 
Using Special Effect Commands
Using Tune Commands



Image Special Effect Mosaic Command -- Adding a Mosaic Effect to Your Picture 

To apply the Mosaic special effect to pictures or defined areas:     

1 Select the sample button that is closest to the effect you want.     
2 Choose OK.    

Related Topics:
Using Filter Commands
Using Special Effect Commands
Using Tune Commands



Image Special Effect Motion Blur Command -- Creating a Motion Effect in Your 
Picture 

To add a motion effect to pictures or defined areas:     

1 Select the sample button that is closest to the effect you want.     
2 Choose Advanced to manually adjust the setting of the selected button.     
4 Choose OK.    

Related Topics:
Using Filter Commands
Using Special Effect Commands
Using Tune Commands



Image Special Effect Outline Command -- Outlining Shapes in Your Picture 

To outline shapes in pictures or defined areas: 
1 Select a background color for the non-outlined areas.

2 Choose Special Effect Outline from the Image menu.

Related Topics:
Special Effect Edge Detect command
Using Filter Commands
Using Special Effect Commands
Using Tune Commands



Image Special Effect Pixelate Command -- Pixelating Your Picture 

To create block-like effects in pictures or defined areas:     

1 Select the sample button that is closest to the effect you want.     
2 Click the Expand or Shrink button to display more samples based on your selection. Click the 
Recenter button to move the selected sample to the middle of the display.
3 Choose Advanced to manually adjust the settings of the selected button.     
4 Choose OK.    

Related Topics:
Using Filter Commands
Using Special Effect Commands
Using Tune Commands



Image Special Effect Texturize Command -- Applying Texture 

To apply a texture to pictures or defined areas:    

1 Click Load to select the picture to be used as a texture.    
2 Select the sample button that is closest to the effect you want.     
3 Click the Expand or Shrink button to display more samples based on your selection. Click the 
Recenter button to move the selected sample to the middle of the display.
4 Choose Advanced to manually adjust the settings of the selected button.     
5 Choose OK.    

Related Topics:
Special Effect Apply Paper command 
Using Filter Commands
Using Special Effect Commands
Using Tune Commands 



Loading a Texture from Disk 

To load a previously saved texture:    
1 Select a File Type option.

2 Select the drive and directory you want.    
3 Click a file in the File Name list box.    
4 Choose OK to display the Texturize Samples dialog box.

Related Topics:
Special Effect Texturize command



Image Special Effect Twist Command -- Twisting Your Picture 

To apply the Twist special effect to pictures or defined areas:    

1 Select the sample button that is closest to the effect you want.     
2 Choose Advanced to manually adjust the settings of the selected button.     
3 Choose OK.    

Related Topics:
Using Filter Commands
Using Special Effect Commands
Using Tune Commands



Using Tune Commands 

You use the Tune commands to enhance images and tune up pictures or cutouts.
The Tune commands are only one aspect of image enhancement. PhotoFinish also has tools and other 
commands you can use to edit your pictures.
Keep the following in mind when using Tune commands:

All Tune commands are available with 24 bit color pictures. All Tune commands except Hue and 
Saturation are available with gray scale and 256 color pictures. Negative is the only Tune command 
available for black and white pictures.

Tune commands work best when your picture is 24 bit color or gray scale. You can convert your 
picture to one of these color modes.

Tune commands work fastest with a gray scale picture. Tune commands require more time with a
256 color picture than a 24 bit color picture.

Preview allows you to view changes to your picture before they are applied.
Use the Local Undo tool to remove changes in smaller areas, along contours, and pixel-by-pixel.
Undo cancels everything you've done since the last time you chose a tool or command.

Related Topics:
Tune Brightness and Contrast command
Tune Color/Gray Map command
Tune Equalize command
Tune Hue and Saturation command
Tune Negative command
Using Filter Commands
Using Special Effect Commands



Image Tune Samples Command -- Viewing Tune Samples 

To view and select a tune sample:

1 Click Show Samples to display samples of the available filters.     
2 Click the sample you want to use and choose OK.     

Related Topics:
Tune Brightness and Contrast command
Tune Color/Gray Map command
Tune Equalize command
Tune Hue and Saturation command
Tune Negative command
Using Filter Commands 
Using Special Effect Commands 
Using Tune Commands 



Image Tune Brightness and Contrast Command -- Adjusting Brightness and 
Contrast 

To change brightness or contrast in pictures or defined areas:    

1 Select the sample button that is closest to the effect you want.     
2 Click the Expand or Shrink button to display more samples based on your selection. Click the 
Recenter button to move the selected sample to the middle of the display.
3 Use the horizontal scroll bar to change the Contrast values of the samples. Use the vertical scroll 
bar to change the Brightness values of the samples.
4 Choose Advanced to manually adjust the settings of the selected button.     
5 Choose OK.    

Related Topics:
Auto Brightness/Contrast command 
Brighten Paintbrush tool 
Contrast Paintbrush tool 
Using Filter Commands
Using Special Effect Commands
Using Tune Commands



Image Tune Color/Gray Map Command -- Fine-tuning with the Color/Gray Map 

To apply the Color/Gray Map command to pictures or defined areas:    

1 Select the sample button that is closest to the effect you want.     
2 Click the Expand or Shrink button to display more samples based on your selection. Click the 
Recenter button to move the selected sample to the middle of the display.
3 Click OK to apply the sample setting or choose Advanced to manually adjust the map.     

Related Topics:
Saving Response Curve Settings 
Using Filter Commands
Using Special Effect Commands
Using Tune Commands



Adjusting a Color/Gray Map

To manually adjust a color/gray map:
1 Select a Preset Maps option, and PhotoFinish automatically adjusts your picture.

2 Click Show Calibration Maps to include your calibration maps in the Preset Maps drop-down list.    
3 Select color channels to change from the Channel drop-down list.    
4 Select a Style to make other changes.     
5 Click Save to save the current map settings.     
6 Choose OK.    

Related Topics:
Tune Color/Gray Map command 
Using Filter Commands
Using Special Effect Commands
Using Tune Commands



Tune Color/Gray Map Style Options 

You can use several styles to get the response curve you want.
Curve
Freehand
Linear

This picture illustrates the color values represented in the response curve sample box:

Related Topics:
Adjusting a Color/Gray Map 
Tune Color/Gray Map command 



Saving Response Curve Settings 

To save response curve settings:
1 Type a name for the new color/gray map in the Name text box.

2 Choose OK to save the map to disk.    

Related Topics:
Adjusting a Color/Gray Map 
Tune Color Gray/Map command 



Image Tune Equalize Command -- Changing Your Highlights and Shadows 

To equalize pictures or defined areas:    

1 Select the sample button that is closest to the effect you want.     
2 Click the Expand or Shrink button to display more samples based on your selection. 
3 Click OK to apply the sample setting or choose Advanced to manually adjust the map.        

Related Topics:
Tune Color/Gray Map command
Using Filter Commands
Using Special Effect Commands
Using Tune Commands



Manually Adjusting Equalize Options

1 Drag the arrows at the bottom of the bar graph to adjust the Low, Mid, and High values.    
2 Choose OK.    

Related Topics:
Equalize command 
Tune Color/Gray Map command
Using Filter Commands
Using Special Effect Commands
Using Tune Commands 



Image Tune Hue and Saturation Command -- Adjusting Hue and Saturation 

To adjust hue and saturation in pictures or defined areas:    

1 Select the sample button that is closest to the effect you want.     
2 Click the Expand or Shrink button to display more samples based on your selection. 
3 Use the horizontal scroll bar to change the Hue values of the samples.
4 Choose Advanced to manually adjust the settings of the selected button.     
5 Choose OK.    

Related Topics:
Auto Saturation command 
Using Filter Commands
Using Special Effect Commands
Using Tune Commands 



Image Tune Negative Command -- Inverting Colors in Your Picture 

To invert the colors in pictures or defined areas:
Choose Tune Negative from the Image menu.    

Related Topics:
Color Replacer tool
Using Filter Commands
Using Special Effect Commands
Using Tune Commands



Image Clear Command -- Clearing Your Picture to the Background Color 

To clear your picture to a new background color:

1 Select a background color.    
2 Choose Clear from the Image menu.

Related Topics:
Color Replacer tool
Eraser tool
Revert command
Undo command



Image Convert To Command -- Changing Color Formats 

To convert a picture to another color format:    
1 Choose Convert To from the Image menu.

2 Choose the option you want.    

Related Topics:
Working with Different Numbers of Colors



Convert To Options 

Black and White
Gray Scale
256 Color
24 Bit Color

Related Topics:
Convert To commands 



Image Transform Flip Horizontal Command -- Making a Mirror Image 

To flip pictures or defined areas horizontally:
Choose Transform Flip Horizontal from the Image menu to make a mirror image.

Related Topics:
Transform Flip Vertical command



Image Transform Flip Vertical Command -- Turning Your Picture Upside Down 

To flip pictures or defined areas vertically:
Choose Transform Flip Vertical from the Image menu to turn your picture upside down.

Related Topics:
Transform Flip Horizontal command



Image Transform Rotate Command -- Rotating by Degrees 

To rotate pictures or defined areas:

1 Choose the degree of rotation you want.    
2 If you choose Custom, use the Custom mini-scroll bar to specify the amount of custom rotation 
you want.    
3 Choose OK.     

Related Topics:
Auto Straighten command 



Image Transform Free Resize Command -- Resizing Freehand 

To freehand adjust a defined area:    

1 Define an area.    
2 Choose Free Resize from the Image menu.    
3 Drag a handle to stretch or shrink the picture.    
4 Choose a tool or click outside the marquee to paste the effect.

Related Topics:
Transform Resize command



Image Transform Resize Command -- Resizing Your Picture 

To resize pictures or defined areas:    
1 Use the mini-scroll bar or type numbers in the Resize Width and Height text boxes to increase or 
decrease the size of the picture or defined area.    

2 Select a Units option from the Units drop-down list.
3 Choose OK to complete the command.

Related Topics:
Transform Free Resize command



Image Info Command -- Displaying Picture Information 

To view information about a picture:     

1 Read the information.    
2 Choose OK to return to your picture.

Related Topics:
Resolution command
System Info command



Image Resolution Command -- Adjusting Picture Resolution 

To adjust the resolution of a picture:    
1 Use the mini-scroll bars to adjust the resolution.

2 Choose OK to return to your picture.

Related Topics:
Info command
Print command



The File Menu 

You use File menu commands to start new pictures, load and save pictures, abandon changes, select 
your printer, change printer options, calibrate your printer, view thumbnail pictures, and exit PhotoFinish. 
The File menu may also contain commands to control TWAIN devices, as well as commands that control 
PhotoFinish pictures that are embedded or linked to other documents.
The File menu picture list displays the last four pictures you opened. As you open pictures, their names 
are added to the list. Click a picture name to open it.
The New, Open, and Save commands are also available on the AutoBar. Just click the button you want on
the AutoBar. To choose a command from the File menu, click File and choose the command.
File Menu Commands 
New: Starts a new picture.

Open: Loads a picture previously saved to disk or stored on the Clipboard.

Close: Closes the active picture and all its duplicates.

Save: Saves changes you make to a picture previously saved to disk.

Save As: Saves a new picture for the first time or saves a picture previously saved to disk with a new 
name or in a new format.

Revert: Abandons all changes made since the last time you saved your picture.

Calibrate Printer: Calibrates your printer, and creates, edits, or deletes calibration maps.

Print: Prints the picture.

Print Setup: Selects the printer, printer halftone patterns, and printer options you use to print.

Viewer: Views pictures in thumbnail format. You can also manage your picture files with this command.

Exit: Closes the PhotoFinish program.

Update: Updates the embedded object in the destination file without closing PhotoFinish. This command 
appears only if the current picture is an embedded object.

Save Copy As: Saves a copy of an embedded picture to a file on disk. This command appears only if you 
have linked or embedded an image. The embedded picture is not changed with this command.

Exit and Return To: Ends your PhotoFinish session and returns to the destination program. This 
command appears only if you have linked or embedded an image.

Acquire: Imports data from the selected TWAIN source. This command appears only if your scanner or 
video grabber supports the TWAIN standard interface.

Select Source: Selects which TWAIN source you use to scan. This command appears only if your 
scanner or video grabber supports the TWAIN standard interface.



File New Command -- Starting a New Picture 
 

To start a new picture:
1 Select a Units option.

2 Select a size for your picture in the Width and Height boxes.    
3 Select a color format from the Mode drop-down list.    
4 Choose OK.

Related Topics:
Open command
Viewer command
Working with Different Numbers of Colors



File Open Command -- Opening an Existing Picture 
 

To open a previously saved picture:

1 Select a File Type option from the List Files of Type drop-down list.    
2 Select the drive and directory you want.    
3 Click a file in the File Name list box.    
4 Choose OK.    

Related Topics:
Duplicate command
New command
Previewing a Picture
Viewer command
Working with Different Numbers of Colors



Previewing a Picture 
 

To preview a picture:

1 Read the displayed information.    
2 Click Show Thumbnail to see a small representation of the picture.    
3 Choose OK to return to the dialog box.

Related Topics:
Open command
Paste From command
Preferences command
Tile Pattern command



File Close Command -- Closing a Picture 
 

To close a picture and all its duplicates:    
1 Choose Close from the File menu.

2 If you have made changes since the last time you saved, PhotoFinish asks if you want to save them.   

Related Topics:
Duplicate command 
Exit command 
Save As command 
Save command 



File Save Command -- Saving Your Picture with Save 
 

To resave a previously saved picture:    
Choose Save from the File menu.    

 
You also can click the Save icon on the AutoBar to save a picture.

Related Topics:
Save As command
Updating an Embedded Picture



File Save As Command -- Saving a Picture with a New Name 
 

To save a picture for the first time or to resave an existing picture:    

1 Select a File Type option.    
2 Select other available options from the File Sub-Format drop-down list.    
3 Select where you want to save the file.    
4 Type a name for the file.
5 Choose OK.    

Related Topics:
Compressing with JPEG
Copying Picture Files with the Viewer
Saving a Copy of an Embedded Picture
Save command



File Revert Command -- Restoring Your Previous Version 
 

To abandon all changes since the last time you saved your picture:    
Choose Revert from the File menu.    

Related Topics:
Clear command
Delete command
Eraser tool
Local Undo tool
Undo command



Compressing with JPEG 
 

To customize JPEG settings:    

1 If you are saving a 24 bit color picture, choose the Subsample you want.    
2 Use the Luminance Quantization mini-scroll bar or type a number to specify how much gray to 
lose.    
3 Use the Chrominance Quantization mini-scroll bar or type a number to specify how much color to 
lose.    
4 Choose OK to compress the picture.    

Related Topics:
Convert To commands
JPEG File Format 
Save As command
Saving a Copy of an Embedded Picture
Working with 24 Bit Color Pictures
Working with Gray Scale Pictures



File Calibrate Printer Command -- Calibrating Your Printer 
 

To load a preset map:

1 Choose the map you want from the Preset Maps drop-down list.    
2 Click the Options button to create a new map or to recalibrate, edit, or delete the selected map.   

3 Choose OK to use the map.

Related Topics:
Calibrating Your Hardware



Creating a New Printer Calibration Map 
 

To create a new calibration map:     

1 Choose a preset map that the new map is to be based on from the Based On drop-down list.

2 Type a name for the new calibration map in the Map Name text box.

3 Choose OK to save the map to disk and return to the Calibrate Printer dialog box.    

4 Click Recalibrate to automatically recalibrate your printer and save the calibration to the new map.

5 Click Edit to fine-tune the map.

6 Choose OK to use the new calibration map.

Related Topics:
Calibrating Your Hardware
Calibrating Your Printer



Recalibrating Your Printer 
 

To recalibrate your printer:     

1 Select the color option you want your printer to be calibrated for, and choose OK.    

2 Place the printout of CALIBRTE.PCX on your scanner. 

3 Choose OK to start the calibration process.    
4 Choose OK in the Calibrate Printer dialog box to save your changes to disk and use the new 
settings.

Related Topics:
Calibrating Your Hardware
Calibrating Your Printer 
Creating a New Printer Calibration Map
Editing a Printer Calibration Map 



Editing a Printer Calibration Map 
 

To edit a printer calibration map:     

1 Choose a channel to specify the colors to be adjusted.    
2 Adjust the curve to get the effect you want.    
3 Choose OK to return to the Calibrate Printer dialog box.
4 Choose OK save your changes to disk and use your new settings.    

Related Topics:
Calibrating Your Hardware
Calibrating Your Printer
Creating a New Printer Calibration Map 
Recalibrating Your Printer 



File Print Command -- Printing a Picture 
 

To print a picture:    

1 Select a size for the printed picture.    
2 Select a Units option.
3 Specify the number of copies you want to print.
4 Click the Setup button if you want to select another printer or change printer options.
5 Choose OK.

Related Topics:
Adjusting Picture Resolution
Calibrating Your Printer



File Print Setup Command -- Setting Up Your Printer 
 

To set up your printer:

1 Select a printer from the Printer box.     
2 Select a halftone option.    
3 Select an Orientation for your picture.
4 Select a Paper Size and Source from the drop-down list.
5 Click the Options button if you want to change other printer-specific options.    
6 Choose OK.

Related Topics:
Calibrating Your Printer
Printing a Picture



File Viewer Command -- Viewing Pictures 
 

To view thumbnail pictures:    
1 Click Browse to change the drive, directory, or image format.

2 Click the picture you want to work with.    
3 Click Open to load the selected pictures.    
4 You can also copy, move, rename, and delete selected pictures by clicking the corresponding 
button.



Browsing Through Thumbnails 
 

To browse through thumbnails:

1 Select the drive and directory you want to browse through.     
2 Select the file type you want to view from the List Images of Type drop-down list.
3 Choose OK to view picture thumbnails in the new drive, directory, and format.

Related Topics:
Copying Picture Files with the Viewer
Deleting Picture Files with the Viewer
Moving Picture Files with the Viewer
Renaming Picture Files with the Viewer
Viewer command



Copying Picture Files with the Viewer 
 

To copy selected picture files:    
1 Select the drive and directory where you want to copy the files.

2 Choose OK to copy the files.

Related Topics:
Browsing Through Thumbnails
Deleting Picture Files with the Viewer
Moving Picture Files with the Viewer
Renaming Picture Files with the Viewer
Viewer command



Moving Picture Files with the Viewer 
 

To move selected picture files:    
1 Select the drive and directory where you want to move the files.

2 Choose OK to move the files.

Related Topics:
Browsing Through Thumbnails
Copying Picture Files with the Viewer
Deleting Picture Files with the Viewer
Previewing a Picture
Renaming Picture Files with the Viewer
Viewer command



Renaming Picture Files with the Viewer 
 

To rename selected picture files:    
1 Type the new name for the selected picture in the File Name text box.

2 Choose OK to rename the file.

Related Topics:
Browsing Through Thumbnails
Copying Picture Files with the Viewer
Deleting Picture Files with the Viewer
Moving Picture Files with the Viewer
Viewer command



Deleting Picture Files with the Viewer 
 

To delete selected picture files:    
Choose OK to delete the files.

Related Topics:
Browsing Through Thumbnails
Copying Picture Files with the Viewer
Moving Picture Files with the Viewer
Renaming Picture Files with the Viewer
Viewer command



File Exit Command -- Exiting PhotoFinish 
 

To end your PhotoFinish session:
1 Choose Exit from the File menu.

2 If you have made changes to a picture since the last time you saved, PhotoFinish asks if you want to 
save them.    

Related Topics:
Close command
Exiting and Returning to the Destination Application



The Edit Menu 

You use Edit menu commands to correct mistakes, copy or cut to the Clipboard or to disk, paste from the 
Clipboard or disk, crop a selected area, and otherwise manipulate your picture or cutouts.
To choose an Edit menu command, click Edit and choose the command.
Edit Menu Commands 
Undo: Cancels changes made since the last time you chose a tool or command.

Cut: Deletes a defined area and copies it to the Clipboard.

Copy: Copies a defined area to the Clipboard.

Paste: Places the contents of the Clipboard, surrounded by the marquee, in the upper left corner of the 
picture window.

Delete: Deletes a defined area without copying it to the Clipboard.

Copy To: Copies a defined area to disk.

Paste From: Places a picture saved to disk, surrounded by the marquee, in the upper left corner of the 
picture window.

Crop: Copies a defined area to a new picture window.

Select All: Selects your entire image.

Select None: Pastes a cutout or cancels your current selection.

Select Leave Original: Leaves a single copy of the cutout behind when you move it.

Select Transparent: Makes the background color of a cutout transparent.



Edit Undo Command -- Undoing Changes to Your Picture 
 

To cancel recent changes:    
Choose Undo from the Edit menu.

Related Topics:
Local Undo tool
Revert command



Edit Cut Command -- Cutting to the Clipboard 
 

To cut a defined area to the Clipboard:    
1 Select a background color to fill the cut area.

2 Define an area.    
3 Choose Cut from the Edit menu.    

Related Topics:
Copy command
Delete command



Edit Copy Command -- Copying to the Clipboard 
 

To copy a defined area to the Clipboard:    

1 Define an area.    
2 Choose Copy from the Edit menu.

Related Topics:
Copy To command
Copying Picture Files with the Viewer
Cut command



Edit Paste Command -- Pasting from the Clipboard 
 

To paste a cutout from the Clipboard:    

1 Choose Paste from the Edit menu.    
2 Drag the cutout to move it to another area.    
3 Choose a tool, click outside the marquee, or choose Select None to paste the cutout.

Related Topics:
Copy command
Cut command
Manipulating Defined Areas
Paste From command



Edit Delete Command -- Deleting Portions of Your Picture 
 

To delete a defined area from your picture:    
1 Select a background color to fill the cut area.

2 Define an area.    
3 Choose Delete from the Edit menu.    

Related Topics:
Crop command
Cut command



Edit Copy To Command -- Saving Portions of Your Picture to Disk 
 

To copy a defined area to a file:

1 Select a File Type option.    
2 Select other available options from the File Sub-Format drop-down list if they are available.    
3 Select where you want to save the file.    
4 Type a name for the file.
5 Choose OK.    

Related Topics:
Copy command
Copying Pictures Files with the Viewer
Crop command
Paste From command



Edit Paste From Command -- Pasting from Disk 
 

To paste an image from a file:    
1 Select a File Type option.

2 Select the drive and directory you want.    
3 Click a file in the File Name list box.    
4 Choose OK.    
5 Drag the cutout to move it to another area.    
6 Choose a tool, click outside the marquee, or choose Select None to paste the cutout.

Related Topics:
Copy To command
Manipulating Defined Areas
Paste command
Select Transparent command



Edit Crop Command -- Cropping a Cutout 
 

To crop a portion of your picture:     

1 Define an area.    
2 If you are selecting a non-rectangular area, select a background color for the area surrounding 
the cutout in the rectangular window.
3 Choose Crop from the Edit menu.    
4 Use the Save As command to save the cropped picture to disk.

Related Topics:
Auto Crop command 
Copy To command
Delete command
Select Leave Original command 
Select Transparent command



Edit Select All Command -- Selecting Your Entire Picture 
 

To select your entire picture:    
Choose Select All from the Edit menu.    

Related Topics:
Copy command
Copy To command
Delete command
Select Leave Original command    



Edit Select None Command -- Quickly Pasting a Cutout or Canceling Current 
Selection 
 

To quickly paste a cutout or cancel your current selection:    
Choose Select None from the Edit menu.

Related Topics:
Select All command 



Edit Select Leave Original Command -- Leaving a Copy of a Cutout 
 

To leave a copy of a cutout behind:

1 Define an area.    
2 Choose Select Leave Original from the Edit menu.    
3 Drag the cutout to another location.    
4 Choose the command again to deselect the command.    

Related Topics:
Manipulating Defined Areas 



Edit Select Transparent Command -- Making the Background Color Transparent 
 

To make the background color of a cutout transparent:

1 Select a background color.    
2 Define a cutout or use the Paste or Paste From command to place a cutout in the picture.    
3 Choose Select Transparent from the Edit menu.    
4 Drag the cutout to another location.    
5 Choose another tool or choose Select None to paste the cutout.
6 Choose the command again to deselect the command.    

Related Topics:
Manipulating Defined Areas



active picture window
The picture window you are working on. Its title bar is shaded differently from other open windows. To 
make a window active, click its title bar or choose it from the Window menu list.



background color
Many tools and commands use the background color. To change your background color, point in the 
Palette to the color you want, hold down Shift and click the left mouse button. You can also select the 
Eyedropper tool, point to a color in your picture, hold down Shift, and click the left mouse button. The new
background color appears in the color selection box on the left of the Palette. Use Clear to clear a picture 
window to the background color.



backup copy
Choose the Save Backup Copy option when you use the Save As or Copy To command to keep a backup
of your picture as it was when you last chose Save or Save As. The backup file's name is the same as the
original's, except the last letter of the extension is a $. For example, the backup file of GRAPH.PCX is 
GRAPH.PC$.



cascading menu
A command with an arrow to the right of it contains a cascading menu. To choose a command on a 
cascading menu, click a command with an arrow. When the cascading menu appears, choose a 
command.



check box
Found in dialog boxes. Click a box to select it. A selected check box contains an X. Click the box again to 
deselect it. Unavailable choices are dimmed.



chrominance quantization
Used in the Custom JPEG compression. Specifies how much color to retain in a group of pixels. The 
number selected for the size of the groups of pixels with Subsample determines the level at which 
PhotoFinish compresses the colors in specified blocks. This procedure makes the picture file smaller 
which aids in transmission and saves disk space. 



click
Point to the area or tool you want, press the mouse button and release it in one smooth, quick motion. 
Unless otherwise noted, click the left mouse button.



Clipboard
The Clipboard stores graphics or text you cut or copy until you cut or copy again. Use Paste to insert 
graphics from the Clipboard into the active picture. To insert text from the Clipboard, select the Text tool. 
When the Enter Text dialog box appears, press Ctrl+V.



CMY
Cyan-magenta-yellow. A way to refer to colors by their amount of cyan, magenta, and yellow. The CMY 
values range from 0 to 255, where 0 is the minimum amount of a particular color and 255 is the maximum
amount. See also HLS and RGB.



color selection box 
The box on the left of the Palette that displays current primary, secondary, and background colors, 
gradient effect, or the loaded tile pattern.



color tolerance
The range of colors PhotoFinish uses to determine how much of the picture to fill with any paint roller tool,
replace with the Color Replacer tool, or select with the Magic Wand tool. The greater the value, the more 
colors are affected.



command button 
A button in a dialog box that initiates action. For example, OK applies your settings and Help activates the
help program. Command buttons followed by an ellipsis (...) bring up other related dialog boxes.



CONFIG.SYS
The CONFIG.SYS file tells your computer what types of devices, such as scanners, are installed in your 
computer system. The CONFIG.SYS file must be in the root directory of your boot disk or hard drive. The 
PhotoFinish Setup Program can automatically make CONFIG.SYS changes when you install a scanner.



constrain
Use the Shift key with many tools to force the tool to paint in a particular direction or shape. You can 
constrain the box tools, including the Box Selection tool, to a square. You can constrain the Ellipse/Circle 
tools, including the Elliptical Selection, to a circle. You can constrain other tools vertically, horizontally, or 
at a 45-degree angle. Press the spacebar to change between vertical and horizontal constraint.



Control menu 
Click on the box containing a hyphen or dash on the left side of a window's title bar to open its Control 
menu. To open the Control menu of a minimized window, click on the icon. To quickly close or hide a 
window or workbox, double-click the Control menu box.



crop
To cut an area of a picture defined with the Box Selection, Magic Wand, Lasso, Elliptical Selection, or 
Scissors and copy it into a new picture window. 



cutout
An area of a picture defined with the Box Selection, Magic Wand, Lasso, Elliptical Selection, or Scissors 
or an area pasted from the Clipboard or from disk. A cutout is surrounded by the marquee. Use Edit menu
commands to cut, copy, and paste cutouts. Use Image menu commands to transform and enhance 
cutouts.



defined area
A part of a picture that is surrounded by a marquee, also called a cutout. Use the Box Selection, Magic 
Wand, Lasso, Elliptical Selection, or Scissors to define an area. Areas you paste are also defined areas.



device independence
PhotoFinish allows you to load and edit images that have more colors than your hardware supports, while
retaining all of the original details and colors in your picture. PhotoFinish uses dithering to simulate the 
colors and shades not supported by your monitor.



double-click
Point to the area or tool you want, quickly press the mouse button twice and release it. Unless otherwise 
noted, double-click the left mouse button.



dpi
The number of dots per inch your printer or scanners uses to resolve an image. A higher dpi produces a 
sharper image that appears larger on screen and requires more storage space.



Draft mode
Prescan mode. Draft mode scans more quickly than Quality mode, at the lowest possible resolution with 
the lowest number of colors possible for the scanner (usually black and white). Use Draft mode to see an 
approximation of the final scan.



drag
Press and hold the mouse button while you move the mouse. Unless otherwise noted, drag with the left 
mouse button.



drop-down list
List that drops down from a box to show the current selection. To open a list, click the underlined arrow. 
Use the scroll bar to move up and down in the list.



frame markers
Small squares on the frame in the Scan Area dialog box that are used to size the scan area.



gradient

Gradients can be vertical , horizontal

, or radial

. They are shaded from secondary to background color. You can fill an area with a gradient. Use the 
Gradient Type command on the Options menu to change the look and brightness of a gradient.



gray scale
Gray scale pictures can contain up to 256 solid colors of gray. Filters, special effects, and tunes produce 
excellent results with gray scale pictures. Gray scale picture require significantly less storage space than 
do 24 bit color pictures.



grouped tools    

Similar tools that are grouped together to reduce the size of the Toolbox. A triangle appears in the bottom 
right corner of the displayed tool. To select another tool within a group, press the triangle. When the 
available tools appear, drag to the tool you want, and release the mouse button. The new tool appears in 
the Toolbox.

To ungroup the Toolbox, choose Layout Ungroup from the Toolbox Control menu.



halftone pattern
A series of dots that simulate a color or shade of gray. When you    choose the Optimize Display command
from the Display menu, PhotoFinish uses halftones to simulate colors your monitor is not capable of 
displaying.



handles
Squares or circles on the resize box, text frame box, and curve tool. You use handles to resize and 
manipulate the defined area.



HLS
Hue-lightness-saturation. A way to refer to colors by their amount of lightness, color intensity, and hue. 
The hue is the spectrum arranged in a circle where red is 0, yellow is 60, green is 120, cyan is 180, blue 
is 240, magenta is 300 and red is 360, again. Lightness and saturation are values ranging from 0.0 to 1.0.
See also CMY and RGB.



icon
The small picture representation of a minimized window. Click the down arrow to the right of a window's 
title bar to minimize it. Double-click an icon to open the window on your screen.



list box
Box in a dialog box that shows available selections, such as a file list box. Use the scroll bar to move up 
and down in the list. To select an item, click it and choose a command button. Double-click your selection 
to choose it and complete the command.



luminance quantization
Used in the Custom JPEG compression. Specifies how much gray to retain in a group of pixels. The 
number selected for the size of the groups of pixels with Subsample determines the level at which 
PhotoFinish compresses the grays in specified blocks. This procedure makes the picture file smaller, 
which aids in transmission and saves disk space. 



maximize 
You can maximize a PhotoFinish picture and the PhotoFinish desktop to the size of your screen by 
clicking the up arrow on the right corner of the title bar. To edit in Full Screen view, click the double arrow 
on the right corner of the status bar. To maximize a window that has been minimized to an icon, double-
click the icon, or click the icon and choose Maximize from the Control menu. You cannot maximize the 
Palette or the Toolbox.



menu bar
The horizontal bar below the program title bar that contains menu names. Each menu contains a list of 
commands you can choose.



minimize 
You can minimize or shrink a picture window and the PhotoFinish desktop to an icon by clicking the down 
arrow on the right corner of the title bar. You cannot minimize the Palette or the Toolbox.



mini-scroll bar    
Adjusts numerical values. Mini-scroll bars can be vertical or horizontal. Click the arrows to increase or 
decrease values by single increments. To quickly adjust the values, point to the box between the arrows. 
When your pointer is a double-sided arrow with lines through the center, drag the mouse to change the 
value. You can also type numbers in the text box.



moiré pattern
An irregular pattern that may appear in a scanned image.



option button
A button that allows you to choose one of several items. Click a button to select it. A selected button 
contains a filled dot. Unavailable choices are dimmed or do not appear.



Palette 
Workbox you display to view and change colors or tool settings. Choose Screen Layout Palette from the 
Display menu, or press Ctrl+P to display or remove your Palette.

The color selection box on the left side of the Palette displays the primary, secondary, and background 
colors. The rest of the Palette shows available colors or settings for the current tool. Each picture has its 
own palette. The palette of a 24 bit picture shows 256 of the available 16.7 million colors.

Use Save Palette As to save the current set of colors to disk in a palette you can load into another picture.



picas
Unit of measurement. There are six picas in one inch and twelve points in one pica.



picture window
Each picture is loaded into its own picture window. You can open up to 8 pictures. You can duplicate 
windows until you have 20 windows displayed or until you have exceeded the amount of available 
memory.



pixels
The individual dots that make up an image, pixels are the smallest possible unit of measurement. The 
size of each pixel is determined by the resolution of the current device (monitor, scanner, or printer). See 
also dpi (dots-per-inch).



points
Unit usually used to measure the size of type. There are twelve points in one pica and six picas in one 
inch.



posterize
An effect that decreases the number of colors in your entire picture or in a defined area. This is useful if 
you want to create sharp contrasts between areas of your picture.



press
Hold down the mouse button. Unless otherwise noted, press the left mouse button.



primary color
Many tools and commands use the primary color. To change your primary color, point in the Palette to the 
color you want and click the left mouse button. You can also select the Eyedropper tool, point to a color in 
your picture, and click the left mouse button. The new primary color appears in the color selection box on 
the left of the Palette .



printer halftone
Pattern of dots that simulates a color, used when you print a picture that has more colors than your printer
supports.



Quality mode
Prescan mode. Quality mode scans in the lowest possible resolution and at the lowest number of colors 
possible for the Image Type you select with the Scanner Setup options. Quality mode takes more time 
than Draft mode but provides a better representation of the final scan.



RGB
Red-green-blue. A way to identify a color by its red, green, and blue content. RGB values can range from 
0 to 255, where 0 is the minimum amount of color and 255 is the maximum amount of color. See also 
CMY and HLS.



retouch tools
Tools you use to repair imperfections and create special effects in scanned images. The retouch tools are 
the contrast, brighten, tint, blend, smudge, and sharpen tools. You can also use Filter, Special Effect, and 
Tune commands to retouch pictures and cutouts.



scanner configuration file
A file, with the extension .CNF, that contains scanner settings. Select Save Configuration As from the 
Scan menu to save current scanner settings. Select Open Configuration from the Scan menu to load 
previously saved scanner settings. Save scanner settings into PHOTO.CNF to automatically load them 
when you start PhotoFinish.



natural art tools
Tools that simulate real-world art tools, such as markers, chalks, charcoals, pens, paintbrushes, 
airbrushes, and color pencils. You use the ribbon bar or the Tool Options command on the Options menu 
to adjust tool settings.



Preview
Shows how changes will affect your picture before the changes are made. During Preview, you can drag 
the dialog box aside to see more of the picture.



secondary color
Many tools and commands use the secondary color. To change your secondary color, point in the Palette 
to the color you want and click the right mouse button. You can also select the Eyedropper tool, point to a 
color in your picture, and click the right mouse button. The new secondary color appears in the color 
selection box on the left of your Palette.



temporary files
PhotoFinish temporarily stores information in files on your hard disk if it runs out of memory. Set the 
drives/directories for PhotoFinish to use as temporary storage with the Preferences command on the 
Options menu. If you quit PhotoFinish abnormally, the files remain on your system and can be deleted.



text box
An area in a dialog box you use to enter text. For example, you type the name of a file in the File Name 
text box.



tile pattern 
Any small picture loaded from disk or the Clipboard, to be used in a tile pattern. Use Tile Pattern to select 
the tile you want.



thumbnail
A small representation of a picture. Thumbnail files have a file extension that begins with !. For example, a
thumbnail file for a .PCX has a .!px extension.



title bar
The horizontal bar at the top of windows that shows the title of the program, the title of the window, or 
information about the loaded picture (name, magnification rate, etc.). The left end of the title bar contains 
the Control menu box and the right end may contain minimize and maximize buttons.



Toolbox
Workbox containing the tools you use to create and retouch pictures and add special effects. Choose 
Screen Layout Toolbox from the Display menu, or press Ctrl+T to display or remove the Toolbox.

Click a tool with the left mouse button to choose it. Click a tool with the right mouse button for help on 
using the tool. Click the triangle in the bottom right corner to display grouped tools.



virtual memory
Allows PhotoFinish to behave as if there were more memory than is actually present in your system by 
storing temporary files in any free RAM and disk space.



work area
Area of your picture you see in a picture window. If a picture extends beyond the work area, use the Hand
tool or the scroll bars to move other areas into view. Use the Locator tool to display other areas in a 
duplicated picture. Use the Zoom Out commands to display more of a picture at once.



DMA I/O
Data is transferred by your system hardware from memory to some other device without being loaded into
the microprocessor.



EMS
Expanded Memory Specification. A standard that allows personal computers to use more than 640K of 
RAM in DOS. EMS creates a 64K RAM window through which RAM in 64K sections can be swapped as 
needed.



interrupt request
A signal that can be generated by hardware or software to tell the microprocessor to pause in what it is 
doing and perform a different function, such as inputting data from a scanner.



memory address
A number that specifies a memory location.



port address
The location you assign for the interface between your computer and an external device, such as a 
scanner or printer. You can assign a port address to one device at a time.



programmed i/o
Data is transferred by a program from memory to some other memory location or to a device, such as a 
scanner.



Transparency
A tool option that determines the amount of pigment in the paint. The higher the custom setting, the more 
sheer the paint appears. Selecting a Sheer transparency is equivalent to thinning the paint with water -- 
more of the existing color in the picture shows through. Selecting the Solid transparency option covers 
more of the existing color in the picture. 



Pressure
A tool option that determines the force used to apply paint. Generally, the greater the pressure, the darker
the brush stroke and the less prominent the paper grain. 



Spacing
A tool option that determines the distance between each spot of color that makes up a brush stroke. The 
higher the setting, the more distance there is between the spots of color. You change this option with the 
Tool Options command on the Options menu. 



Rate of Flow
A tool option for the Airbrush and Spraycan tools that determines the amount of paint applied each 
second. Changing the rate of flow is equivalent to adjusting the air pressure of an airbrush. The higher the
setting, the more quickly the paint is applied. You change this option with the Tool Options command on 
the Options menu.



PhotoFinish Tools 
 

You use the tools in the Toolbox to create, add special effects, and retouch your pictures. To choose a 
tool, the Toolbox must be displayed.
Click a tool below to learn more about the tool. 



Related Topics:
Changing Tool Width and Shape
Finding and Selecting Tools
Screen Layout Toolbox command
Selecting Tool Colors
Selecting Tool Settings



Finding and Selecting Tools 
 

You use PhotoFinish tools to create, retouch, and add special effects to pictures.
To get help on using a tool, click the right mouse button on the tool in the Toolbox.
To choose a tool, the Toolbox must be displayed. Point to the tool you want and click the left 

mouse button. The tool is highlighted to indicate it is selected. You can move the Toolbox by dragging its 
title bar.

To choose a tool from a group, press the left mouse button on the triangle in the bottom right 
corner of the current tool. When the available tools appear, drag the mouse to the tool you want and 
release the mouse button. The tool appears in the Toolbox and is selected.

 Locator, Hand tools
 Selection tools
 Eraser and Color Replacer tools
 Airbrush and Spraycan tools
 Shape tools
 Line and Curve tools
 Blend and Sharpen tools

To use most tools, choose the tool you want and point to where you want to start. Press the left 
mouse button to anchor the starting point, drag the mouse until you have the look you want, and release 
the mouse button.

When you move the pointer over the picture window, it changes shape to remind you which tool 
you selected.

Related Topics:
Laying Out the Toolbox
Screen Layout Toolbox command 
Selecting Tool Colors
Selecting Tool Settings 



Selecting Tool Colors 
 

There are several ways to choose colors:
Point to a color in the Palette and click the appropriate mouse button to select a color.    

 
Use the Eyedropper tool to pick up a color from your picture. Click the appropriate mouse button 

to select your colors.    
 

Use the Pen tool and click the right mouse button to select a primary color.
If your pointing device has only one button, you can simulate a right mouse button click by 

holding the Ctrl key and clicking the stylus button.

Related Topics:
Changing Tool Width and Shape
Finding and Selecting Tools
Folding and Unfolding the Palette
PhotoFinish Tools
Screen Layout Palette command 
Selecting Tool Settings



Selecting Tool Settings 
 

The ribbon bar is where you can quickly change settings for the selected tool. You can also use the Tool 
Options command to change tool settings for the selected tool.
To select new settings from the ribbon bar, it must be displayed.
Related Topics:
Changing Tool Width and Shape
Finding and Selecting Tools
Folding and Unfolding the Palette
PhotoFinish Tools
Screen Layout Ribbon Bar command 
Selecting Tool Colors 



Changing Tool Width and Shape 
 

You use the ribbon bar to change the width and shape of tools that use the width and shape settings. You 
can also change the width and shape with the Tool Options command. To change width or shape on the 
ribbon bar, it must be displayed.

To change the tool width, click or press one of the arrows on the Width mini-scroll bar.

To change the tool shape, click the Shape drop-down list and select the shape you want. 

Related Topics:
PhotoFinish Tools 
Screen Layout Ribbon Bar command 
Selecting Tool Colors 
Selecting Tool Settings 



      Zoom Tool -- Zooming In and Out with the Zoom Tool 
 

To use the Zoom tool:    
1 Point to the area you want to zoom.

2 Click the left mouse button to zoom in.    
3 Click the right mouse button to zoom out.    
4 Continue clicking the mouse button to cycle through the Zoom command percentages.    

To change magnification with the ribbon bar:    

1 Select a magnification level from the Amount drop-down list.     
2 Click the 100% button to return to normal view.
3 Click the Zoom To Fit button to automatically zoom in or out so that the picture fits on the 
PhotoFinish desktop.
4 Click the Fit To Zoom button to automatically resize the picture window to the maximum 
PhotoFinish desktop size.     

Related Topics:
Duplicate command
Fitting to Zoom 
Locator tool
Zoom commands
Zoom To Fit command 



The Tool Options command is unavailable for the Zoom tool. Instead, you can choose a Zoom 
command from the Display menu.



      Locator Tool -- Viewing the Same Area in Multiple Windows 
 

To use the Locator tool:    
Click in one picture on the area you want to show in all windows that contain duplicate copies.    

To locate areas with the Locator ribbon bar:
Click the icon that represents the area you want to show in all windows that contain duplicate 

copies.    

You also can select the area you want to show in the Tool Options dialog box.

Related Topics:
Duplicate command
Hand tool
Scrolling



      Locator Tool Options    

 
To select Locator tool options:

Click the option for the area where you want to move. 
You also can click a button on the Locator ribbon bar to move to another area of the picture.

Related Topics:
Locator tool 



      Hand Tool -- Moving Areas of Your Picture into View 
 

To use the Hand tool:    
Drag the picture to bring the area you want into view.

To move the picture with the Hand tool ribbon bar:
Click the icon on the ribbon bar that represents the area of the picture where you want to move.

Related Topics:
Hand Tool Options 
Locator tool
Scrolling



      Hand Tool Options
To select Hand tool options:    

Click the option for the area where you want to move. 
You also can click a button on the Hand ribbon bar to move to another area of the picture.

Related Topics:
Hand tool 



      Local Undo Tool -- Undoing Some Changes 
 

To use the Local Undo tool:    

1 Adjust the tool's width and shape on the ribbon bar or in the Tool Options dialog box.    
2 Drag over areas you want to return to their previous look.     
3 Click the Undo All button to undo all changes made since the last time you chose a tool or 
command.

Related Topics:
Clear command 
Eraser tool
Revert command
Undo command



      Local Undo Tool Options
 

To set Local Undo tool options:
1 Adjust the tool's width and shape.

2 Adjust the spacing for the tool.

3 Use the tool with the settings and keep the dialog box displayed.     
4 Choose Close or Cancel to close the dialog box.

You also can use the ribbon bar to change most of the tool options.

Related Topics:
Local Undo tool 



      Box Selection Tool -- Defining a Rectangular Area 
 

To use the Box Selection tool:    
1 Select a background color if you plan to cut, delete, or move the cutout.

2 Press the left mouse button to anchor the starting point.

3 Drag to surround the area you want.    
4 Release the mouse button.     
5 Click a button on the ribbon bar or choose the appropriate Edit menu command to crop a defined 
area, select the entire picture, or deselect a defined area.
6 Click an icon on the ribbon bar or choose the appropriate Edit menu command to leave a copy of 
the original or paste the cutout transparently.

Related Topics:
Finding and Selecting Tools
Manipulating Defined Areas



      Magic Wand Tool -- Defining an Area of Similar Colors 
 

To use the Magic Wand tool:    
1 Select a background color if you plan to cut, delete, crop, or move the cutout.

2 Adjust the Range option on the ribbon bar or choose Tool Options to adjust the range of colors for 
selection.     

3 Point to the area you want to select and click the left mouse button.    
4 Click a button on the ribbon bar or choose the appropriate Edit menu command to crop a defined 
area, select the entire picture, or deselect a defined area. 
5 Click an icon on the ribbon bar or choose the appropriate Edit menu command to leave a copy of 
the original or paste the cutout transparently.

Related Topics:
Finding and Selecting Tools
Manipulating Defined Areas 
Understanding Color Tolerance 



Magic Wand Tool Options
 

To select Magic Wand tool options:

1 Use the Color Tolerance mini-scroll bars to adjust the range of the colors to be selected.    
2 Choose OK.     

You also can use the ribbon bar to change some of the tool options.

Related Topics:
Magic Wand tool 



      Lasso Tool -- Defining an Irregular Area 
 

To use the Lasso tool:    
1 Select a background color if you plan to cut, delete, crop, or move the cutout.

2 Press the left mouse button to anchor the starting point.

3 Drag to surround the area you want to define.     
4 Release the mouse button to complete the cutout.    
5 Click a button on the ribbon bar or choose the appropriate Edit menu command to crop a defined 
area, select the entire picture, or deselect a defined area.
6 Click an icon on the ribbon bar or choose the appropriate Edit menu command to leave a copy of 
the original or paste the cutout transparently.

Related Topics:
Finding and Selecting Tools
Manipulating Defined Areas



      Scissors Tool -- Defining a Polygonal Area 
 

To use the Scissors tool:    
1 Select a background color if you plan to cut, delete, crop, or move the cutout.

2 Click the mouse button to anchor the starting point.

3 Continue clicking around the area you want to define.     
4 Double-click to end the last line and complete the cutout.    
5 Click a button on the ribbon bar or choose the appropriate Edit menu command to crop a defined 
area, select the entire picture, or deselect a defined area.
6 Click an icon on the ribbon bar or choose the appropriate Edit menu command to leave a copy of 
the original or paste the cutout transparently.

Related Topics:
Finding and Selecting Tools
Manipulating Defined Areas



      Elliptical Selection Tool -- Defining an Elliptical Area 
 

To use the Elliptical Selection tool:    
1 Select a background color if you plan to cut, delete, crop, or move the cutout.

2 Press the left mouse button to set the center of the cutout.

3 Drag to surround the area you want.     
4 Release the mouse button to complete the cutout.    
5 Click a button on the ribbon bar or choose the appropriate Edit menu command to crop a defined 
area, select the entire picture, or deselect a defined area.
6 Click an icon on the ribbon bar or choose the appropriate Edit menu command to leave a copy of 
the original or paste the cutout transparently.

Related Topics:
Finding and Selecting Tools
Manipulating Defined Areas



Manipulating Defined Areas 
 

Define a cutout with a selection tool and a marquee surrounds the selected area. 
To permanently paste the cutout, click outside the marquee, choose a tool, or choose Select None on the 
ribbon bar or from the Edit menu.
You can manipulate the cutout in the following ways:

Choose Transform Free Resize if you want handles to appear around the cutout. A check mark 
appears beside the command to show that it is selected. 

Point to one of the handles. When the cursor is shaped like a cross hair, drag to enlarge or shrink 
the cutout. Press Shift as you drag to retain the proportions of the cutout.

Point inside the marquee. When the cursor is shaped like a hand, drag to move the cutout to 
another location. You can also use the arrow keys to move the cutout one pixel at a time.

Choose the Select Transparent command, choose the Select Transparent icon on the ribbon bar, 
or drag with the right mouse button to make the background color of the cutout transparent -- colors in the
original picture show through the cutout where the background color is. You can also choose the Select 
Transparent icon

Clear the Select Transparent command or the icon on the ribbon bar and drag with the left mouse
button to make the cutout solid -- the entire cutout appears on the original picture.

Choose the Select Leave Original command, choose the Select Transparent icon on the ribbon 
bar, or hold down Shift while you drag to leave a single copy behind.

Hold down Ctrl while you drag to leave a trail of copies behind.
Choose a command from the Edit or Image menu to manipulate the cutout in other ways. For 

example, you can apply the Filter, Special Effect, Tune, and Transform commands.

Related Topics:
Box Selection tool
Elliptical Selection tool
Lasso tool
Magic Wand tool
Scissors tool
The Edit Menu
The Image Menu



The Tool Options command is unavailable for all selection tools except the Magic Wand tool. You 
can choose Crop, Select All, Select None, Select Leave Original, and Select Transparent from the Edit 
menu.



      Text Tool -- Adding Text to Your Picture 
 

To use the Text tool:

1 Choose the Text tool and type your text in the Enter Text dialog box.     
2 Choose OK.    
3 To edit your text, press the spacebar and make the changes before you paste the text.    
4 Select a different font from the ribbon bar or in the Tool Options dialog box.
5 Select a font size, style, and effect from the ribbon bar or in the Tool Options dialog box.
6 Select a secondary color for your text and the Underline effect and a primary color for the Outline 
or Shadow effect.
7 Click outside the text frame or choose a tool to paste the text.

Related Topics:
Font command
Text Tool Options 



      Text Tool Options
 

To select Text tool options:
1 Select a font from the Font list.

2 Select a size for the font from the Size list.

3 Select a Style and Effect option to change the style of the text.     
4 Select a Justification option to set the alignment of the text.     

You also can use the ribbon bar to change the tool options.

Related Topics:
Text tool 



      Eyedropper Tool -- Picking Up a Color from the Picture 
 

To use the Eyedropper tool:
1 On the ribbon bar or in the Tool Options dialog box, select the number of pixels PhotoFinish uses to 
calculate a color selection.

2 Point to the color you want to pick up from the picture.

3 Click the appropriate mouse button to select a color.    

Related Topics:
Selecting Tool Colors



      Eyedropper Tool Options 
 

To set Eyedropper tool options:
To select a color from a single pixel, choose Single Pixel.
To select an average color in a group of pixels, choose an average option.    

You also can use the ribbon bar to change the tool option.

Related Topics:
Eyedropper tool



      Paintbrush Tool -- Painting Freehand 
 

To use the Paintbrush tool:
1 Choose a primary or secondary color.

2 Adjust the tool's effect on the ribbon bar or in the Tool Options dialog box.

3 Adjust the tool's width and shape on the ribbon bar or in the Tool Options dialog box.    
4 Click the Paper button to adjust the paper effect when you use the tool with some Tool Types.
5 Drag with the left mouse button to paint with the primary color or the right mouse button to paint 
with the secondary color.    



      Paintbrush Tool Options 

To adjust Paintbrush options:
1 Select a tool type from the Tool Type drop-down list.

2 Adjust the transparency, pressure, and spacing for the tool.

3 Adjust the tool's width and shape.

4 Click the Paper button to adjust the paper effect if you select a Tool Type that uses paper.

5 Use the tool with the settings and keep the dialog box displayed.     
6 Choose Close or Cancel to close the dialog box.

You also can use the ribbon bar to change most of the tool options.

Related Topics:
Paintbrush tool



      Paintbrush Tool Types

Basic Paintbrush paints smooth, soft-edged brush strokes. Paper is used.
Flat Color paints solid color, hard-edged brush strokes. Use this tool type to paint a solid line. 

Transparency, Pressure, and Paper are ignored.
Jitter splashes paint along the length of the brush stroke. Adjust the Spacing option to set how far

apart the paint drops are splashed. Paper is used.
Jitter Rainbow splashes multi-colored paint along the length of the brush stroke. Drag with the 

left mouse button to cycle through colors from the primary to the secondary color. Drag with the right 
mouse button to cycle through colors from the secondary to the primary color. Adjust the Spacing option 
to set how far apart the paint drops are splashed. Paper is used.

Jitter Two Tone splashes paint along the length of the brush stroke, changing from the primary to
the secondary color. Click the mouse button to restart the color gradation. Drag with the right mouse 
button to change from the secondary color to the primary color. Adjust the Spacing option to set how far 
apart the paint drops are splashed. Paper is used.

Neon paints smooth, soft-edged strokes that fade to white along the centerline of the stroke, 
simulating the glow of a neon light. This effect is most apparent when you paint on a medium to dark area
with a medium color in a 24 bit color picture. Paper is used.

Rainbow paints smooth, soft-edged strokes that cycle through colors from the primary to the 
secondary color. Drag with the right mouse button to cycle through colors from the secondary to the 
primary color. Paper is used.

Soft paints smooth, soft-edged strokes. The effect is most apparent in gray scale and 24 bit color 
pictures. Paper is ignored.

Two Tone paints smooth, soft-edged strokes that change color from the primary to the secondary
color. Click the mouse button to restart the color gradation. Drag with the right mouse button to change 
from the secondary color to the primary color. Adjust the width of the tool to change the rate at which the 
colors change. Paper is used.

Wash paints smooth, soft-edged strokes with pale, diluted paint. The effect is most apparent in 
gray scale and 24 bit color pictures. Paper is used.

Wet Oil Paint paints smooth, soft-edged strokes with the primary color gradually mixing with the 
color underneath, simulating the effect of an oil brush running out of paint on a canvas. Continuing to 
paint after the primary color runs out smears the paint under the stroke. Drag with the right mouse button 
to mix the colors already in the picture. Paper is used.

Related Topics:
Paintbrush tool 
Paintbrush Tool Options 



      Eraser Tool -- Erasing Parts of Your Picture 
 

To use the Eraser tool:     

1 Choose a background color.    
2 Adjust the tool's effect on the ribbon bar or in the Tool Options dialog box.
3 Adjust the tool's width and shape on the ribbon bar or in the Tool Options dialog box.    
4 Click the Paper button to adjust the paper effect when you use the tool with some Tool Types.
5 Drag over areas you want to erase.    

Related Topics:
Finding and Selecting Tools



      Eraser Tool Options
 

To adjust Eraser options:
1 Select a tool type from the Tool Type drop-down list.

2 Adjust the transparency, pressure, and spacing for the tool.

3 Adjust the width and shape of the tool.

4 Click the Paper button to adjust the paper effect if you select a Tool Type that uses paper.

5 Use the tool with the settings and keep the dialog box displayed.     
6 Choose Close or Cancel to close the dialog box.

You also can use the ribbon bar to change most of the tool options.

Related Topics:
Eraser tool 



      Eraser Tool Types
 

Basic erases to the background color using a soft-edged eraser. Paper is ignored.
Bleach uses a lighter hue of the background color. Continue dragging over the same area to 

erase to white. The effect is similar to wiping a bleached soaked cloth across a printed fabric. The effect is
most apparent in gray scale and 24 bit color pictures. Paper is used. 

Hard erases to the background color using a solid, hard-edged eraser. Pressure, Transparency, 
and Paper are ignored.

Soft Bleach is similar to the Bleach tool type, but ignores the paper.
Related Topics:
Eraser tool 
Eraser Tool Options 



      Color Replacer Tool -- Replacing One Color with Another 
 

To use the Color Replacer tool:    
1 Choose a primary color (the color you want to change) and a secondary color (the color you want to 
paint with).

2 Adjust the tool's width and shape on the ribbon bar or in the Tool Options dialog box.    
3 Adjust the Range option on the ribbon bar or in the Tool Options dialog box to adjust the range of 
colors to replace.     
4 Drag over areas you want to change.     
5 Click Replace All on the ribbon bar to automatically change all instances of the primary color to 
the secondary color in the picture window. Choose Zoom To Fit if the picture is larger than the 
PhotoFinish desktop and you want to replace colors in the entire picture.

Related Topics:
Finding and Selecting Tools



      Color Replacer Tool Options
 

To adjust Color Replacer options:
1 Adjust the tool's width and shape.

2 Use the Color Tolerance mini-scroll bars to adjust the range of colors to replace.     
3 Use the tool with the settings and keep the dialog box displayed.     
4 Choose Close or Cancel to close the dialog box.

You also can use the ribbon bar to change most of the tool options.

Related Topics:
Color Replacer tool 



      Airbrush Tool -- Shading with the Airbrush 
 

To use the Airbrush tool:    
1 Choose a primary color or secondary color.

2 Adjust the tool's effect on the ribbon bar or in the Tool Options dialog box.

3 Adjust the tool's width and shape on the ribbon bar or in the Tool Options dialog box.    
4 Drag with the left mouse button to paint with the primary color or the right mouse button to paint 
with the secondary color.    

Related Topics:
Airbrush Tool Types 
Finding and Selecting Tools



      Airbrush Tool Options
 

To adjust Airbrush options:
1 Select a tool type from the Tool Type drop-down list.

2 Adjust the transparency, spacing, and Rate of Flow for the tool.

3 Adjust the tool's width and shape.

4 Use the tool with the settings and keep the dialog box displayed.     
5 Choose Close or Cancel to close the dialog box.

You also can use the ribbon bar to change most of the tool options.

Related Topics:
Airbrush tool 



      Airbrush Tool Types
 

Basic Airbrush sprays very smooth, soft-edged strokes that build up if you hold the tool over the 
same area. Paper is ignored.

Bull's Eye sprays a pattern of several diffused concentric circles similar to a target. The circles 
build up if you hold the tool over the same area. Paper is ignored. 

Fat Tip sprays very smooth, slightly soft strokes that quickly build up if you hold the tool over the 
same area. Paper is ignored. 

Feather Tip sprays very smooth strokes that build up if you hold the tool over the same area. The
width of the strokes is slightly smaller than the selected tool width. Paper is ignored. 

Ring sprays a pattern of diffused circles that build up if you hold the tool over the same area. 
Paper is ignored.

Related Topics:
Airbrush tool 
Airbrush Tool Options 



      Spraycan Tool -- Splattering Color with the Spraycan 
 

To use the Spraycan tool:    
1 Choose a primary color or secondary color.

2 Adjust the tool's effect on the ribbon bar or in the Tool Options dialog box.

3 Adjust the tool's width and shape on the ribbon bar or in the Tool Options dialog box.    
4 Drag with the left mouse button to paint with the primary color or the right mouse button to paint 
with the secondary color.     

Related Topics:
Finding and Selecting Tools
Spraycan Tool Types 



      Spraycan Tool Options
 

To adjust Spraycan options:
1 Select a tool type from the Tool Type drop-down list.

2 Adjust the transparency, spacing, and Rate of Flow for the tool.

3 Adjust the tool's width and shape.

4 Use the tool with the settings and keep the dialog box displayed.     
5 Choose Close or Cancel to close the dialog box.

You also can use the ribbon bar to change most of the tool options.

Related topics:
Spraycan tool 



      Spraycan Tool Types
 

Basic Spraycan sprays moderately smooth, soft-edged strokes that build up if you hold the tool 
over the same area. Paper is ignored.

Graffiti sprays moderately smooth, soft-edged strokes that run and drip if the paint accumulation 
becomes too thick. Paper is ignored.

Splatter sprays a diffused pattern of paint. Use this tool type to add texture to an overly blended 
area. Paper is ignored.

Two Tone Splatter sprays a diffused pattern mixture of the primary and secondary color, with the 
primary color prevalent. Drag with the right mouse button if you want the secondary color to be prevalent. 
Paper is ignored.

Related Topics:
Spraycan tool 
Spraycan Tool Options 



      Pen Tool -- Drawing Freehand Shapes
 

To use the Pen tool:
1 Choose a primary color.

2 Adjust the tool's effect on the ribbon bar or in the Tool Options dialog box.

3 Adjust the tool's width and shape on the ribbon bar or in the Tool Options dialog box.    
4 Click the Paper button to adjust the paper effect when you use the Quill Tool Type. 
5 Drag with the left mouse button to paint with the primary color.    
6 You can click the right mouse button on a color in the picture to select it as the primary color.



      Pen Tool Options
 

To adjust Pen options:
1 Select a tool type from the Tool Type drop-down list.

2 Adjust the transparency, pressure, and spacing for the tool.

3 Adjust the tool's width and shape.

4 Click the Paper button to adjust the paper effect when you use the Quill Tool Type.

5 Use the tool with the settings and keep the dialog box displayed.     
6 Choose Close or Cancel to close the dialog box.

You also can use the ribbon bar to change most of the tool options.

Related Topics:
Pen tool 



      Pen Tool Types
 

Basic Pen paints solid color, hard-edged lines. This tool type is especially useful for editing 
individual pixels at high zoom levels. Pressure, Transparency, and Paper are ignored.

Ball Point paints smooth, soft-edged lines that simulate the effect of a ball point pen. Paper is 
ignored.

Calligraphy paints solid color, hard-edged lines with an angled nib, allowing you to create pen 
strokes where the apparent line width varies according to the direction of the stroke. Pressure, 
Transparency, and Paper are ignored.

Fine Point paints thin, soft-edged lines that simulate the effect of a fine-point pen. The width of 
the lines is smaller than the selected tool width. Paper is ignored. 

Medium Point paints smooth, soft-edged lines that simulate the effect of a medium-point pen. 
The width of the lines is slightly smaller than the selected tool width. Paper is ignored. 

Quill paints smooth, soft-edged lines that fade as the tool runs out of ink. Click the mouse button 
to add ink. Paper is used.

Related Topics:
Pen tool 
Pen Tool Options 



      Charcoal Tool -- Drawing Freehand with the Charcoal Tool 
 

To use the Charcoal tool:

1 Choose a primary or secondary color.     
2 Adjust the tool's effect on the ribbon bar or in the Tool Options dialog box.
3 Adjust the tool's width and shape on the ribbon bar or in the Tool Options dialog box.    
4 Click the Paper button to adjust the paper effect when you use the tool with some Tool Types.
5 Drag with the left mouse button to paint with the primary color or the right mouse button to paint 
with the secondary color.     



      Charcoal Tool Options
 

To adjust Charcoal options:
1 Select a tool type from the Tool Type drop-down list.

2 Adjust the transparency, pressure, and spacing for the tool.

3 Adjust the tool's width and shape.

4 Click the Paper button to adjust the paper effect if you select a Tool Type that uses paper.

5 Use the tool with the settings and keep the dialog box displayed.     
6 Choose Close or Cancel to close the dialog box.

You also can use the ribbon bar to change most of the tool options.

Related Topics:
Charcoal tool 



      Charcoal Tool Types
 

Basic Charcoal paints a moderately grainy, soft-edged charcoal mark. Paper is used.
Gritty paints a light grainy, soft-edged charcoal mark. Paper is ignored.
Soft paints a smooth, soft-edged charcoal mark. Paper is used.

Related Topics:
Charcoal tool 
Charcoal Tool Options 



      Chalk Tool -- Drawing Freehand with the Chalk Tool
 

To use the Chalk tool: 

1 Choose a primary or secondary color.     
2 Adjust the tool's effect on the ribbon bar or in the Tool Options dialog box.
3 Adjust the tool's width and shape on the ribbon bar or in the Tool Options dialog box.    
4 Click the Paper button to adjust the paper effect when you use the tool with some Tool Types.
5 Drag with the left mouse button to paint with the primary color or the right mouse button to paint 
with the secondary color with all but the Chalk Pastel tool type.     



      Chalk Tool Options
 

To adjust Chalk options:
1 Select a tool type from the Tool Type drop-down list.

2 Adjust the transparency, pressure, and spacing for the tool.

3 Adjust the tool's width and shape.

4 Click the Paper button to adjust the paper effect if you select a Tool Type that uses paper.

5 Use the tool with the settings and keep the dialog box displayed.     
6 Choose Close or Cancel to close the dialog box.

You also can use the ribbon bar to change most of the tool options.

Related Topics:
Chalk tool 



      Chalk Tool Types
 

Basic Chalk paints grainy, soft-edged chalk marks. Paper is used.
Chalk Pastel paints smooth, soft-edged chalk marks that gradually fade and begin to mix the 

colors you are painting over. Click the mouse button to use the selected primary color again. Drag with 
the right mouse button to mix colors as if you were blending pastel chalks with your finger. Paper is used. 

Powdery paints very smooth, soft-edged chalk marks. Paper is ignored.
Related Topics:
Chalk tool 
Chalk Tool Options 



      Color Pencil Tool -- Painting with a Pencil Effect
 

To use the Color Pencil tool:
1 Choose a primary or secondary color.

2 Adjust the tool's effect on the ribbon bar or in the Tool Options dialog box.

3 Adjust the tool's width and shape on the ribbon bar or in the Tool Options dialog box.    
4 Click the Paper button to adjust the paper effect when you use the tool.
5 Drag with the left mouse button to paint with the primary color or the right mouse button to paint 
with the secondary color.     

Related Topics:
Color Pencil Tool Types 



      Color Pencil Tool Options
 

To adjust Color Pencil options:
1 Select a tool type from the Tool Type drop-down list.

2 Adjust the transparency, pressure, and spacing for the tool.

3 Adjust the tool's width and shape.

4 Click the Paper button to adjust the paper effect when you use the tool.

5 Use the tool with the settings and keep the dialog box displayed.     
6 Choose Close or Cancel to close the dialog box.

You also can use the ribbon bar to change most of the tool options.

Related Topics:
Color Pencil tool 



      Color Pencil Tool Types
 

Basic Color Pencil paints moderately smooth, soft-edged lines that smudge with the colors you 
are painting over. Paper is used.

Dull paints thick, soft-edged lines that simulate a dull pencil tip. The lines smudge the colors you 
are painting over. The effect is most apparent in 24 bit and gray scale pictures. Paper is used.

Sharp paints moderately smooth, thin lines that simulate a sharp pencil tip. The lines smudge 
with the colors you are painting over. The lines are smaller than the selected tool width. Paper is used. 

Related Topics:
Color Pencil tool 
Color Pencil Tool Options 



      Marker Tool -- Painting with Markers
 

To use the Marker tool:
1 Choose a primary or secondary color.

2 Adjust the tool's effect on the ribbon bar or in the Tool Options dialog box.

3 Adjust the tool's width and shape on the ribbon bar or in the Tool Options dialog box.    
4 Click the Paper button to adjust the paper effect when you use the tool.
5 Drag with the left mouse button to paint with the primary color or the right mouse button to paint 
with the secondary color.     

Related Topics:
Marker Tool Options 
Marker Tool Types 



      Marker Tool Options
 

To adjust Marker options:
1 Select a tool type from the Tool Type drop-down list.

2 Adjust the transparency, pressure, and spacing for the tool.

3 Adjust the tool's width and shape.

4 Click the Paper button to adjust the paper effect.

5 Use the tool with the settings and keep the dialog box displayed.     
6 Choose Close or Cancel to close the dialog box.

You also can use the ribbon bar to change most of the tool options.

Related Topics:
Marker tool 



      Marker Tool Types
 

Basic Marker paints smooth, soft-edged lines that gradually smudge with the colors you are 
painting over. The effect varies slightly depending on the paper type.

Felt Tip The Felt Tip Marker paints smooth, soft-edged lines that are heavier and smudge more 
quickly than the Basic Marker. The effect varies slightly depending on the paper.

Fine Point paints smooth, soft-edged lines that smudge. The lines are smaller than the selected 
tool width. The effect varies slightly depending on the paper. 

Highlighter paints smooth, soft-edged lines with a high degree of transparency. The effect varies 
slightly depending on the paper.

Smudge paints smooth, soft-edged lines that blend and smudge more than the other Markers. 
The effect varies slightly depending on the paper. 

Related Topics:
Marker tool 
Marker Tool Options 



      Crayon Tool -- Painting with Crayons
 

To use the Crayon tool:
1 Choose a primary or secondary color. 

2 Adjust the tool's effect on the ribbon bar or in the Tool Options dialog box.

3 Adjust the tool's width and shape on the ribbon bar or in the Tool Options dialog box.    
4 Click the Paper button to adjust the paper effect when you use the tool.
5 Drag with the left mouse button to paint with the primary color or the right mouse button to paint 
with the secondary color with all but the Oil Pastel tool type.     

Related Topics:
Crayon Tool Types 



      Crayon Tool Options
 

To adjust Crayon options:
1 Select a tool type from the Tool Type drop-down list.

2 Adjust the transparency, pressure, and spacing for the tool.

3 Adjust the tool's width and shape.

4 Click the Paper button to adjust the paper effect when you use the tool.

5 Use the tool with the settings and keep the dialog box displayed.     
6 Choose Close or Cancel to close the dialog box.

You also can use the ribbon bar to change most of the tool options.

Related Topics:
Crayon tool 



      Crayon Tool Types
 

Basic Crayon paints grainy, soft-edged crayon marks. The lines are slightly smaller than the 
selected tool width. Paper is used.

Dull paints dense, moderately smooth and broad crayon marks. Paper is used.
Oil Pastel paints smooth, even oil pastel marks that gradually fade and begin to mix the colors 

you are painting over. Click the mouse button to use the selected primary color again. Drag with the right 
mouse button to mix the colors as if you were smudging them with your finger. Paper is used.

Sharp paints thin, dense crayon marks with grainy edges. The lines are much smaller than the 
selected tool width. Paper is used.

Waxy paints moderately smooth, semi-transparent crayon marks with a very soft edge. Paper is 
used.

Related Topics:
Crayon tool 
Crayon Tool Options 



      Paint Roller Tool -- Filling an Area
 

To use the Paint Roller tool:
1 Choose a primary color, secondary color or background color, or load a tile pattern. 

2 Adjust the Range option on the ribbon bar or in the Tool Options dialog box to adjust the range of colors
to fill.     

3 Select a Tool Type from the ribbon bar or in the Tool Options dialog box.     
4 Place the drop on the pointer inside the area you want to fill.    
5 Click the mouse button to fill.     



      Paint Roller Tool Options
 

To adjust Paint Roller options:

1 Select the type of fill you want from the Tool Type    drop-down list.     
2 Use the Color Tolerance mini-scroll bars to adjust the range of colors to fill.     
3 Use the tool with the settings and keep the dialog box displayed.     
4 Choose Close or Cancel to close the dialog box.

You also can use the ribbon bar to change most of the tool options.

Related Topics:
Gradient Type command 
Paint Roller tool 
Tile Pattern command 



      Paint Roller Tool Types
 

Basic Paint Roller fills with color. Click the left mouse button to fill with the primary color. Click 
the right mouse button to fill with the secondary color.

Gradient fills with a gradient that begins with the secondary color and ends with the background 
color. 

Tile fills with a selected tile pattern. If the selected primary color is in the tile pattern, those areas 
are transparent in the picture -- colors already in the picture show through the tile pattern.

Related Topics:
Gradient Type command 
Paint Roller tool 
Paint Roller Tool Options 
Tile Pattern command 



      Box Tool -- Drawing a Box 
 

To use the Box tool:    
1 Choose a primary color, secondary color or background color, or load a tile pattern. 

2 Select a Tool Type from the drop-down list on the ribbon bar or in the Tool Options dialog box.     
3 Select a Style on the ribbon bar or in the Tool Options dialog box.     
4 If you select the Hollow or Filled With Border style, adjust the width of the border with the Width 
mini-scroll bar on the ribbon bar or in the Tool Options dialog box.
5 Press the left mouse button to anchor the starting point.
6 Drag to paint the shape.    

Related Topics:
Finding and Selecting Tools



      Box Tool Types
 

Basic Box paints boxes filled with the secondary color. Select the Filled With Border Style if you 
want a border in the primary color.

Gradient paints boxes filled with a gradient that begins with the secondary color and ends with 
the background color. Select the Filled With Border Style if you want a border in the primary color.

Tile paints boxes filled with a selected tile pattern. Select the Filled With Border Style if you want 
a border in the primary color.

Related Topics:
Box tool 
Gradient Type command 
Tile Pattern command 



      Rounded Box Tool -- Drawing a Rounded Box 
 

To use the Rounded Box tool:    
1 Choose a primary color or secondary color. 

2 Select a Style on the ribbon bar or in the Tool Options dialog box.     
3 If you select the Hollow or Filled With Border style, adjust the width of the border with the Width 
mini-scroll bar on the ribbon bar or in the Tool Options dialog box.
4 Press the left mouse button to anchor the starting point
5 Drag to paint the shape.    

Related Topics:
Finding and Selecting Tools



      Ellipse/Circle Tool -- Drawing an Ellipse/Circle 
 

To use the Ellipse/Circle tool:    
1 Choose a primary color and secondary color. 

2 Select a Style on the ribbon bar or in the Tool Options dialog box.    
3 If you select the Hollow or Filled With Border style, adjust the width of the border with the Width 
mini-scroll bar on the ribbon bar or in the Tool Options dialog box.
4 Press the left mouse button to anchor the starting point.
5 Drag outward to paint the shape.    

Related Topics:
Finding and Selecting Tools



      Regular Polygon Tool -- Drawing an Equal-sided Polygon 
 

To use the Regular Polygon tool:    
1 Choose a primary color and secondary color. 

2 Select a Style on the ribbon bar or in the Tool Options dialog box.    
3 If you select the Hollow or Filled With Border style, adjust the width of the border with the Width 
mini-scroll bar on the ribbon bar or in the Tool Options dialog box. 
4 Select the number of sides you want from the ribbon bar or in the Tool Options dialog box.
5 Press the left mouse button to set the center point.
6 Drag outward to paint the shape.    

Related Topics:
Finding and Selecting Tools 



      Polygon Tool -- Drawing a Polygon 
 

To use the Polygon tool:    
1 Choose a primary color and secondary color. 

2 Select a Style on the ribbon bar or in the Tool Options dialog box.    
3 If you select the Hollow or Filled With Border style, adjust the width of the border with the Width 
mini-scroll bar on the ribbon bar or in the Tool Options dialog box. 
4 Click the mouse button to anchor the starting point.
5 Move to where you want the next side of the polygon to end and click again.     
6 Continue pointing and clicking to paint the shape.     
7 Double-click to end the last line and complete the shape.

Related Topics:
Finding and Selecting Tools



    
    
    
    
      Shape Tools Options
 

To adjust shape tools options:

1 Select a Style from the drop-down list.     
2 If you select the Hollow or Filled With Border style, adjust the width of the border.
3 If you are using the Box tool, select a Tool Type from the drop-down list.
4 Use the tool with the settings and keep the dialog box displayed.     
5 Choose Close or Cancel to close the dialog box.

You also can use the ribbon bar to adjust the tool options.

Related Topics:
Box tool 
Ellipse/Circle tool 
Polygon tool 
Regular Polygon tool 
Rounded Box tool 



      Line Tool -- Drawing Single and Joined Lines 
 

To use the Line tool:     

1 Select a primary color.

2 Select a Tool Type from the ribbon bar or in the Tool Options dialog box.     
3 Adjust the tool's width and shape on the ribbon bar or in the Tool Options dialog box.     
4 Press the left mouse button to anchor the starting point.
5 Drag to where you want to end the line.    
6 You can also paint joined lines or rays joined at a single point.    

Related Topics:
Finding and Selecting Tools 



      Line Tool Options
 

To adjust Line options:

1 Select a tool type from the Tool Type drop-down list.     
2 Adjust the tool's width and shape.     
3 Use the tool with the settings and keep the dialog box displayed.     
4 Choose Close or Cancel to close the dialog box.

You also can use the ribbon bar to change the tool options.

Related Topics:
Line tool 
Tile Pattern command 



      Line Tool Types
 

Basic Line paints lines in the primary color.
Tile paints lines with the selected tile pattern.

Related Topics:
Line tool 
Line Tool Options 



      Curve Tool -- Drawing Single and Joined Curves 
 

To use the Curve tool:    
1 Choose a primary color.

2 Adjust the tool's width in the ribbon bar or in the Tool Options dialog box.

3 Press the left mouse button to anchor the starting point.

4 Drag to where you want the curve to end.

5 Use the handles to adjust the curve.    
6 Click outside the curve to paste it.    

Related Topics:
Finding and Selecting Tools



      Curve Tool Options
 

To adjust Curve tool options:
1 Adjust the tool's width.

2 Use the tool with the settings and keep the dialog box displayed.     
3 Choose Close or Cancel to close the dialog box.

You also can use the ribbon bar to change the tool options.



      Contrast Paintbrush Tool -- Changing Contrast Freehand 
To adjust contrast in areas:    
1 Adjust the tool's effect on the ribbon bar or in the Tool Options dialog box.
2 Adjust the tool's width and shape.    
3 Drag over areas you want to change.    
Related Topics:
Tune Brightness and Contrast command
Tune Equalize command



      Contrast Paintbrush Tool Options
 

To adjust Contrast Paintbrush options:
1 Select an amount from the Amount drop-down list.     
2 Adjust the Spacing for the tool.
3 Adjust the tool's Width and Shape.
4 Use the tool with the settings and keep the dialog box displayed.     
5 Choose Close or Cancel to close the dialog box.

You also can use the ribbon bar to change most of the tool options.

Related Topics:
Contrast Paintbrush tool



      Brighten Paintbrush Tool -- Brightening Freehand 
To brighten areas:    
1 Adjust the tool's effect on the ribbon bar or in the Tool Options dialog box.
2 Adjust the tool's width and shape.    
3 Drag over areas you want to change.    
Related Topics:
Tune Brightness and Contrast command
Tune Color/Gray Map command



      Brighten Paintbrush Tool Options
 

To adjust Brighten Paintbrush options:
1 Select an amount from the Amount drop-down list.     
2 Adjust the Spacing for the tool.
3 Adjust the tool's Width and Shape.
4 Use the tool with the settings and keep the dialog box displayed.     
5 Choose Close or Cancel to close the dialog box.

You also can use the ribbon bar to change most of the tool options.

Related Topics:
Brighten Paintbrush tool 



      Tint Paintbrush Tool -- Tinting Freehand 
To tint areas:    
1 Choose a primary color.
2 Adjust the tool's effect on the ribbon bar or in the Tool Options dialog box.
3 Adjust the tool's width and shape.    
4 Drag over the areas you want to change.    



      Tint Paintbrush Tool Options
 

To adjust Tint Paintbrush options:
1 Select an amount from the Amount drop-down list.     
2 Adjust the Spacing for the tool.
3 Adjust the tool's Width and Shape.
4 Use the tool with the settings and keep the dialog box displayed.     
5 Choose Close or Cancel to close the dialog box.

You also can use the ribbon bar to change most of the tool options.

Related Topics:
Tint Paintbrush tool 



      Blend Paintbrush Tool -- Blending Freehand 
To blend areas:     
1 Adjust the tool's effect on the ribbon bar or in the Tool Options dialog box.
2 Adjust the tool's width and shape.    
3 Drag over areas you want to change.    
Related Topics:
Filter Blend command



      Blend Paintbrush Tool Options
 

To adjust Blend Paintbrush options:
1 Select an amount from the Amount drop-down list.     
2 Adjust the Spacing for the tool.
3 Adjust the tool's Width and Shape.
4 Use the tool with the settings and keep the dialog box displayed.     
5 Choose Close or Cancel to close the dialog box.

You also can use the ribbon bar to change most of the tool options.

Related Topics:
Blend Paintbrush tool 



      Sharpen Paintbrush Tool -- Sharpening Freehand 
To sharpen areas:     
1 Adjust the tool's effect on the ribbon bar or in the Tool Options dialog box.
2 Adjust the tool's width and shape.    
3 Drag over the areas you want to change.    
Related Topics:
Filter Sharpen command



      Sharpen Paintbrush Tool Options
 

To adjust Sharpen Paintbrush options:
1 Select an amount from the Amount drop-down list.     
2 Adjust the Spacing for the tool.
3 Adjust the tool's Width and Shape.
4 Use the tool with the settings and keep the dialog box displayed.     
5 Choose Close or Cancel to close the dialog box.

You also can use the ribbon bar to change most of the tool options.

Related Topics:
Sharpen Paintbrush tool 



      Smudge Paintbrush Tool -- Smudging Freehand 
To smudge areas:
1 Adjust the tool's effect on the ribbon bar or in the Tool Options dialog box.
2 Adjust the tool's width and shape on the ribbon bar or in the Tool Options dialog box.    
3 Click the Paper button to adjust the paper effect when you use the tool with some 
Tool Types.
4 Drag over the areas you want to change.     



      Smudge Paintbrush Tool Options
 

To adjust Smudge Paintbrush options:
1 Select a tool type from the Tool Type drop-down list.
2 Adjust the Transparency, Pressure, and Spacing for the tool.
3 Adjust the tool's Width and Shape.
4 Click the Paper button to adjust the paper effect if you select a Tool Type that uses paper.
5 Use the tool with the settings and keep the dialog box displayed.     
6 Choose Close or Cancel to close the dialog box.

You also can use the ribbon bar to change most of the tool options.

Related Topics:
Smudge Paintbrush tool



Smudge Paintbrush Tool Types

Basic Smudge smudges areas using the colors you drag over. Paper is ignored. 
Glaze smears the colors you drag over, giving the appearance of an uneven glaze. 

Paper is used.
Grainy scatters the colors you drag over. Paper is ignored.
Mix lightly smudges areas using the colors you drag over. Paper is used.
Smear smudges areas by "pushing" the pixels aside. Paper is ignored.
Sprinkle spreads the colors you drag over. It looks like scattered water drops. Paper 

type is used.
Related Topics:
Smudge Paintbrush tool 
Smudge Paintbrush Tool Options 



      Clone Tool -- Replacing One Area with Another Freehand 
 

To use the Clone tool:    
1 Adjust the tool's effect on the ribbon bar or in the Tool Options dialog box.     
2 Adjust the tool's width and shape.    
3 Click the right mouse button on the area you want to clone (source).    
4 Drag to begin cloning.    



      Clone Tool Options
 

To adjust Clone tool options:
1 Adjust the Transparency and Spacing for the tool.
2 Adjust the tool's Width and Shape.
3 Use the tool with the settings and keep the dialog box displayed.     
4 Choose Close or Cancel to close the dialog box.

You also can use the ribbon bar to change most of the tool options.

Related Topics:
Clone tool 



The Help Menu 
 

You use Help menu commands to open the PhotoFinish help program and learn more about 
commands, procedures, tools, and shortcuts. Use the About command on the Help menu to 
see the version of PhotoFinish you are using.
To learn how to use on-line help, choose How to Use Help from the Help menu. Choose 
Search for Help on... to search for help on topics that relate to a specific word or phrase.
To choose a Help menu command, click Help and choose a command.
Help Menu Commands 
Contents: Displays topics you can choose from.
Commands: Lists and explains PhotoFinish menus and commands.
Procedures: Lists topics that help you work with PhotoFinish.
Shortcuts: Explains shortcuts for choosing commands and selecting options.
Tools: Explains how to use PhotoFinish tools.
For Beginners: Explains basic PhotoFinish information.



For Beginners 
Welcome to PhotoFinish's help for beginners.
If you are unfamiliar with PhotoFinish, choose from the topics listed below. For more help on 
PhotoFinish, choose a command from the PhotoFinish Help menu, choose Help in any dialog 
box, click the right mouse button on a tool, browse through the Help system, or read the 
PhotoFinish User's Guide.
To learn about PhotoFinish Help features, point to the picture of the key and click the left 
mouse button.
To choose a Help topic with the mouse, point to words that have a solid underline. When the 
pointer becomes a hand, click the left mouse button. To read a glossary term, point to words 
with a dotted underline and click the left mouse button.
To choose a Help topic with the keyboard, tab to words that have a solid underline and press 
Enter. To read a glossary term, tab to words with a dotted underline and press Enter.
To learn how to use Windows on-line Help, choose How to Use Help from the Help menu in 
the PhotoFinish Help program. For help running Windows, check your Microsoft Windows 
User's Guide.
Help for Beginners
Calibrating Your Hardware 
Changing Tool Width and Shape 
Finding and Selecting Tools 
Memory Information 
PhotoFinish Commands 
Scrolling 
Selecting Memory Options 
Selecting Tool Colors 
Selecting Tool Settings 
Understanding File Formats 
Using Filter Commands 
Using PhotoFinish Windows 
Using Special Effect Commands 
Using Tune Commands 
Viewing Colors on Your Screen 
Working with Different Numbers of Colors 



Using PhotoFinish Windows 
PhotoFinish loads pictures into picture windows. The window's title bar displays the picture's 
name, magnification percentage, and the order in which it was opened or duplicated.
You can move, resize, and close a window, or reduce it to an icon.

To move a window to another location, drag the window's title bar.
To resize a window, place your pointer on a window border. When your pointer 

becomes a double-sided arrow, drag to resize the window.
To close, maximize, or minimize a window, choose the appropriate command from the

window's Control menu.
The Toolbox and Palette are individual workboxes you can show, hide, and move to control 
your desktop layout.
Related Topics:
Duplicate command 
Open command
Screen Layout AutoBar command 
Screen Layout Palette command
Screen Layout Ribbon Bar command 
Screen Layout Show/Hide All Workboxes command
Screen Layout Status Bar command
Screen Layout Toolbox command



Scrolling 
You use mini-scroll bars to cycle through fields in a dialog box instead of typing numbers.
You use sliders to set values for options in some dialog boxes instead of typing numbers.
You use scroll bars to display parts of your picture that do not fit in the picture window and 
portions of lists that are out of view. You can also use the Hand to move a picture around a 
window. The Hand works like scroll bars, but it also lets you move diagonally.
To use a mini-scroll bar:    

Click a scroll arrow to increase or decrease numbers by single increments.
Press a scroll arrow to continuously increase or decrease numbers.
Point to the middle of the scroll bar. When your pointer is a double-sided arrow with 

lines through the center, drag up or down to scroll through available values.

To use a slider:      
Drag an arrow to the right to quickly increase numbers, to the left to decrease 

numbers.
Click an arrow and then use the arrow keys on the keyboard to increase or decrease 

numbers one unit at a time.
To use a scroll bar:    

Click a scroll arrow to move one increment at a time.
Press a scroll arrow to move continuously.
Drag the scroll box to the general location you want to see.
Click inside the scroll bar to move the scroll box to that location.



PhotoFinish Commands 
You choose PhotoFinish commands from the menus along the top of the PhotoFinish desktop.
Some commands are also available on the PhotoFinish AutoBar and ribbon bar for some 
tools.
To choose a command on the AutoBar, just click the button you want. To choose a command 
from a menu, click the menu name in the menu bar and click the command you want. Some 
commands are on cascading menus.
File Menu 
Edit Menu 
Image Menu 
Scan Menu 
Display Menu 
Options Menu 
Window Menu 
Help Menu 
Control Menu 



Procedures 
 

Alphabetical List of Procedures: Displays icons you can click to jump to an alphabetical list of
the PhotoFinish Procedures.

Getting Acquainted: Lists topics that explain some basic techniques that make working with 
PhotoFinish even easier.

Customizing PhotoFinish: Lists topics that explain how set up your computer, scanner, and 
printer to get the most out of PhotoFinish.

Working with Pictures: Lists topics that explain basic techniques for working with pictures 
and picture files.

Working with Color: Lists topics that explain how to work with color.
Scanning: Lists topics that explain how to scan with PhotoFinish.
Working with Cutouts: Lists topics that explain how to define and enhance areas of your 

pictures.
Enhancing and Retouching: Lists topics that explain how to enhance and retouch cutouts or 

the entire picture.
Painting: Lists topics that explain the PhotoFinish painting tools.



PhotoFinish Shortcuts 
PhotoFinish provides many shortcuts to help you work more efficiently. You will often find the
use of accelerator keys to be faster than choosing commands from menus. In addition, many
PhotoFinish tools can be constrained so that you can draw perfect lines and geometric 
shapes.
Choose a topic below for more information.
Keyboard Shortcuts
Tool Constraints



Keyboard Shortcuts 
Use accelerator keys, shown beside some commands, to select a command. For example, 
use Ctrl+S to save a picture. You can also hold down Alt and type the underlined letter in a 
menu and the underlined letter in the command. For example, use the following keys to cut, 
copy, and paste: Alt+E,T to cut, Alt+E,C to copy, Alt+E,P to paste.
PhotoFinish Keystrokes
This key... ...does this.
Alt+F4 closes PhotoFinish.
Arrow keys moves a cutout one pixel at a time or a slider in a dialog box one unit

at a time.
Ctrl+1 returns a picture to one-to-one view.
Ctrl+A shows or removes the Palette and Toolbox.
Ctrl+B shows or removes the status bar.
Ctrl+C copies a defined area.
Ctrl+D duplicates the current picture.
Ctrl+F makes more work space available on the PhotoFinish desktop.
Ctrl+G rescans with your current scanning settings.
Ctrl+N scans an image.
Ctrl+O displays the tool options dialog box specific to the selected tool, if 

available.
Ctrl+P shows or removes the Palette.
Ctrl+R shows or removes the ribbon bar.
Ctrl+S saves your picture.
Ctrl+T shows or removes the Toolbox.
Ctrl+U shows or removes the AutoBar.
Ctrl+V pastes a cutout from the Clipboard.
Ctrl+X cuts a defined area.
Ctrl+Z undoes recent changes.
Del deletes the defined area without copying it to the Clipboard.
Esc erases some tools' effects before you release the mouse button.
F1 displays the PhotoFinish on-line Help system.
Shift+F4 tiles the windows on your PhotoFinish desktop.
Shift+F5 cascades the windows on your PhotoFinish desktop.
Windows Keystrokes
This key... ...does this.
Alt+spaceba
r

opens the program Control menu.

Alt+up or 
down arrow

opens a drop-down list after you tab to the list box.



Arrow keys moves within a list, display box, or group of choices in a dialog box.
Ctrl+F4 closes the current picture.
Ctrl+F6 switches to the next picture.
Enter chooses a highlighted command, selects an item from a list, and 

completes commands.
Esc cancels a dialog box.
F1 opens the on-line Help system and displays the Contents.
Shift+Tab moves from one area to another in a dialog box in reverse order.
Spacebar chooses a selection in a list or a check box option. Press the 

spacebar again to deselect the option.
Tab moves from one area to another in a dialog box.
Related Topics:
PhotoFinish Shortcuts



Tool Constraints 
For some tools, holding down Shift while you drag the mouse constrains the shape or 
direction of the effect. Press the spacebar to switch between horizontal and vertical 
constraint. Release the Shift key to use the tools normally.

Airbrush tool
Selection tools
Box tools
Chalk tool
Charcoal tool
Clone tool
Color Pencil tool
Color Replacer tool
Crayon tool
Ellipse tool
Eraser tool
Marker tool
Pen tool
Line tool
Local Undo tool
Paintbrush tools
Polygon tool
Regular Polygon tool
Spraycan tool

Related Topics:
PhotoFinish Shortcuts
PhotoFinish Tools



Trademarks and Tradenames 
PhotoFinish is a registered trademark and ZSoft, PhotoLibrary, AutoEnhance, AutoBar, and 
UltraFAX are trademarks of WordStar Atlanta Technology Center, Inc. WordStar Atlanta 
Technology Center, Inc., is a subsidiary of WordStar International Incorporated. WordStar is a 
registered trademark of WordStar International Incorporated.
Kodak Photo CD is a registered trademark of Eastman Kodak Company. Kodak Photo CD 
technology is a copyright of Eastman Kodak Company, 1991, 1992, and 1993.
Other product names mentioned may be trademarks or registered trademarks of their 
respective companies. Some trademarks may be registered in countries other than the U.S.



Update Info 
Welcome to PhotoFinish version 3.0!
PhotoFinish 3.0 has added even more automation to make editing your pictures even easier. 
PhotoFinish has added more than a dozen new commands and has more than doubled the 
number of tools and tool types. PhotoFinish now has nearly 90 tools and tool types -- 
including innovative natural art tools you can use to create your own artistic masterpiece.
This topic contains a summary of what is new in PhotoFinish 3.0. It also contains specific 
release information and other items that became available after the PhotoFinish manuals 
went to print.
What's New in PhotoFinish 3.0

The AutoBar has been added to the top of the PhotoFinish desktop. Just a click of the
mouse button lets you start, open, or save a picture; cut, copy, or paste a cutout; undo your 
last changes; automatically enhance the picture with several options; automatically adjust 
brightness and contrast, crop the border from a picture, remove moiré patterns, adjust the 
intensity of colors in the picture, sharpen the picture, or straighten the picture; or 
automatically scan a picture.

Press Ctrl+U or use the Screen Layout AutoBar command to display or hide the 
AutoBar.

Six new Auto commands have been added to the Image menu. 
Choose Auto Brightness/Contrast to have PhotoFinish automatically adjust brightness 

and contrast in the entire picture.
Choose Auto Crop to automatically crop the border from a picture.

Choose Auto Remove Moiré to automatically remove moiré patterns from the entire 
picture.
Choose Auto Saturation to automatically adjust the intensity of colors in the entire picture.
Choose Auto Sharpen to automatically sharpen the entire picture
Choose Auto Straighten to automatically straighten or deskew the entire picture.
All of these commands are available for 24 bit color pictures. All but the Auto Saturation 
command are available for gray scale pictures.

The ribbon bar has been added to the PhotoFinish desktop. The ribbon bar changes 
depending on the selected tool. You can quickly change most of the tool's settings with a 
click of the mouse button on the ribbon bar. Some ribbon bars also have command buttons 
you can click to quickly perform a task. For example, if the selected tool is the Zoom tool 
and you have zoomed in on a picture, click the Fit To Zoom button on the button bar to 
resize the picture window so you can see more of the zoomed-in picture.

Press Ctrl+R or use the Screen Layout Ribbon Bar command to display or hide the ribbon 
bar.

The Samples command has been added to the Filter, Special Effect, and Tune 
cascading menus on the Image menu. These commands make it easy to decide which Filter, 
Special Effect, or Tune command to apply to the picture or cutout.

Choose Filter Samples to see how the other Filter commands may change the picture 
or cutout. 

Choose Special Effect Samples to see how the other Special Effect commands may 
change the picture or cutout. 

Choose Tune Samples to see how the other Tune commands may change the picture 
or cutout.

Individual Filter, Special Effect, and Tune commands also display samples of how 
the command will change the picture or cutout. Click the Shrink or Expand button to display 
more samples of the command using different settings. Click Advanced to manually adjust 
the settings.



Two new Special Effect commands have been added. 
Choose Apply Paper to add a paper texture to the entire picture or a cutout. The 

paper effect is apparent immediately, unlike the Paper command on the Options menu, 
which is used with some tools. This command is available for 24 bit color and gray scale 
pictures.

Choose Crumple to create a crumpled look to the entire picture or a cutout. This 
command is available for 24 bit color, gray scale, and 256 color pictures.

New tools and tool types have been added. PhotoFinish now has nearly 90 tools 
and tool types, giving you even more picture editing possibilities. 

The new tools are the Chalk, Color Pencil, Marker, and Crayon tools. 
Select a tool type to change the effect of most tools. Tool types vary depending on 

the selected tool. Most tool types are available for all color modes. However, the effect of 
most tool types is more apparent with 24 bit color or gray scale pictures. 

You can paint with a paper effect with many of the painting tools. Choose Paper to 
load a paper. The texture of the paper appears when you begin painting with a tool and tool 
type that use paper. 

PhotoFinish supports pressure sensitive tablets. You can affect how many of the 
painting tools apply color by varying the downward force on the tablet surface. If you have a 
pointing device that has only one button, you can simulate a right mouse button click by 
holding the Ctrl key and clicking the button.

The Box tool has more options. Use the ribbon bar or the Tool Options command 
to select the Basic Box tool type to paint boxes filled with the secondary color. Select the Tile
tool type to paint a box filled with a tile pattern. Select the Gradient tool type to paint a box 
filled with a gradient that begins with the secondary color and ends with the background 
color.

The Text tool has more options. You can now choose to apply a shadow or outline 
to make your text more distinctive. Shadows and outlines appear in the primary color. You 
can also choose to left justify, right justify, or center text within the Text Frame.

The Paint Roller tools have been combined. Use the ribbon bar or choose the 
Tool Options command to select the Basic Roller tool type to fill an area with the primary or 
secondary color. Select the Tile tool type to fill an area with a tile pattern. Select the 
Gradient tool type to fill an area with a gradient that begins with the secondary color and 
ends with the background color. 

The Line and Tile Pattern Line tools have been combined. Use the ribbon bar or
choose the Tool Options command to select whether you want to paint a line in the primary 
color or a line of tile patterns.

The Hollow and Filled shape tools have been combined. Choose a shape tool 
and use the ribbon bar or the Tool Options command to select whether you want to paint a 
hollow shape, a filled shape with a border, or a filled shape without a border.

You can choose the width and shape for tools on the ribbon bar or in the Tool 
Options dialog box for the selected tool. Width and shape are tool specific. That means that 
when you switch tools, width and shape change to the last selected options for the tool. The 
Width & Shape workbox no longer appears. 

Color Tolerance has been improved. You can now specify a separate, tool specific 
color tolerance setting for the Magic Wand, Color Replacer, and Paint Roller tools. 

The Apply Texture command has been renamed Texturize. 
The Font More Fonts command has been renamed Font.
Beginning with version 2.02, PhotoFinish has supported the Photo CD (.PCD) file 

format. This format is used to load images from a Kodak Photo CD into PhotoFinish. To open 
a Photo CD image, select the drive where your CD device is located. 

Kodak Photo CD is a registered trademark of Eastman Kodak Company. Kodak Photo 
CD technology is a copyright of Eastman Kodak Company, 1991, 1992, and 1993.

Photo CD images are available in 24 bit color only. Use one of PhotoFinish's Image 
Convert To commands if you want the image in another color format, You can save .PCD files



in any format, except PCD, onto your hard disk for later use. 



Calling Technical Support
If you cannot install PhotoFinish correctly on your computer or if you have a problem with 
the program that you cannot solve by reading the User's Guide, call our Technical Support 
Department at (404) 428-0008 between 9 a.m. and 6 p.m. Eastern time.
We also have a 24-hour bulletin board service. Our BBS telephone number is (404) 514-
6332. Your modem should be set to 8, N, 1. Your modem speed can be up to 9600 baud. You 
can also reach us through CompuServe in the WordStar forum (GO WORDSTAR). We also 
offer a fax on demand service. To receive documents by fax with answers to commonly 
asked questions, call (404) 514-6333.
If you have trouble getting your scanner to work properly, it is possible there is a conflict 
between the scanner interface card or scanner driver and other boards or software that may 
exist in your computer. To isolate conflicts, remove possible conflicting components and test 
the scanner again. A scanner that offers switchable port, memory, interrupt, or DMA 
addresses gives you a chance to resolve the conflicts. When changing any of these 
selections, you may need to change a jumper or switch position on the scanner interface 
board and indicate the new specifications for the driver in your CONFIG.SYS or 
AUTOEXEC.BAT file. Refer to your scanner documentation for more specific information.
If you call Technical Support, you should have the following information ready:

The make and model of your computer and any peripherals you are using.
The amount of memory installed in your computer.
The version of PhotoFinish you have. Get the version number by choosing About 

PhotoFinish from the Help menu.
The version of DOS and Microsoft Windows you are using.
The contents of your CONFIG.SYS, AUTOEXEC.BAT, and WIN.INI files.



The Display Menu 

You use Display menu commands to zoom in or out on your picture, set the layout of your desktop, 
optimize your display, view only your picture, and to calibrate your monitor.
To choose a Display menu command, click Display and choose the command. Some commands are on 
cascading menus.
Display Menu Commands
100% (No Zoom): Returns a picture to one-to-one view.

Zoom: Magnifies or shrinks the active picture.

Zoom To Fit: Shrinks or magnifies your picture to fit your PhotoFinish desktop.

Screen Layout Show/Hide All Workboxes: Displays or hides the Palette and Toolbox.

Screen Layout Palette: Displays or hides the Palette.

Screen Layout Toolbox: Displays or hides the Toolbox.

Screen Layout AutoBar: Displays or hides the AutoBar.

Screen Layout Ribbon Bar: Displays or hides the ribbon bar.

Screen Layout Status Bar Displays or hides context-sensitive help at the bottom of your screen.

Full Screen: Removes the title bar and menu bar from your screen and maximizes your desktop. You can 
edit a picture in Full Screen mode.

Show Screen: Removes everything but the active picture from your screen. You cannot edit a picture in 
Show Screen mode.

Calibrate Monitor: Compensates for differences between your monitor and the original picture.

Optimize Display: Improves the on-screen look of your pictures if they contain more colors than your 
monitor supports.

Related Topics:
Fitting to Zoom 



 Display 100% (No Zoom) Command -- Viewing Your Picture with No Zoom

To return to 100% view:
Choose 100% (No Zoom) from the Display menu.    

Related Topics:
Full Screen command
Zoom commands
Zoom To Fit command
Zoom tool



Display Zoom Commands -- Zooming In and Out with the Zoom Commands 

To shrink or magnify a picture:    
Choose the Zoom percentage you want from the Display menu.
If you zoom by 800% or greater, PhotoFinish displays a grid that shows individual pixels.

Related Topics:
100% (No Zoom) command
Duplicate command
Full Screen command
Locator tool
Zoom To Fit command
Zoom tool



Display Zoom To Fit Command -- Zooming to Fit 

To zoom so that the picture fits the PhotoFinish desktop:
Choose Zoom To Fit from the Display menu.    

 

Related Topics:
100% (No Zoom) command 
Fitting to Zoom 
Full Screen command 
Zoom commands 
Zoom tool 



Fitting to Zoom

To resize the picture window to its maximum size:
Select the Zoom tool and click the Fit To Zoom button on the ribbon bar. This is especially useful if

you have zoomed in on a picture. The picture window resizes so that the maximum area of the picture is 
visible.

Related Topics:
100% (No Zoom) command
Full Screen command
Zoom commands
Zoom To Fit command 
Zoom tool 



Display Screen Layout Show/Hide All Workboxes Command -- Showing or Hiding 
Workboxes 

To show or hide all of the workboxes:
Choose the Screen Layout command from the Display menu. From the cascading menu, choose 

Show All Workboxes to display the Palette and Toolbox.    

Choose the Screen Layout command from the Display menu. From the cascading menu, choose 
Hide All Workboxes to hide the Palette and Toolbox.    

Related Topics:
Folding and Unfolding the Palette
Laying Out the Toolbox
Screen Layout Palette command
Screen Layout Toolbox command



Display Screen Layout Palette Command -- Showing or Hiding the Palette 

To show or hide the Palette:
Choose the Screen Layout command from the Display menu. From the cascading menu, choose 

Palette to display the Palette.    

Choose the Screen Layout command from the Display menu. From the cascading menu, choose 
Palette to hide the Palette.    

Related Topics:
Folding and Unfolding the Palette
Screen Layout Show/Hide All Workboxes command



Display Screen Layout Toolbox Command -- Showing or Hiding the Toolbox 

To show or hide the Toolbox:
Choose the Screen Layout command from the Display menu. From the cascading menu, choose 

Toolbox to display the Toolbox.    

Choose the Screen Layout command from the Display menu. From the cascading menu, choose 
Toolbox to hide the Toolbox.    

Related Topics:
Laying Out the Toolbox
Screen Layout Show/Hide All Workboxes command



Display Screen Layout AutoBar Command -- Showing or Hiding the AutoBar 

To show or hide the AutoBar:
Choose the Screen Layout command from the Display menu. From the cascading menu, choose 

AutoBar to display the AutoBar.    

Choose the Screen Layout command from the Display menu. From the cascading menu, choose 
AutoBar to hide the AutoBar.    

Related Topics:
Screen Layout Ribbon Bar command 



Display Screen Layout Ribbon Bar Command-- Showing or Hiding the Ribbon Bar

To show or hide the ribbon bar:
Choose the Screen Layout command from the Display menu. From the cascading menu, choose 

Ribbon Bar to display the ribbon bar.    

Choose the Screen Layout command from the Display menu. From the cascading menu, choose 
Ribbon Bar to hide the ribbon bar.    
 

To display the ribbon bar labels, choose Preferences and select the Show Ribbon Bar Labels 
option.

Related Topics:
Screen Layout AutoBar command 



Display Screen Layout Status Bar Command -- Showing or Hiding the Status Bar 

To show or hide status bar:    
Choose the Screen Layout command from the Display menu. From the cascading menu, choose 

Status Bar to display the status bar.    

Choose the Screen Layout command from the Display menu. From the cascading menu, choose 
Status Bar to hide the status bar.    



Display Full Screen Command -- Editing Your Picture Full Screen 

To edit your picture full screen:    
Choose Full Screen from the Display menu.    

Press Ctrl+F to return to normal view.
You also can click the double arrows on the right side of the status bar to switch between full 

screen and normal view.

Related Topics:
Screen Layout Show/Hide All Workboxes command
Show Screen command



Display Show Screen Command -- Viewing Only Your Picture 

To view only the picture:    

1 Choose OK to view your active picture full-screen.    
2 Press Esc to return to the normal PhotoFinish screen.

Related Topics:
Full Screen command
Screen Layout Show/Hide All Workboxes command



Display Calibrate Monitor Command -- Calibrating Your Monitor 

To load a preset map:    

1 Choose the map you want from the Preset Maps drop-down list.    
2 Choose OK to use the map.
3 You can choose Options to create a new map, or recalibrate, edit, or delete the selected map.    

Related Topics:
Calibrating Your Hardware
Creating a New Monitor Calibration Map
Editing a Monitor Calibration Map
Recalibrating Your Monitor



Creating a New Monitor Calibration Map 

To create a new calibration map:     

1 Choose a preset map that the new map is to be based on from the Based On drop-down list.

2 Type a name for the new calibration map in the Map Name text box.

3 Choose OK to save the map to disk.    
4 Click Recalibrate to recalibrate your monitor and save it to the new map file.
5 Click Edit to fine-tune the map.

Related Topics:
Calibrating Your Hardware
Calibrating Your Monitor
Editing a Monitor Calibration Map
Recalibrating Your Monitor



Recalibrating Your Monitor 

To recalibrate your monitor:     

1 Click on the box whose center looks most like its border for gray, red, green, and blue.    
2 Choose OK to save your changes to disk and use your new settings.

Related Topics:
Calibrating Your Hardware
Creating a New Monitor Calibration Map
Editing a Monitor Calibration Map



Editing a Monitor Calibration Map 

To edit a monitor calibration map:     

1 Choose a channel to specify the colors to be adjusted.    
2 Adjust the curve to get the effect you want.    
3 Choose OK to save your changes to disk and use your map.    

Related Topics:
Calibrating Your Hardware
Calibrating Your Monitor
Creating a New Monitor Calibration Map
Recalibrating Your Monitor



Display Optimize Display Command -- Optimizing Your Display 

To enhance your screen display:
Select Optimize Display.    

Choose the command again to return to a normal display.

Related Topics:
Calibrating Your Monitor
Preferences command



The Options Menu 

You use Options menu commands to change the palette, change tool settings, load a tile pattern, select 
startup preferences, select and style fonts, get system information, and choose other program options. 
To choose an Options menu command, click Options and choose the command. Some commands are on
cascading menus.
Options Menu Commands 
Tool Options: Changes the tool settings. 

Color Tolerance: Specifies a color range to fill, select, or replace with the Paint Roller, Magic Wand, and 
Color Replacer.

Font: Selects fonts and font styles and sizes.

Gradient Type: Changes the direction and brightness of the gradient for the gradient tools.

Palette All Colors: Adjusts all colors in the palette.

Palette Color Picker: Adjusts individual colors in the palette.

Palette Range of Colors: Creates gradations of colors in the palette.

Palette Single Colors: Adjusts individual colors in the palette. 

Palette Open Palette: Loads a palette previously saved to disk.

Palette Save Palette As: Saves a palette to disk.

Paper Type: Selects a paper type to use with some tools and tool types.

Tile Pattern: Loads a picture from disk or the Clipboard to use with the tile pattern tools.

Preferences: Adjusts settings for PhotoFinish's virtual memory, the unit of measure for pictures, the 
display for gray scale pictures, ribbon bar labels, thumbnail files, and program startup.

System Info: Displays information about the PhotoFinish version number, your current picture, memory, 
disk space, and hardware.



Options Tool Options Command -- Changing Tool Settings 

You use the Tool Options command to change the settings of the selected tool. You can also adjust most 
tool settings with the ribbon bar.
For more information about the options for a specific tool, click the tool icon.

Related Topics:
PhotoFinish Tools



Options Color Tolerance Command -- Specifying Color Tolerance 

To specify colors to fill, replace, or select:

1 Type the color tolerance range for the colors to be filled, replaced, or selected.    
2 Choose OK.    

Related Topics:
Color Replacer tool 
Magic Wand tool
Paint Roller tool
Understanding Color Tolerance 



Options Font Command -- Selecting and Styling a Font

To open and style a font:
1 Select a font from the Font list.

2 Select a size for the font from the Size list.

3 Select a Style and Effect option to change the style of the text.     
4 Select a Justification option to set the alignment of the text.     

You also can use the ribbon bar to change the font options.

Related Topics:
Text tool 



Options Gradient Type Command -- Changing the Direction of Your Gradient 

To change the gradient's effect:    

1 Select the gradient you want to use.    
2 Use the mini-scroll bar or type a number from 0 to 255 to select an amount of brightness.     
3 Choose OK.

Related Topics:
Box tool 
Paint Roller tool 



Options Palette All Colors Command -- Changing All the Colors in Your Palette 

To adjust the entire palette:    

1 Drag the Brightness and Contrast arrows to adjust the palette.     
2 Drag the Hue arrow or type a number from 0 to 360 in the text box to select the color you want to 
add to the entire picture.     
3 Drag the Amount arrow or type a number from -100 to 100 in the text box to select the amount of 
hue you want to add.     
4 Choose OK.    

Related Topics:
Mixing RGB Colors
Palette Color Picker command 
Palette Range of Colors command
Palette Single Colors command 
Working with Different Numbers of Colors



Options Palette Color Picker Command -- Adjusting Individual Colors 

To adjust the selected primary color:    

1 Select a color model from the Model drop-down list.    
2 Select a channel from the Channel drop-down list.
3 Adjust the level of the selected channel with the color slider.    
4 Choose Show Colors to see the available colors in the color refiner box.
5 Click on the color you want in the color refiner box.    
6 Choose OK.    

Related Topics:
Mixing RGB Colors
Palette All Colors command
Palette Range of Colors
Palette Single Colors command
Selecting a Color in the Color Refiner Box
Working with Different Numbers of Colors



Selecting a Color in the Color Refiner Box

Select the color below that is your selected color channel to see how to choose a color within the color 
refiner box.

 Red
 Green
 Blue
 Cyan
 Magenta
 Yellow
 Hue
 Lightness
 Saturation

Related Topics:
Mixing RGB Colors
Palette All Colors command
Palette Range of Colors command
Palette Single Colors command



Options Palette Range of Colors Command -- Creating a Range of Colors 

To create a range of colors:    

1 Choose RGB or HLS as the color model you want to use to edit your color.    
2 Click the left mouse button on the color you want to start the range.
3 Click the right mouse button on the color you want to end the range.
4 Use the mini-scroll bars or type numbers to change the level of each factor in the Start and End 
colors.    
5 Click Build Range.
6 Choose OK.    

Related Topics:
Mixing RGB Colors
Palette All Colors command
Palette Color Picker command
Palette Single Colors command
Working with Different Numbers of Colors



Options Palette Single Colors Command -- Creating a New Color 

To change an individual color:    

1 Choose RGB or HLS as the color model you want to use to edit your color.    
2 Drag the arrows or type numbers in the text boxes to change the level of each color value.    
3 Choose OK.    

Related Topics:
Mixing RGB Colors
Palette All Colors command
Palette Color Picker command
Palette Range of Colors command
Working with Different Numbers of Colors



Options Palette Open Palette Command -- Loading a Palette 

To open a previously saved palette:    

1 Select the drive and directory you want.    
2 Click a file in the File Name list box.    
3 Choose OK.     

Related Topics:
Palette Save Palette As command
Working with Different Numbers of Colors



Options Palette Save Palette As Command -- Saving a Palette 

To save a palette:    

1 Select the drive and directory you want.    
2 Type a name for the palette in the File Name text box.
3 Choose OK.

Related Topics:
Palette Open Palette command
Working with Different Numbers of Colors



Mixing RGB Colors 

Below is a list of RGB values for common colors. Color values are listed in the order you adjust them: 
Red, Green, and then Blue. Each value is separated by a comma.
To mix colors for a gray scale picture, first convert the picture to a 256 color or 24 bit color picture.
If the colors don't look right, you can adjust the brightness of your pictures on-screen with the Display 
Calibrate Monitor command.
Red

Dark: 85, 0, 0
Medium: 170, 0, 0
Bright: 255, 0, 0
Light: 255, 85, 85
Brick: 160, 64, 64
Cherry: 255, 0, 85
Maroon: 192, 0, 80
Pink: 255, 170, 170
Salmon: 255, 144, 128
Violet-Red: 255, 0, 170

Green
Dark: 0, 85, 0
Medium: 0, 170, 0
Bright: 0, 255, 0
Light: 170, 255, 170
Forest: 85, 170, 0
Grass: 0, 176, 112
Lime: 170, 255, 85
Olive: 120, 144, 0
Pine: 43, 85, 0
Sea Green: 170, 255, 255
Spring Green: 208, 255, 160
Yellow-Green: 192, 255, 0

Blue
Dark: 0, 0, 85
Medium: 0, 0, 170
Bright: 0, 0, 255
Light: 85, 85, 255
Baby Blue: 170, 170, 255
Blue-Gray: 144, 144, 160
Cobalt Blue: 96, 80, 208
Cornflower: 170, 170, 255
Navy: 0, 0, 128
Periwinkle: 224, 208, 255
Sky Blue: 85, 170, 255
Violet Blue: 170, 0, 255

Cyan (Blue-Green)
Dark: 0, 85, 85
Medium: 0, 170, 170
Bright: 0, 255, 255
Light: 85, 255, 255
Aquamarine: 160, 255, 224
Blue-Green: 0, 255, 170
Green-Blue: 0, 128, 112
Pale: 170, 255, 255
Turquoise: 0, 176, 160



Earthtones
Dark Brown: 128, 64, 0
Brown: 176, 80, 0
Burnt Sienna: 176, 64, 0
Copper: 176, 96, 64
Indian Red: 144, 0, 0
Mahogany: 192, 64, 0
Raw Sienna: 176, 96, 0
Raw Umber: 144, 96, 0
Rust: 160, 80, 48
Sepia: 144, 64, 0
Tan: 255, 144, 96

Flesh
Dark: 170, 85, 85
Medium: 255, 170, 170
Light: 255, 192, 192
Apricot: 255, 224, 192
Peach: 255, 208, 192

Gray
Black: 0, 0, 0
Very Dark: 64, 64, 64
Dark: 85, 85, 85
Medium: 128, 128, 128
Light: 170, 170, 170
Very Light: 213, 213, 213
White: 255, 255, 255
Silver: 208, 208, 224

Magenta (Red-Violet)
Dark: 85, 0, 85
Medium: 170, 0, 170
Bright: 255, 0, 255
Light: 255, 85, 255
Mulberry: 170, 0, 85
Orchid: 255, 85, 170
Pale: 255, 170, 255
Red Violet: 255, 0, 160

Orange
Dark: 128, 85, 0
Medium: 170, 113, 0
Bright: 255, 170, 0
Light: 255, 170,85
Bittersweet: 255, 112, 80
Burnt Orange: 224, 96, 0
Melon: 255, 128, 112
Orange-Red: 255, 80, 0
Tangerine: 255, 112, 0
Yellow-Orange: 255, 144, 0

Purple
Dark: 43, 0, 85
Medium: 85, 0, 170
Bright: 128, 0, 255
Light: 128, 85, 255
Violet: 96, 0, 112



Lavender: 213, 170, 255
Plum: 160, 0, 112

Yellow
Dark: 85, 85, 0
Medium: 170, 170, 0
Bright: 255, 255, 0
Light: 255, 255, 170
Amber: 255, 170, 0
Cream: 255, 255, 208
Gold: 176, 112, 64
Goldenrod: 255, 176, 0
Green-Yellow: 170, 255, 0
Lemon: 255, 255, 85
Maize: 255, 176, 112
Orange-Yellow: 255, 208, 0

Related Topics:
Palette All Colors command
Palette Color Picker command 
Palette Open Palette command 
Palette Range of Colors command
Palette Single Colors command



Options Paper Type Command -- Selecting a Paper Type 

To select a paper:     

1 Click the Paper drop-down list and select the paper you want.     
2 Select a preset Surface option or select Custom and use the mini-scroll bars to specify a number 
from 0 to 100.     
3 Adjust Grain settings.     
4 Click OK.

Related Topics:
Special Effect Apply Paper command 



Options Tile Pattern Command -- Opening a Tile Pattern 

To open a tile pattern:

1 Select a File Type option.    
2 Select the drive and directory you want.    
3 Click a file in the File Name list box.    
4 Choose OK.

Related Topics:
Line tool 
Paint Roller tool 
Previewing a Picture 



Options Preferences Command -- Selecting Preferences 

To change PhotoFinish settings:

1 Choose the options you want.    
2 Click Memory Options to set up or disable virtual memory.
3 Click VGA Palette to try to view more levels of gray.    
4 Choose OK.
5 Exit Windows and restart the program for the changes to take effect.

Related Topics:
Calibrate Monitor command
Optimize Display command



Preferences Dialog Box Options 

At Startup
Units
Save Thumbnail Files
Show Ribbon Bar Labels
VGA Palette
Memory Options

Related Topics:
Preferences command



Viewing More Levels of Gray 

To view more gray levels on a VGA monitor:     

1 Save all work.

2 Choose Test Hardware.    
3 Select Use VGA Hardware Palette if the test worked.
4 Choose OK. 
5 Exit Windows and restart PhotoFinish to make the VGA Hardware Palette option take effect.    

Related Topics:
Calibrate Monitor command
Optimize Display command
Preferences command



Selecting Memory Options 

To set up virtual memory:

1 Select Enable Virtual Memory.    
2 Type a number in the Min KB text box.    
3 Type a number in the Max KB text box.    
4 Specify the Virtual Memory Path.    
5 Choose OK.
6 Exit Windows and restart PhotoFinish to make the Virtual Memory options take effect.

Related Topics:
Preferences command



Options System Info Command -- Displaying System Information 

You use the System Info command to view information about your current picture, your display, your 
printer, and your scanner. You can also see how much memory and disk space is installed and remains in
your computer.

Image: Shows you the size, resolution, and number of colors in your picture.
Screen: Shows you the dpi your screen can display. The higher the number, the sharper your display.
Printer: Shows you the name of the currently selected printer and the dpi the printer can print. The higher

the number, the sharper your printout will be. You can change the selected printer and printer 
settings with Print Setup.

Scanner: Shows you the name of the scanner you have installed to use with PhotoFinish.
Computer Memory: Shows you how much memory and disk space is installed in your computer and how

much remains. You can set virtual memory paths with Preferences.



The Window Menu 

You use Window menu commands to rearrange PhotoFinish picture windows, rearrange minimized 
pictures, duplicate a picture, and change the active picture.
To choose a Window menu command, click Window and choose the command you want.
To change your active picture click the Window menu and choose a different picture from the picture list. 
For more information, see Activating a Picture Window.
Window Menu Commands 
Cascade: Layers PhotoFinish picture windows so each title bar is visible.

Tile: Arranges PhotoFinish picture windows in equal sizes to fit on your screen.

Arrange Icons: Arranges minimized pictures across the bottom of the PhotoFinish desktop.

Duplicate: Duplicates pictures so you can see changes at different magnifications while you edit a picture.



Window Cascade Command -- Cascading Your Picture Windows 

To layer your picture windows:
Choose Cascade from the Window menu.    

Related Topics:
Activating a Picture Window
Tiling Your Picture Windows



Window Tile Command -- Tiling Your Picture Windows 

To arrange your picture windows:
Choose Tile from the Window menu.    

Related Topics:
Activating a Picture Window
Cascading Your Picture Windows



Window Arrange Icons Command -- Arranging Your Picture Icons 

To arrange picture icons:
Choose Arrange Icons from the Window menu.    



Activating a Picture Window 

To activate a picture:
Click the name of the picture on the Window menu picture list or click the title bar of the picture.
A check mark appears beside the picture name on the Window menu list to show it is selected.



Window Duplicate Command -- Viewing a Picture in Multiple Views 

To duplicate a picture:    
Choose Duplicate from the Window menu.    

Related Topics:
Locator tool
Zoom commands
Zoom tool



The Control Menu 
You use Control menu commands on the PhotoFinish program and picture windows to move, 
close, restore, and change the size of the window. These commands are standard Windows 
commands.
You use Control menu commands on the PhotoFinish Palette and Toolbox to move and hide 
them. The Toolbox Control menu also has the Layout command, and the Palette Control 
menu also has the Fold/Unfold command.
Point to a topic below and click for more information about the Control menu commands 
unique to PhotoFinish.
Control Menu Commands
Image Info: Displays information about the picture.
Resolution: Changes the resolution of the picture.
Layout: Allows you to change the width and height of the Toolbox and to group or ungroup 

the tools.
Fold/Unfold: Allows you to fold or unfold the Palette workbox.



Layout Command -- Laying Out the Toolbox 
To change your Toolbox layout:
1 Click the Control menu box on the Toolbox.
2 Choose Layout Ungroup or Layout Group.    
3 Choose a column or row command to lay out your Toolbox.    
Related Topics:
Screen Layout Show/Hide All Workboxes command
Screen Layout Toolbox command



Fold/Unfold Command -- Folding and Unfolding the Palette 
To fold or unfold your Palette:
1 Click the Control menu box of the Palette.
2 Choose Fold or Unfold.    

Unfold displays all the colors available in the Palette.    

Fold displays only the color selection box.

Related Topics:
Screen Layout Palette command
Screen Layout Show/Hide All Workboxes



The Scan Menu 

You use Scan menu commands to scan and set scanning options, load and save scanner configurations, 
calibrate your scanner, stitch images together, and rescan images.
To choose a Scan menu command, click Scan and choose the command.
Before you begin scanning, you may want to read Scanning with PhotoFinish.
Scan Menu Commands
AutoScan: Automatically scans and improves the quality of an image.

Scan: Changes scanner settings and scans or captures an image.

Scan Again: Scans or captures an image again with the current settings.

Stitch: Scans an image and adds it to the active picture.

Calibrate Scanner: Calibrate your scanner, and create, edit, or delete calibration maps.

Open Configuration: Loads scanner settings previously saved to disk.

Save Configuration As: Saves scanner settings to disk.



Scanning with PhotoFinish 

You use a scanner to translate a printed image to computer language so you can use the image with your
computer. You can use flatbed scanners, video grabbers, and hand scanners with PhotoFinish. For best 
results, you should calibrate your scanner before you scan. For more information, see Calibrating Your 
Hardware.
Keep the following in mind when you scan with PhotoFinish:

You must first connect your scanner to your computer system according to the scanner 
manufacturer's installation instructions.

If you want to use PhotoFinish's scanning features, you must first install and configure your 
scanner with the PhotoFinish Setup program.

Turn on your scanner before you start your computer.
If you have already installed PhotoFinish and want to install or reconfigure a scanner, run the 

PhotoFinish Setup program again and choose the Install Scanner or Change Scanner Settings option. 
You will be prompted to insert PhotoFinish disks or scanner manufacturer's disks to install your scanner.

If your scanner supports the TWAIN interface, use the Select Source and Acquire commands on 
the File menu to set up your scanner and to scan.

Related Topics:
AutoScan command
Scanning with a Flatbed Scanner
Scanning with a Hand Scanner
Scanning with a Video Grabber



Scan AutoScan Command -- Improving the Quality of a Scanned Image 

To have PhotoFinish automatically scan and correct your image:     

1 Choose Options to select the auto enhancement options.    
2 Click the Scan button to scan and automatically enhance the picture.    
3 Choose Accept to load the enhanced image into a new picture window.

Related Topics:
Auto Brightness/Contrast command 
Auto Crop command
Auto Remove Moiré command 
Auto Saturation command 
Scanning with PhotoFinish 
Transform Rotate command 
Tune Equalize command 



Setting AutoScan Options 

To specify auto enhancement options:

1 Click the box next to the option you want PhotoFinish to use on your picture.    
2 Select an image type from the Image Type drop-down list.    
3 Choose the output device you want from the Output drop-down list.    
4 Click Edit Output to view, change, add, or delete available Output options.    
5 Choose OK to use your new selections.

Related Topics:
Auto Brightness/Contrast command 
Auto Crop command
Auto Remove Moiré command 
Auto Saturation command 
AutoScan command
Scanning with PhotoFinish 
Transform Rotate command 
Tune Equalize command 



Changing Your Output Device 

To change, add, or delete output options:
1 Use the mini-scroll bars to adjust the Vertical and Horizontal resolution for Text/Line Art and Photo 
scanning.    

2 Choose Change to save your settings with the selected Output name.    
3 Choose Close when you are finished making your changes.

Related Topics:
AutoScan command
Setting AutoScan Options
Scanning with PhotoFinish



Scan Scan Command -- Scanning a Picture 

You use the Scan command on the Scan menu to scan or capture an image. The dialog box that appears 
when you choose Scan differs depending on the type of scanner you are using. For step-by-step 
instructions click the Related Topic below for your scanner.
If your scanner is installed for the TWAIN standard interface, you can also select a TWAIN source and 
choose Acquire from the File menu to scan an image.
Related Topics:
Scanning with a Flatbed Scanner
Scanning with a Hand Scanner
Scanning with a Video Grabber
Scanning with PhotoFinish



Scanning with a Flatbed Scanner 

If you plan to stitch, be sure to scan the left side of the image first.

To scan with a flatbed scanner:    

1 Click Options to change scanner settings and choose OK.     
2 Adjust other options you want.    

3 Click Prescan to prescan the image.    
4 Click Scan to scan your picture.    

Related Topics:
Open Configuration command
Save Configuration As command
Scanning with PhotoFinish



Flatbed Scanner Dialog Box Options 

Units
Margins
Set Paper Size
Prescan
Select Scan Area box
Options
Scan

Related Topics:
Open Configuration command
Save Configuration As command
Scanning Different Page Sizes
Scanning with a Flatbed Scanner
Scanning with PhotoFinish
Setting Up Scanning Options



Scanning Different Page Sizes 

To change your paper size:

1 Select a Units option.    
2 Select a paper size option.    
3 Click OK to return to the main scanning dialog box.

Related Topics:
Scanning with a Flatbed Scanner
Scanning with PhotoFinish



Flatbed Scanner Page Size Options 

Letter
Legal
Custom
B Size
A3
A4
A5
B5

Related Topics:
Scanning Different Page Sizes
Scanning with a Flatbed Scanner
Scanning with PhotoFinish



Scanning with a Video Grabber 

If you plan to stitch, be sure to capture the left side first.

To capture an image with a video grabber:    

1 Click Options to change grabber settings and choose OK.     
2 Adjust other options you want.    

3 Click Prescan to prescan the area.    

4 Click Stop to end prescanning.

5 Click Capture to capture the area you want.    

Related Topics:
Open Configuration command
Save Configuration As command
Scanning with PhotoFinish



Video Grabber Dialog Box Options 

Scan Area
Set Dimensions
Prescan
Select Video Scan Area box
Brightness
Contrast
Options
Capture

Related Topics:
Capturing Different Picture Sizes
Open Configuration command
Save Configuration As command
Scanning with a Video Grabber
Scanning with PhotoFinish
Setting Up Scanning Options



Capturing Different Picture Sizes 

To change scan dimension size:

1 Type the unit of measure you want.    
2 Type a horizontal and vertical size of the area you want to capture.
3 Click OK to return to the main scanning dialog box.

Related Topics:
Scanning with a Video Grabber
Scanning with PhotoFinish



Scanning with a Hand Scanner 

If you plan to stitch, be sure to scan the left side first.

To scan with a hand scanner:    

1 Click Options to change scanner settings and choose OK.     
2 Adjust other options you want.    
3 Click Scan and begin to scan with the hand scanner.

4 Click OK to accept the scanned image.    

Related Topics:
Open Configuration command
Save Configuration As command
Scanning with PhotoFinish



Hand Scanner Dialog Box Options 

Units
Margins
Set Scan Size
Feedback
Hand Scanner Area
Options
Scan

Related Topics:
Handscanning Different Page Sizes
Open Configuration command
Save Configuration As command
Scanning with a Hand Scanner
Scanning with PhotoFinish
Setting Up Scanning Options



Handscanning Different Page Sizes 

To change the scan area size:

1 Select a Units option.    
2 Type the width of the area you want to scan in the Horizontal Size text box.    
3 Type the length of the area you want to scan in the Vertical Size text box.
4 Click OK to return to the main scanning dialog box.

Related Topics:
Scanning with a Hand Scanner
Scanning with PhotoFinish



Setting Up Scanning Options 

To adjust scanner options:

1 Adjust the options you want.    
2 Choose OK to return to the main scanning dialog box.

Related Topics:
Open Scanner Configuration command
Save Configuration As command
Scanning with a Flatbed Scanner
Scanning with a Hand Scanner
Scanning with a Video Grabber
Scanning with PhotoFinish
Working with Different Numbers of Colors



Scanner Setup Dialog Box Options 

Brightness
Contrast
Scaling
Image Type
Halftone
Resolution
Enhancements
Units

Related Topics:
Scanning with PhotoFinish
Setting Up Scanning Options



Scan Scan Again Command -- Rescanning a Picture 

To rescan a picture:    

1 Choose Yes to rescan or recapture your picture with the current settings.

2 Choose No to cancel the scan.

Related Topics:
Open Configuration command
Scan command
Scanning with PhotoFinish
Stitch command



Scan Stitch Command -- Stitching Scanned Images 

To scan an image larger than the width of your scanner:

1 Use Scan to scan the left side of your picture.    
2 Choose Stitch from the Scan menu.    
3 Scan the portion of the image you want to add.    
4 Move the stitched image where you want it.    
5 Choose another command, select a tool, or choose Select None to stitch the image permanently.

Related Topics:
Manipulating Defined Areas
Scanning with a Flatbed Scanner
Scanning with a Hand Scanner
Scanning with a Video Grabber
Scanning with PhotoFinish
Zoom commands



Scan Calibrate Scanner Command -- Calibrating Your Scanner 

To load a preset map:    

1 Choose the map you want from the Preset Maps drop-down list.    
2 Choose OK to use the map.
3 You can choose Options to create a new map, recalibrate, edit, or delete the selected map.    

Related Topics:
Calibrating Your Hardware
Scanning with PhotoFinish



Creating a New Scanner Calibration Map 

To create a new calibration map:     

1 Choose a preset map that the new map is to be based on from the Based On drop-down list.

2 Type a name for the new calibration map in the Map Name text box.

3 Choose OK save the map to disk.

4 Click Recalibrate to recalibrate your scanner and save it to the new map.

5 Click Edit to fine-tune the map.

Related Topics:
Calibrating Your Hardware
Calibrating Your Scanner
Scanning with PhotoFinish



Recalibrating Your Scanner 

To recalibrate your scanner:     

1 Place the calibration card on your scanner.

2 Select which option you want your scanner to be calibrated for, and choose OK.    
3 Choose OK to save your changes to disk and use your new settings.

Related Topics:
Calibrating Your Hardware
Calibrating Your Scanner 
Creating a New Scanner Calibration Map
Editing a Scanner Calibration Map 



Editing a Scanner Calibration Map 

To edit a scanner calibration map:     

1 Choose a channel to specify the colors to be adjusted.    
2 Adjust the curve to get the effect you want.    
3 Choose OK to save your changes to disk and use your map.    

Related Topics:
Calibrating Your Hardware
Calibrating Your Scanner
Creating a New Scanner Calibration Map
Scanning with PhotoFinish



Compensation Map Editing Options 

You can use several styles to get the response curve you want.

Curve
Freehand
Linear

This picture illustrates the color values represented in the calibration map sample box:

Related Topics:
Calibrating Your Hardware



Scan Open Configuration Command -- Loading Scanner Settings 

To load previously saved scanner settings:

1 Select the drive and directory you want.    
2 Click a scanner configuration in the File Name list box.
3 Choose OK.

Related Topics:
Save Configuration As command 
Scan Again command
Scanning with a Flatbed Scanner
Scanning with a Hand Scanner
Scanning with a Video Grabber
Scanning with PhotoFinish 



Scan Save Configuration As Command -- Saving Scanner Settings 

To save scanner settings:

1 Select where you want to save the file.    
2 Type a name for the file.
3 Choose OK.

Related Topics:
Open Configuration command
Scanning with PhotoFinish
Setting Up Scanning Options



Viewing Colors on Your Screen 

PhotoFinish provides device independence so you can load and edit images that have more colors than 
your monitor supports. PhotoFinish simulates colors not supported by your monitor and retains all the 
original details and colors in your picture.

To adjust how bright your pictures appear on-screen, see Calibrate Monitor.
To enhance how simulated colors appear on-screen, see Optimize Display.
If your VGA driver supports fewer than 16 levels of gray, you may be able to use PhotoFinish's 

VGA Hardware Palette option to improve the on-screen appearance of gray scale pictures. For more 
information see Viewing More Levels of Gray.

Related Topics:
Working with Different Numbers of Colors



Working with Different Numbers of Colors

PhotoFinish supports 24 bit color, 256 color, gray scale, and black and white pictures. A picture with fewer
than 256 colors or grays (except black and white) is automatically converted to 256 color when you open 
it. A 32 bit picture is automatically converted to 24 bit color when you open it.
You can create and edit pictures that contain more colors than your hardware supports without losing 
original detail. PhotoFinish simulates colors on-screen that your monitor doesn't support, giving you 
device independence.
Following is general information about working with pictures. For more specific color information, click one
of the Related Topics.

Use Convert To to convert a picture to another color format. If you plan to use the picture with a 
device or application that requires a specific format, you can convert the picture, edit it, and then convert it
to the format you need.

To optimize how PhotoFinish simulates colors on-screen, see Optimize Display.
To adjust how bright your pictures appear on-screen, see Calibrate Monitor.
Filter, Special Effect, and Tune commands work best with 24 bit color and gray scale pictures. For

more information, see Using Filter Commands, Using Tune Commands, or Using Special Effect 
Commands.

Tools work best with 24 bit color and gray scale pictures.
Some commands and tools are available only with 24 bit color or gray scale pictures. Commands 

that are unavailable for the format you are using are dimmed and cannot be selected. When you try to 
use a tool that is unavailable for the format you are using, you receive an error message.

Related Topics:
Working with 24 Bit Color Pictures
Working with 256 Color Pictures
Working with Black and White Pictures
Working with Gray Scale Pictures



Working with Black and White Pictures 

A black and white picture is made up of only black and white. Grays are made up of individual dots of 
black and white. This mode is useful if you want high contrast black and white pictures.
You can create, open, save, scan, and edit black and white pictures with PhotoFinish.

Black and white requires the least amount of memory.
If you want to colorize a black and white picture or take advantage of more options and tools, you 

can convert the picture to another color format.
If you convert a picture to black and white, you can choose a conversion type. If you select Line 

Art, no halftone is used. If you choose Printer Halftone, a fatting halftone is used. If you choose Screen 
Halftone and Optimize Display on the Display menu is selected, a diffused halftone pattern is used. If you 
choose Screen Halftone and Optimize Display is not selected, a Bayer halftone is used.

Some tool types are unavailable for black and white pictures. In addition, most tool types work 
best in 24 bit color or gray scale. 

The following tools are unavailable for black and white pictures: Color Replacer, Contrast 
Paintbrush, Brighten Paintbrush, Tint Paintbrush, Blend Paintbrush, and Sharpen Paintbrush.

The AutoEnhance and Auto commands on the Image menu are unavailable for black and white 
pictures.

The only available Filter command is Remove Spots.
The only available Special Effect command is Outline.
The only available Tune command is Negative.
You can open black and white pictures in the following formats: BMP, GIF, JPEG, MSP, PCX, and 

TIFF.
You can save black and white pictures in the following formats: BMP, EPS, GIF, JPEG, PCX, and 

TIFF.

Related Topics:
Working with Different Numbers of Colors



Working with Gray Scale Pictures 

A gray scale picture is made up of 256 solid grays. This mode is useful if you do not want to add color to 
your picture.
You can create, open, save, scan, and edit gray scale pictures with PhotoFinish. Grays not supported by 
your monitor are simulated on-screen, and the original detail is retained in your picture.

When you convert a gray scale picture to color, the picture remains gray, but you can add colors.
If you use a VGA driver that displays fewer than 16 levels of gray, you may be able to use 

PhotoFinish's VGA Hardware Palette option to increase the number of grays displayed on-screen.
All Filter, Tune, and Special Effect commands and tools are available with the exception of Tune 

Hue and Saturation.
Gray scale pictures require less memory than 24 bit color pictures.
You can open gray scale pictures in the following formats: BMP, GIF, JPEG, PCX, TARGA, and 

TIFF.
You can save gray scale pictures in the following formats: BMP, EPS, GIF, JPEG, PCX, TARGA, 

and TIFF.

Related Topics:
Calibrating Your Monitor
Optimizing Your Display
Working with Different Numbers of Colors



Working with 256 Color Pictures 

A 256 color picture is made up of 256 solid colors. This mode is useful if you are creating pictures to view 
on-screen or if you don't have enough memory for 24 bit color pictures. PhotoFinish automatically 
converts a picture with fewer than 256 colors to 256 color when you open it.
You can create, open, save, scan, and edit 256 color pictures with PhotoFinish. Colors not supported by 
your monitor are simulated on-screen and the original detail is retained in your picture.

The color set in the palette of a 256 color picture defines the colors available for your picture.
You can use Palette commands to adjust a single color, range of colors, or all the colors in your 

palette. However, the picture also will change.
Some tool types are unavailable for 256 color pictures. In addition, most tool types work best in 

24 bit color or gray scale. 
The Tint Paintbrush, Blend Paintbrush, and Sharpen Paintbrush are unavailable for 256 color 

pictures.
The AutoEnhance and Auto commands on the Image menu are unavailable for 256 color pictures.
Diffuse and Remove Spots are the only Filter commands available for 256 color.
Black Hole, Crumple, Crystallize, Fisheye Lens, Outline, Pixelate, and Twist are the only Special 

Effect commands available for 256 color picture.
All Tune commands are available for 256 color pictures with the exception of Hue and Saturation.
You can open 256 color pictures in the following formats: BMP, GIF, PCX, TARGA, and TIFF.
You can save 256 color pictures in the following formats: BMP, EPS, GIF, PCX, TARGA, and TIFF.
To take advantage of all the Filter, Tune, and Special Effect commands, tools and tool types, use 

Convert To to convert your picture to 24 bit color.

Related Topics:
Calibrating Your Monitor
Optimizing Your Display
Working with Different Numbers of Colors



Working with 24 Bit Color Pictures 

A 24 bit color picture is made up of 16,777,216 colors, providing better detail and depth than other color 
modes. Retouch tools and the commands on the Image menu also work best in 24 bit color mode. You 
can paste pictures without changing their colors.
You can create, open, save, scan, and edit 24 bit color pictures with PhotoFinish. Colors not supported by
your monitor are simulated on-screen, and the original detail is retained in your picture.

The color set in the Palette of a 24 bit color picture displays 256 of the 16.7 million colors 
available.

To change the colors displayed in the color set for easy access: double-click a color in the palette;
use any of the Palette commands, or pick up a color from your picture with the Eyedropper.

You can use the Optimize Display command to change the look of 24 bit color pictures on-screen.
All of the Filter, Tune, and Special Effect commands and tools are available with 24 bit color 

pictures.
You can open 24 bit color pictures in the following formats: BMP, JPEG, PCX, TARGA, and TIFF.
You can save 24 bit color pictures in the following formats: BMP, EPS, JPEG, PCX, TARGA, and 

TIFF.
To use your picture with a device or application that does not support 24 bit color, use Convert To 

to convert the picture to the color mode you need.

Related Topics:
Calibrating Your Monitor
Optimizing Your Display
Working with Different Numbers of Colors



Calibrating Your Hardware 

Differences between your scanner, printer, and monitor can occur for many reasons. Your picture may 
appear darker in print than it does on-screen because printer dots look darker and larger than the dots on 
your screen. In addition, colors on a monitor are projected and so they usually appear brighter than 
printed colors, which are perceived with reflective light. And each device also has its own idiosyncrasies. 
For example, your scanner may tend toward the dark end of the spectrum or your printer may print dark 
because it is new. Even the length of time a device is on can change its results. For example, a scanner 
usually gives you different results when you first turn it on and after it is warm. Compensating your 
devices helps you to get the results you expect.

PhotoFinish uses special response curves, called compensation maps, to adjust your devices. 
Compensation maps do not change the colors in your picture. Instead, the colors in your picture are 
adjusted when the picture is sent to or from the device. For example, a printer compensation map is 
applied to a picture when the picture is sent to your printer.

You can load a preset map, let PhotoFinish automatically recalibrate a map for you, create a new map 
based on a previous one, and fine-tune a map.

Following is an explanation of which type of calibration method you should use.
You can choose a preset map for your scanner, printer, and monitor. Although this is not the most 

accurate way to adjust your devices, it is a quick way to get started. You cannot recalibrate, edit, or delete
a preset map shipped with PhotoFinish.

Generally, you load a preset map you previously calibrated or fine-tuned. If, however, you want to 
get started right away or a particular device does not support PhotoFinish's automatic calibration, you can
load one of the preset maps PhotoFinish supplies.

If your monitor can display at least 256 colors or 16 levels of gray, you can let PhotoFinish 
recalibrate a map specifically for you.

If you have a flatbed, sheetfed, or hand scanner that is at least four inches wide, supports 256 
gray scale or 24 bit color, and has a resolution of at least 75 dpi, installed in PhotoFinish, you can let 
PhotoFinish recalibrate a map specifically for your scanner.

If you have a printer installed in Windows and a scanner that supports the scanner requirements 
listed above, you can let PhotoFinish recalibrate a map specifically for your printer.

For step-by-step instructions on calibrating a device, choose one of the topics below.
Calibrate Scanner
Calibrate Monitor
Calibrate Printer 



Using the AutoBar

PhotoFinish's AutoBar makes it easy to quickly choose some of the most-used commands with the click 
of the mouse button. 
To choose commands from the AutoBar, it must be displayed. To quickly display the AutoBar, press Ctrl+U
or choose the Screen Layout AutoBar command.
To read about the available commands on the AutoBar, click an icon or button on the picture below.



Using the Ribbon Bar

PhotoFinish's ribbon bar makes it easy to quickly change most of the tool settings for the currently 
selected tool. You can also change tool settings with the Tool Options command.
To change tool settings on the ribbon bar, it must be displayed. To quickly display the ribbon bar, press 
Ctrl+R or choose the Screen Layout Ribbon Bar command.
The appearance of the ribbon bar varies depending on the tool you select. To see how to use the ribbon 
bar for a specific tool, see the Tool Options help topic for the tool.



Understanding File Formats

PhotoFinish supports a wide range of different formats, allowing you to save your pictures in a format that 
can be understood by your other applications.
File formats can be distinguished from one another by their three-letter filename extension. Each has 
characteristics that make it suitable for different applications. Following is a list of the formats supported 
by PhotoFinish. Click the name of the format to learn more about it.

BMP EPS GIF 

JPG MSP PCX 

PCD TGA TIF 

Note: If you have installed UltraFAX on your system, you also can open and save pictures in DCX and 
ZGF formats. These formats open and save in black and white only. If you open a multiple page DCX or 
ZGF file in PhotoFinish, only the first page of the file is visible. If you want to see all the pages in the file, 
use the UltraFAX Viewer.



BMP File Format

The BMP format is the internal picture file format used by Windows 3.0.
You can open and save black and white, 256 color, 24 bit color, and gray scale pictures in the .BMP file 
format. If you open a 16 color BMP, PhotoFinish automatically converts the picture to 256 colors.
Related Topics:
Understanding File Formats 



EPS File Format

The Encapsulated PostScript format (EPS) is used to exchange pictures between programs and 
computer platforms because it is simply a PostScript description of the picture. PhotoFinish's .EPS file 
format contains PostScript code that draws a bitmap image. Since this type of .EPS file is resolution 
specific, you will get the same results sizing it as you would with any other picture file format.
You can save black and white, 256 color, 24 bit color, and gray scale pictures in the .EPS file format. You 
can specify Color or Gray Scale in the File Sub-Format drop-down list if you save a 256 color or 24 bit 
color picture. PhotoFinish does not support a preview copy of an .EPS file. You can save a file in the .EPS
format, but you cannot load an .EPS file into PhotoFinish. You may want to save your picture as a .PCX 
file until you finish making changes.
You can customize the header and trailer information in your .EPS file by editing a file named EPS.DAT, 
which was copied to your PhotoFinish directory during setup. You can load EPS.DAT into a text editor, 
such as Notepad, to change header information including the date the file was created, its title, and the 
name of the person who created the picture. For example, you can add your name to the header by 
editing the line that reads: For:--Your-Name-Here--

If you choose to edit your EPS.DAT file, make sure you read the comments in the EPS.DAT file before 
you begin editing. Be careful not to change WARNING areas. Keep in mind that although a fully 
conforming .EPS file does not include palette information, you will probably alter the look of your picture if 
you remove the EPS.DAT palette information.

Related Topics:
Understanding File Formats 



GIF File Format

The Graphics Interchange Format (GIF -- a service mark of CompuServe Incorporated) is generally used 
to transmit pictures and to exchange pictures between computer platforms. PhotoFinish supports single-
image .GIF files.
You can save black and white, 256 color, and gray scale pictures in the .GIF file format. Although you can 
open .GIF pictures in both the old and new format, PhotoFinish saves pictures in the older version to be 
more compatible with other programs and uses LZW compression to save space on your hard drive.
Related Topics:
Understanding File Formats 



JPEG File Format

The Joint Photographic Experts Group file format (JPEG) used by PhotoFinish uses the Discrete Cosine 
Transforms (DCT) compression technique. PhotoFinish's JPEG file format conforms to the JPEG File 
Interchange Format. You can save gray scale and 24 bit color pictures in the .JPG file format. 
Of all the file formats PhotoFinish supports, JPEG can give you the greatest compression. 
Although your file size will be smaller, you will lose some picture information during compression. This can
affect the number of colors in your picture by reducing the distinction between different colors -- your 
picture may appear slightly blurred and there may be a loss of detail.
You can choose the amount of loss that is acceptable for your picture from the File Sub-Format drop-
down list. You can select Minimum Loss, Low Loss, Medium Loss, or High Loss, and PhotoFinish 
compresses the file with preset values. The higher the loss, the smaller the file size will be and the more 
detail is discarded from the picture. If your picture is made up of similar hues, the detail you lose will be 
less noticeable. 

It is highly recommended that you check the results of the compression sub-format you choose before 
you discard your original picture. To check the results of saving, you must open the picture again. 

If the loss of detail is not acceptable, try saving the original picture again using a sub-format with lower 
loss. The amount of loss that occurs each time you save a JPEG picture again, using the same sub-
format selection, depends on how much you change the picture.

You can also customize how much loss and the type of loss you want. To customize your JPEG 
compression, choose Custom Compression as the sub-format for JPEG and click OK. The JPEG dialog 
box is displayed so you can choose the options you want. To understand the JPEG custom options you 
must first understand Luminance, Chrominance, and Subsample.

Luminance: Luminance specifies how much gray to retain in a group of pixels. You specify the number of
pixels by choosing a Subsample. Luminance is available for 24 bit color pictures and is the only setting 
available for gray scale pictures. Adjusting Luminance is similar to adjusting the brightness and contrast 
knob on a television set. Luminance can be set from -8 to 100. The lower the number, the more definition 
between colors is retained. If your picture is low contrast, you may be able to use a slightly higher 
Luminance setting with acceptable results.

Chrominance: Chrominance specifies how much color to retain in a group of pixels. You specify the 
number of pixels by choosing a Subsample. Chrominance is available only for 24 bit color pictures. 
Adjusting Chrominance is similar to adjusting the tint and color knobs on a television set. Chrominance 
can be set from -8 to 100. The lower the number, the more definition between colors is retained. Note that
if your picture is made up of similar hues, you may be able to use a slightly higher Chrominance setting 
with acceptable results.

Subsample: Subsample specifies how many pixels PhotoFinish looks at to determine which colors to 
keep and which colors to discard for final compression. Subsample options are listed as three numbers, 
separated by colons. The first number represents how many pixels to look at for the Luminance setting. 
PhotoFinish always looks at each pixel in a group of four when applying the Luminance setting. The 
second and third numbers represent two color channels for Chrominance. They determine how many 
pixels to view as a single value in a group of four pixels. A simple way to look at the Chrominance 
subsample numbers is that the higher the Chrominance subsample, the more detail is retained. For 
example, if you choose the Subsample 4:4:4, each pixel is considered separately when applying the 
Chrominance setting -- giving you less loss. If, however, you choose the Subsample 4:1:1, the group of 
pixels is 4 and all four pixels are considered as a single value when applying the Chrominance setting -- 
giving you higher loss.

PhotoFinish's preset sub-format options follow. Only the Luminance settings are used if you are saving a 
gray scale picture.

This preset sub-format... ...uses these settings.
Minimum Loss Subsample is 4:4:4. Luminance is -8. Chrominance is -8.



Low Loss Subsample is 4:4:4. Luminance is -3. Chrominance is -3.

Medium Loss Subsample is 4:2:2. Luminance is 0. Chrominance is 0.

High Loss Subsample is 4:2:2. Luminance is 3. Chrominance is 3.

Related Topics:
Compressing with JPEG 
Understanding File Formats 



MSP File Format

The Microsoft Paint format (MSP) is used by Microsoft Paint versions included in Windows versions lower
than 3.0.
PhotoFinish supports opening MSP pictures previously saved in the MSP format by another application, 
but you cannot save in the MSP format.
Related Topics:
Understanding File Formats 



PCX File Format

The PCX format was developed in 1984 by ZSoft Corporation. It is used as an industry standard to 
exchange pictures between programs and is supported by a multitude of graphics and desktop publishing 
programs.
You can save black and white, 256 color, 24 bit color, and gray scale pictures using the ZSoft PCX 
selection. PhotoFinish uses a run-length compression to save space on your hard drive.
If you are saving a gray scale or 256 color picture, you can choose 16 Color or 256 Color from the File 
Sub-Format drop-down list. PhotoFinish automatically applies the best halftone when it saves in the 16 
Color subformat. You should be aware that although you can save in 16 colors, PhotoFinish automatically 
converts the picture to 256 color when you open it again. 

If you have problems with a .PCX file, you can use the PCXHDR.EXE utility program to view information 
about the file. PCXHDR.EXE was copied to your PhotoFinish directory when you installed the program. 
To run PCXHDR, double-click the PCX File Info icon in your PhotoFinish program group.

Related Topics:
Understanding File Formats 



PCD File Format
 

The PCD file format was developed by Eastman Kodak Company and is the format used by Kodak Photo 
CDs. PCD files are 24 bit color and usually contain several resolutions for the file. When you open a PCD 
file in PhotoFinish, you can select which resolution you want to use. You cannot save pictures in the PCD 
format. 
Related Topics:
Understanding File Formats 



Targa File Format

The Targa format (.TGA), developed in 1984 by Truevision, was originally intended for use with systems 
that have a Truevision video board, allowing you to see 16.7 million colors on-screen (all the colors 
available in a 24 bit color picture).
You can save black and white, 256 color, 24 bit color, and gray scale pictures in the Targa file format. 
Although Targa files can use several extensions, PhotoFinish automatically uses the .TGA extension. You 
can specify a compressed or uncompressed format in the File Sub-Format drop-down list when you save.
The compressed TGA format uses a run-length compression scheme.
Related Topics:
Understanding File Formats 



Tiff (*.TIF)

The Tagged Image File Format (TIFF) is used to exchange pictures between programs and computer 
platforms. This file format has gone through several revisions, and different versions are often 
incompatible.
You can save black and white, 256 color, 24 bit color, and gray scale pictures in the TIFF file format. 
PhotoFinish saves TIFF files in version 5.0 TIFF files and can often load versions 3 and 4 TIFF files as 
well.
If you are saving a 256 color, 24 bit color, or gray scale picture, you can specify a compressed or 
uncompressed format in the File Sub-Format drop-down list. PhotoFinish uses the LZW compression for 
these types of pictures. Keep in mind that although compressing reduces the size of the file, some 
desktop publishing programs require the uncompressed format.
If you are saving a black and white picture, you can choose either Packbits, or CCITT Group 3 1-D 
compression from the File Sub-Format drop-down list. Packbits is a generic compression, similar to run-
length encoding. You will often get better compression with this option. CCITT uses a modified Huffman 
compression scheme with predefined tables. CCITT is highly optimized for good compression on FAX 200
dpi files.

If you have problems with a TIFF file, you can use the TIFFDUMP.EXE utility program to view information 
about the file. TIFFDUMP.EXE was copied to your PhotoFinish directory when you installed the program. 
To run TIFFDUMP, double-click the TIFF File Info icon in your PhotoFinish program group.

Related Topics:
Understanding File Formats 



Understanding Color Tolerance

You adjust the color tolerance to determine the area affected when you use the Magic Wand, Color 
Replacer, and Paint Roller tools. For example, if your picture is a red apple among green leaves, you can 
adjust color tolerance so that the tool affects the entire apple, and only the apple. The leaves are not 
affected -- there is only a slight color difference between the different shades of red in the apple, but there
is a drastic color difference between the red apple and the green leaves.
The lower the color tolerance value, the smaller the range of color that is affected. You can choose a color
tolerance value from 0 to 255, where 255 affects all the color channels in the picture. 
The colors affected depend on the color you click in your picture. For example, if you click on the red 
apple, the color range is centered on the red value you clicked, and all of the adjacent colors within the 
color tolerance range are affected. If, however, you click on a green leaf, the color range is centered on 
the shade of green you clicked, and all adjacent areas with similar green colors are affected.

You use the Range control on the Magic Wand, Color Replacer, or Paint Roller ribbon bar to set the same
color tolerance values for all color channels. If you want to adjust color tolerance so that it is weighted 
toward a specific RGB color channel, choose the Color Tolerance command, clear the Identical Values 
option, and set the values you want for each color channel. For example, you can increase the value of 
the red color channel and decrease the blue and green channels so that colors with more reds and fewer 
other colors are affected by the tool. Using different values for color tolerance is most useful with 24 bit 
pictures.



Memory Information

The amount of memory available in your computer system determines the size and number of pictures 
you can open (up to eight pictures). When you work with large pictures, it is easy to exceed the amount of
RAM installed in your system.
Windows uses free space on your hard drive to simulate expanded memory. This is known as virtual 
memory. The amount of memory available to Windows applications is equal to the amount of free RAM, 
plus the amount of disk space Windows has reserved for use as virtual memory. For information on 
setting Windows virtual memory options, see your Windows documentation. 
In addition, PhotoFinish includes its own virtual memory manager. If the memory required exceeds the 
amount of memory Windows has set aside, you can use PhotoFinish's virtual memory. You use the 
Preferences command to set virtual memory options.
The following list explains when and how you should use PhotoFinish's virtual memory:

If you have more than 4,000 KB free Windows memory, disable the PhotoFinish virtual memory 
manager.

If you have less than 4,000 KB free Windows memory, enable the PhotoFinish virtual memory 
manager. 

Delete any files you do not need from your hard drive to make more disk space available for 
virtual memory.

If all applications run slowly, reduce the Max KB setting in the Virtual Memory dialog box to one-
half the amount of expanded memory installed in your system. You can determine the amount of 
expanded memory by exiting Windows completely and typing mem.

If just PhotoFinish and other ZSoft products run slowly, increase the amount of Max KB until 
performance improves. 

Always enable virtual memory if you run Windows in standard mode (WIN/S).

If the program continues to run slowly, try some of the following steps:
Close all applications you are not using, including applications that appear as icons on the 

Windows desktop.
Close any PhotoFinish pictures you do not need, including pictures you have not saved yet.
After you have cut or copied a large cutout to the Clipboard, you may notice a decrease in 

program performance. If you no longer need to paste the cutout from the Clipboard, choose Clipboard 
Viewer from the Program Manager's Main window to display the Clipboard Viewer. Choose Delete from 
the Clipboard Viewer's Edit menu. 



Troubleshooting
 

This topic answers some of the most commonly asked questions about PhotoFinish. 
Q. Why does PhotoFinish print such a small area when I tell it to Fit to Page?
A. Crop excess white space from the picture and print the file again.
Q. Why is my Calibrate Monitor option grayed out? 
A. Windows is running in 16 color mode. Your video driver must be able to support at least 256 colors. 
Change your Windows video driver to at least 256 colors, available from your video board's manufacturer.
For information about calibrating your scanner, printer, and monitor, see Calibrating Your Hardware. 
Q. Why do my images look so grainy?
A. Windows is running in 16 color mode. Change your Windows video driver to at least 256 colors, 
available from your video board's manufacturer. You can also choose the Optimize Display to improve the
on-screen appearance of your pictures.

Q. Why does PhotoFinish run so slowly when I am editing a 24-bit image?
A. 24-bit files require the most amount of memory. For information about memory, see Memory 
Information and Selecting Memory Options. 

Q, Why does PhotoFinish sometimes not erase the pull down menus? 
A. Check available memory. If the problem persists, change the Windows video drivers to VGA to test the 
video driver. If the problem does not occur when you use the VGA video driver, check your video driver 
manufacturer to see if they have an updated driver. 

Q. Why does PhotoFinish create a thumbnail directory and yet it places most of my thumbnail files in the 
same directory as my image?

A. The thumbnail directory is created if PhotoFinish is trying to build a thumbnail for a file that is stored on
a read-only drive.

Q. Why are the Scan menu commands grayed out?
A. The PhotoFinish scanner drivers for the scanner are not loaded. Use the PhotoFinish Setup program 
to install the scanner to use with PhotoFinish. For more information about scanning, see Scanning with 
PhotoFinish. 

Q. Why do my color files print too dark when I print from PhotoFinish?
A. Choose Printer's Halftones when printing on a color printer.



Alphabetical List of Procedures
 

Click an icon below to jump to an alphabetical listing of PhotoFinish Procedures. You can scroll through 
the entire list of procedures.

    

    

    

    

    

    

    

    

    

    

    

    

    

    

    

    

    

    

    

    

    

    

 



Acquiring an Image with a TWAIN Device 
Activating a Picture Window 
Adding a Crumple Effect 
Adding a Mosaic Effect to Your Image 
Adding Facets to Your Picture 
Adding Text to Your Picture 
Adding Texture to Your Picture 
Adjusting a Color/Gray Map 
Adjusting Brightness and Contrast 
Adjusting Hue and Saturation 
Adjusting Individual Colors 
Adjusting Picture Resolution 
Airbrush Tool Options 
Airbrush Tool Types 
Applying a Paper Texture 
Applying Texture 
Applying the Black Hole Effect 
Applying the Fisheye Effect 
Applying the Maximum Filter 
Applying the Minimum Filter 
Arranging Your Picture Icons 
Automatically Adjusting Brightness and Contrast 
Automatically Adjusting Color Saturation 
Automatically Cropping 
Automatically Removing Moiré Patterns 
Automatically Sharpening an Image 
Automatically Straightening an Image 

Blend Paintbrush Tool Options 
Blending Freehand 
Blending with the Blend Filter 
Blurring Your Picture 
BMP File Format 
Box Tool Types 
Brighten Paintbrush Tool Options 
Brightening Freehand 
Browsing Through Thumbnails 

Calibrating Your Hardware 
Calibrating Your Monitor 
Calibrating Your Printer 
Calibrating Your Scanner 
Capturing Different Picture Sizes 
Cascading Your Picture Windows 
Chalk Tool Options 
Chalk Tool Types 
Changing All the Colors in Your Palette 
Changing Color Formats 
Changing Contrast Freehand 



Changing the Direction of Your Gradient 
Changing Tool Settings 
Changing Tool Width and Shape 
Changing Your AutoEnhance Options 
Changing Your Highlights and Shadows 
Changing Your Output Device 
Charcoal Tool Options 
Charcoal Tool Types 
Clearing Your Picture to the Background Color 
Clone Tool Options 
Closing a Picture 
Color Pencil Tool Options 
Color Pencil Tool Types 
Color Replacer Tool Options 
Compensation Map Editing Options 
Compressing with JPEG 
Contrast Paintbrush Tool Options 
Convert To Options 
Copying Picture Files with the Viewer 
Copying to the Clipboard 
Crayon Tool Options 
Crayon Tool Types 
Creating a Motion Effect in Your Picture 
Creating a New Color 
Creating a New Monitor Calibration Map 
Creating a New Printer Calibration Map 
Creating a New Scanner Calibration Map 
Creating a Range of Colors 
Cropping a Cutout 
Crystallizing Your Picture 
Curve Tool Options 
Customizing PhotoFinish 
Cutting to the Clipboard 

Defining a Polygonal Area 
Defining a Rectangular Area 
Defining an Area of Similar Colors 
Defining an Elliptical Area 
Defining an Irregular Area 
Deleting Picture Files with the Viewer 
Deleting Portions of Your Picture 
Diffusing Your Picture 
Displaying Picture Information 
Displaying System Information 
Drawing a Box 
Drawing a Polygon 
Drawing a Rounded Box 
Drawing an Ellipse/Circle 
Drawing an Equal-sided Polygon 
Drawing Freehand Shapes 
Drawing Freehand with a Charcoal Tool 



Drawing Freehand with the Chalk Tool 
Drawing Single and Joined Curves 
Drawing Single and Joined Lines 

Editing a Monitor Calibration Map 
Editing a Printer Calibration Map 
Editing a Scanner Calibration Map 
Editing Your Picture Full Screen 
Embossing Your Picture 
Enhancing and Retouching 
Enhancing Edges 
EPS File Format 
Eraser Tool Options 
Eraser Tool Types 
Erasing Parts of Your Picture 
Exiting and Returning to the Destination Application 
Exiting PhotoFinish 
Eyedropper Tool Options 

Filling an Area 
Finding and Selecting Tools 
Fine-tuning with the Color/Gray Map 
Fitting to Zoom 
Flatbed Scanner Dialog Box Options 
Flatbed Scanner Page Size Options 
Folding and Unfolding the Palette 
For Beginners 

Getting Acquainted 
GIF File Format 

Hand Scanner Dialog Box Options 
Hand Tool Options 
Handscanning Different Page Sizes 

Improving the Quality of a Picture 
Improving the Quality of a Scanned Image 
Inverting Colors in Your Picture 

JPEG File Format 

Keyboard Shortcuts 

Laying Out the Toolbox 
Leaving a Copy of a Cutout 
Line Tool Options 
Line Tool Types 
Loading a Palette 
Loading a Texture from Disk 
Loading Scanner Settings 
Local Undo Tool Options 
Locator Tool Options 



Magic Wand Tool Options 
Making a Mirror Image 
Making the Background Color Transparent 
Manipulating Defined Areas 
Manually Adjusting Equalize Options 
Marker Tool Options 
Marker Tool Types 
Mixing RGB Colors 
Moving Areas of Your Picture into View 
Moving Picture Files with the Viewer 
MSP File Format 

Opening a Tile Pattern 
Opening an Existing Picture 
Optimizing Your Display 
Outlining Shapes in Your Picture 

Paint Roller Tool Options 
Paint Roller Tool Types 
Paintbrush Tool Options 
Paintbrush Tool Types 
Painting Freehand 
Painting with a Pencil Effect 
Painting with Crayons 
Painting with Markers 
Painting 
Pasting from Disk 
Pasting from the Clipboard 
PCD File Format 
PCX File Format 
Pen Tool Options 
Pen Tool Types 
PhotoFinish Shortcuts 
PhotoFinish Tools 
PhotoFinish Utilities 
Picking Up a Color from the Picture 
Pixelating Your Picture 
Posterizing Your Picture 
Preferences Dialog Box Options 
Previewing a Picture 
Printing a Picture 

Quickly Pasting a Cutout or Canceling Current Selection 

Recalibrating Your Monitor 
Recalibrating Your Printer 
Recalibrating Your Scanner 
Removing Moiré Patterns from Your Image 
Removing Spots from Your Image 
Renaming Picture Files with the Viewer 



Replacing One Area with Another Freehand 
Replacing One Color with Another 
Rescanning a Picture 
Resizing Freehand 
Resizing Your Picture 
Restoring Your Previous Version 
Rotating by Degrees 

Saving a Copy of an Embedded Picture 
Saving a Palette 
Saving a Picture with a New Name 
Saving Portions of Your Picture to Disk 
Saving Response Curve Settings 
Saving Scanner Settings 
Saving Your Picture with Save 
Scanner Setup Dialog Box Options 
Scanning a Picture 
Scanning Different Page Sizes 
Scanning with a Flatbed Scanner 
Scanning with a Hand Scanner 
Scanning with a Video Grabber 
Scanning with PhotoFinish 
Scanning 
Scrolling 
Selecting a Color in the Color Refiner Box 
Selecting a Paper Type 
Selecting a TWAIN Source 
Selecting and Styling a Font 
Selecting Memory Options 
Selecting Preferences 
Selecting Tool Colors 
Selecting Tool Settings 
Selecting Your Entire Picture 
Setting AutoScan Options 
Setting Up Scanning Options 
Setting Up Your Printer 
Shading with the Airbrush 
Shape Tools Options 
Sharpen Paintbrush Tool Options 
Sharpening Freehand 
Sharpening with the Sharpen Filter 
Showing or Hiding the AutoBar 
Showing or Hiding the Palette 
Showing or Hiding the Ribbon Bar 
Showing or Hiding the Status Bar 
Showing or Hiding the Toolbox 
Showing or Hiding Workboxes 
Smudge Paintbrush Tool Options 
Smudge Paintbrush Tool Types 
Smudging Freehand 
Specifying Color Tolerance 



Splattering Color with the Spraycan 
Spraycan Tool Options 
Spraycan Tool Types 
Starting a New Picture 
Stitching Scanned Images 

Targa File Format 
Text Tool Options 
TIFF File Format 
Tiling Your Picture Windows 
Tint Paintbrush Tool Options 
Tinting Freehand 
Tool Constraints 
Tune Color/Gray Map Style Options 
Turning Your Picture Upside Down 
Twisting Your Picture 

Understanding Color Tolerance 
Understanding File Formats 
Undoing Changes to Your Picture 
Undoing Some Changes 
Update Info 
Updating an Embedded Picture 
Using Filter Commands 
Using PhotoFinish Windows 
Using Special Effect Commands 
Using the AutoBar 
Using the Ribbon Bar 
Using Tune Commands 

Video Grabber Dialog Box Options 
Viewing a Picture in Multiple Views 
Viewing Colors on Your Screen 
Viewing Filter Samples 
Viewing More Levels of Gray 
Viewing Only Your Picture 
Viewing Pictures 
Viewing Special Effect Samples 
Viewing the Same Area in Multiple Windows 
Viewing Tune Samples 
Viewing Your Picture with No Zoom 

Working with 24 Bit Color Pictures 
Working with 256 Color Pictures 
Working with Black and White Pictures 
Working with Color 
Working with Cutouts 
Working with Different Numbers of Colors 
Working with Embedded Pictures 
Working with Gray Scale Pictures 
Working with Pictures 



ZCapture 
Zooming In and Out with the Zoom Commands 
Zooming In and Out with the Zoom Tool 
Zooming to Fit 



Getting Acquainted
 

Activating a Picture Window 
Displaying Picture Information 
Displaying System Information 
Editing Your Picture Full Screen 
Folding and Unfolding the Palette 
For Beginners 
Keyboard Shortcuts 
PhotoFinish Tools 
Scrolling 
Selecting Tool Colors 
Selecting Tool Settings 
Showing or Hiding the Status Bar 
Tool Constraints 
Understanding File Formats 
Using PhotoFinish Windows 
Using the AutoBar 
Using the Ribbon Bar 
Viewing a Picture in Multiple Views 
Viewing Only Your Picture 



Customizing PhotoFinish

Calibrating Your Hardware 
Calibrating Your Monitor 
Calibrating Your Printer 
Calibrating Your Scanner 
Optimizing Your Display 
Selecting Memory Options 
Selecting Preferences 
Viewing More Levels of Gray 



Working with Pictures

Adjusting Picture Resolution 
Browsing Through Thumbnails 
Compressing with JPEG 
Opening an Existing Picture 
Printing a Picture 
Saving a Picture with a New Name 
Saving Your Picture with Save 
Setting Up Your Printer 
Starting a New Picture 
Understanding File Formats 
Viewing Pictures 



Working with Color

Adjusting Individual Colors 
Changing All the Colors in Your Palette 
Changing Color Formats 
Changing the Direction of Your Gradient 
Creating a New Color 
Creating a Range of Colors 
Loading a Palette 
Mixing RGB Colors 
Saving a Palette 
Selecting Tool Colors 
Specifying Color Tolerance 
Understanding Color Tolerance 



Scanning

Acquiring an Image with a TWAIN Device 
Calibrating Your Scanner 
Improving the Quality of a Scanned Image    
Loading Scanner Settings 
Removing Moiré Patterns from Your Image 
Removing Spots from Your Image 
Rescanning a Picture 
Saving Scanner Settings 
Scanning with a Flatbed Scanner 
Scanning with a Hand Scanner 
Scanning with a Video Grabber 
Scanning with PhotoFinish 
Selecting a TWAIN Source 
Setting AutoScan Options 
Setting Up Scanning Options 
Stitching Scanned Images 



Working with Cutouts

Copying to the Clipboard 
Cropping a Cutout 
Cutting to the Clipboard 
Defining a Polygonal Area 
Defining a Rectangular Area 
Defining an Area of Similar Colors 
Defining an Elliptical Area 
Defining an Irregular Area 
Deleting Portions of Your Picture 
Leaving a Copy of a Cutout 
Making a Mirror Image 
Making the Background Color Transparent 
Manipulating Defined Areas 
Pasting from Disk 
Pasting from the Clipboard 
Quickly Pasting a Cutout or Canceling Current Selection 
Resizing Freehand 
Resizing Your Picture 
Rotating by Degrees 
Saving Portions of Your Picture to Disk 
Selecting Your Entire Picture 
Turning Your Picture Upside Down 



Enhancing and Retouching

Adding a Crumple Effect 
Adding a Mosaic Effect to Your Image 
Adding Facets to Your Picture 
Adding Texture to Your Picture 
Adjusting Brightness and Contrast 
Adjusting Hue and Saturation 
Applying a Paper Texture 
Applying Texture 
Applying the Black Hole Effect 
Applying the Fisheye Effect 
Applying the Maximum Filter 
Applying the Minimum Filter 
Automatically Adjusting Brightness and Contrast 
Automatically Adjusting Color Saturation 
Automatically Cropping 
Automatically Removing Moiré Patterns 
Automatically Sharpening an Image 
Automatically Straightening an Image 
Blending Freehand 
Blending with the Blend Filter 
Blurring Your Picture 
Brightening Freehand 
Changing Contrast Freehand 
Changing Your Highlights and Shadows 
Clearing Your Picture to the Background Color 
Creating a Motion Effect in Your Picture 
Cropping a Cutout 
Crystallizing Your Picture 
Diffusing Your Picture 
Embossing Your Picture 
Enhancing Edges 
Fine-tuning with the Color/Gray Map 
Improving the Quality of a Picture 
Inverting Colors in Your Picture 
Outlining Shapes in Your Picture 
Pixelating Your Picture 
Posterizing Your Picture 
Removing Moiré Patterns from Your Image 
Removing Spots from Your Image 
Replacing One Area with Another Freehand 
Sharpening Freehand 
Sharpening with the Sharpen Filter 
Smudging Freehand 
Tinting Freehand 
Twisting Your Picture 
Using Filter Commands 
Using Special Effect Commands 



Using Tune Commands 
Viewing Filter Samples 
Viewing Special Effect Samples 
Viewing Tune Sample 



Painting

Adding Text to Your Picture 
Drawing a Box 
Drawing a Polygon 
Drawing a Rounded Box 
Drawing an Ellipse/Circle 
Drawing an Equal-sided Polygon 
Drawing Freehand Shapes 
Drawing Freehand with a Charcoal Tool 
Drawing Freehand with the Chalk Tool 
Drawing Single and Joined Curves 
Drawing Single and Joined Lines 
Erasing Parts of Your Picture 
Filling an Area 
Painting Freehand 
Painting with a Pencil Effect 
Painting with Crayons 
Painting with Markers 
Replacing One Area with Another Freehand 
Replacing One Color with Another 
Selecting a Paper Type 
Selecting Tool Settings 
Shading with the Airbrush 
Smudging Freehand 
Splattering Color with the Spraycan 
Using the Ribbon Bar 



PhotoFinish Utilities 

PhotoFinish has utilities you use to view information about .PCX and .TIF files, to view information about 
your computer, and to capture areas of your screen.
Utilities
CHKALL: Allows you to check information about hardware, memory, and some software present in your 

computer system. This is a DOS utility you use at the DOS prompt. For information about this utility, 
see the CHKALL.TXT file that was copied to your PhotoFinish directory during Setup.

PCXHDR: Allows you to view header information about .PCX files and turn off a palette in a .PCX file. 
This is a DOS utility you can use from the Windows environment. For information about this utility, 
see the PCXHDR.TXT file that was copied to your PhotoFinish directory during Setup.

TIFFDUMP: Allows you to view information about .TIF files. This is a DOS utility you can use from the 
Windows environment. For information about this utility, see the TIFFDUMP.TXT file that was copied 
to your PhotoFinish directory during Setup.

ZCapture: Takes over your Windows screen capture functions so you can capture areas of your screen 
and keep the colors intact.     

UNINSTALL: Deletes all files in the PhotoFinish directory and all subdirectories the Setup program copied
to your hard disk. For more information about this utility, see the Reference section in your 
PhotoFinish User's Guide.



ZCapture 

ZCapture is a Windows program that takes over your Windows screen capture functions so you can copy 
areas of your screen to the Clipboard and keep your colors intact. During setup ZCapture is added to your
PhotoFinish program group (it looks like a Z caught in a butterfly net). The name of the icon is ZCapture.
To run ZCapture:
1 Open your Windows Program Manager.

2 Double-click on the ZCapture icon.

3 Click the left mouse button again to remove the information box that appears on your screen.

4 To disable ZCapture and use the standard Windows screen capture functions, double-click the 
ZCapture icon again.

To copy areas of your desktop to the Clipboard with ZCapture:
Press PrtSc to capture the entire desktop.
Press Alt+PrtSc to capture only the active window.
Press Alt+Pause to capture only the contents of the active window.
If your keyboard does not include a Pause key, press Alt+Ctrl+NumLock.
To disable ZCapture and use the standard Windows screen capture functions, double-click the 

ZCapture icon again.
To display the area you copied to the Clipboard you can:
Choose File Open and click the Clipboard button to load the Clipboard image into a new picture 

window.
Choose Edit Paste to load the picture into the active picture.



Click the Clipboard button to load the contents of the Clipboard.



Click Info to preview and read information about the picture.



The cutout is replaced by the background color.



If you paste into a 256 color or gray scale picture and the cutout contains colors not 
included in the palette, the cutout's colors change.

The cutout's colors do not change if you first convert the picture to 24 bit color or 
load a more compatible palette.



The cutout appears in the upper left corner of picture window, enclosed by the 
marquee.



You can manipulate a cutout until you paste it.
You can also use the arrow keys to move a cutout one pixel at a time.



Use Copy to store a defined area on the Clipboard without cutting it from the picture.
Use Cut to cut and store a defined area on the Clipboard.
Use Delete to delete a defined area and preserve the contents of the Clipboard.



Do not choose the .EPS format until you finish making changes to your picture.
If you choose the .JPG format, your picture will lose some detail.



If you choose the PCX format and the active picture is 256 color or gray scale, you 
can select 16 Color from the Subformat drop-down list to save with 16 colors.

If you open the picture again, Photo Finish converts the picture to 256 colors.
Use Save As to save the picture again in 16 colors.
If you choose Custom for the JPEG format, a dialog box appears when you choose OK 

so you can select settings.



You can use this command with gray scale and 24 bit color pictures.
Use Convert To to change the color mode of a picture.



You can use this tool with gray scale and 24 bit color pictures.
Use Convert To to change the color mode of a picture.



You can use this command if you have a flatbed scanner that supports 256 gray scale
or 24 bit color.

For other scanners, use Scan to scan your image, then use AutoEnhance to enhance 
the image.



You can use this command with gray scale, 256 color, and 24 bit color pictures.
Use Convert To to change the color mode of a picture.



You can use this tool with gray scale, 256 color, and 24 bit color pictures.
Use Convert To to change the color mode of a picture.



The higher the number, the greater the effect.



Choose Preview to see how changes may alter your picture.
Choose Accept in the Preview dialog box to apply the changes to the picture, choose 

Return if you want to adjust the settings again, or choose Cancel to cancel the command.



Some blending occurs each time you apply Transform Rotate. 
If you have rotated a cutout and do not like the results of the rotating, choose Undo 

before you paste the changes. Then, choose Transform Rotate again and adjust the amount 
of rotation. 

If you have rotated the entire picture, choose Revert and try again.



To quickly display the Toolbox, press Ctrl+T.
To quickly display the Palette, press Ctrl+P.
To quickly display the AutoBar, press Ctrl+U.
To quickly display the ribbon bar, press Ctrl+R.
To quickly display the status bar, press Ctrl+B.



The area you click centers in the picture window.



To see changes occur in other zoom views, duplicate the picture and adjust the zoom 
levels of the two picture windows. Use the Locator tool to display the same area in all copies.



The Hand and Locator tools may be grouped. Press on the white triangle and drag to 
the tool you want to use.

Use the Hand tool to move other areas of a single picture into view. Use the Locator 
tool to quickly display the same area in all windows that contain the same duplicates.



Click the left mouse button to choose the primary color.
Click the right mouse button to choose the secondary color.
Hold down Shift and click the left mouse button to choose the background color.



The selection tools may be grouped. Press on the white triangle and drag to the tool 
you want to use.



The marquee surrounds the area when you release the mouse button.
You can drag the marquee to move the cutout or use the Image and Edit menu 

commands to manipulate the defined area.



Use Undo to cancel all changes made since the last time you chose a tool or 
command.

Use the Local Undo tool to cancel only some changes made since the last time you 
chose a tool or command.

Use Revert to undo all changes made since the last time you saved the picture.
Use Clear to replace the current picture with the selected background color.



Completely enclose the area you are filling or the color "leaks out." If this happens, 
choose Undo and zoom in to fix any "holes" in the border.

You also can adjust color tolerance    to control color leaking.



Type a number or use the Width mini-scroll bar on the ribbon bar or in the tool's Tool 
Options dialog box to change the tool's size.

Click the Shape drop-down list on the ribbon bar or in the tool's Tool Options dialog 
box and select the shape you want.



To draw joined curves or lines, draw your first curve or line. (Do not paste the curve.) 
Point to where you want the second curve or line to end and click the right mouse button.

To draw rays joined at a single point, draw the first curve or line. (Do not paste the 
curve.) Point to where you want the second curve or line to end, hold down Ctrl, and click 
the right mouse button. This option is not available if you are using a one-button pointer.



The tools may be grouped. Press on the white triangle and drag to the tool you want 
to use.



Hold down Shift while you drag to constrain the tool to a circle.
To draw concentric ellipses or circles, draw the largest ellipse or circle first. Then, 

press the right mouse button and drag to draw the others.



Hold down Shift while you drag to constrain the tool vertically or horizontally.
To change the level of the effect, select a different level from the ribbon bar.
Repeated brushes have no effect unless you paste the changes. To paste the 

changes, click the tool and brush again.



The secondary color begins gradients.
The background color ends gradients.
To create a smoother gradient in 256 color pictures, use Range of Colors or load 

another palette and adjust your colors so they have the same hue.
You can also convert your picture to 24 bit color to get smoother gradients.



Use the Box Selection, Magic Wand, Lasso, Elliptical Selection, or Scissors to define 
an area.



Default settings generally provide good results.
Shades to the left of the Low arrow are black.
Shades to the right of the High arrow are white.
Highlights are the shades between the High and Mid values.
Shadows are the shades between the Low and Mid values.
Choose Restore to return to the original values.



The larger the spot size, the more time is required for the filter to work.
If the sample buttons display an X, click the Show Samples option to display the 

samples. 



The converted picture is loaded into a window named NEW followed by a number.
Use Save As to save the converted picture.



Colors are reversed as if on a photographic negative.



You can create gray scale, 256 color, 24 bit color, and black and white pictures.



Type numbers in the boxes or use the mini-scroll bars to set the size.
The dialog box indicates how much memory is needed for the picture and how much 

remains.



The picture's name appears on the picture's title bar and the Window and File menu 
picture lists.

You can open up to eight pictures at one time.



Information includes the picture's name, the last time the picture was saved, height 
and width in pixels, number of colors, file size, image size, format, and type of compression 
used, if any.



If you have selected Keep Thumbnail Files in Preferences, PhotoFinish displays the 
small picture more quickly the next time you preview the picture.



Use Save As to save a picture for the first time or to save an existing picture with a 
new name, in a different directory, or in a different format.

Use Save or click the Save button on the AutoBar to save changes in a previously 
saved picture.



Before you print, use Print Setup to set up your printer.
You may also want to calibrate your printer before your print.



1 to 1 prints the picture at its current size. This option does not adjust for picture 
resolution if the resolution is different from your printer resolution.

Actual Size prints the picture at its current size and resolution.
Fit to Page resizes the picture to the page size indicated in your Print Setup dialog 

box.
Scale changes the printed size of the picture. Adjust the size in the Scale text box.
Poster prints across multiple pages if you scale a picture larger than your page.
Smooth Resize removes blockiness that may occur when you print a picture larger 

than its actual size. Some detail may be lost if you choose Smooth Resize.



Select PhotoFinish's Halftone to let PhotoFinish select the best pattern.
Select Printer's Halftone to use the printer's default halftone, if it has one.



The options you can change depend on your printer.



The active window is placed at the top left corner of the desktop.



You can edit your picture in Full Screen mode.
You cannot edit your picture in Show Screen mode.



The Magic Wand, Color Replacer, and Paint Roller use Color Tolerance values.
Select values for Red, Green, and Blue.
Depending on your picture, values that give good results range from about 10 to 50. 

A value of 30 is a good place to start.
To fill, replace, or select a single color, set the values to 0.
Select Identical Values to set all the ranges at the same values.
For more information, see Understanding Color Tolerance.



VGA Palette isn't available if your screen displays 16 or more gray levels.
Read the warning in the dialog box before you complete this command.



Click to increase the number of grays you see on-screen.
Before you test your hardware, save all of your work. Your system may not support 

this option.



If color areas become gray, you can use the VGA Hardware Palette.
If the screen turns black or your system locks up, you cannot use the VGA Hardware 

Palette.



The VGA setup becomes a PhotoFinish program default. It does not affect other 
programs.

Deselect the option if you no longer want to use it.



Changes what PhotoFinish displays when you start the program.
Choose Nothing if you do not want to load a file or see the About box when you start 

PhotoFinish.



The status bar shows context-sensitive information at the bottom of your screen.



Saves thumbnail preview pictures to disk with an extension that begins with !. For 
example, a thumbnail picture of a .PCX file has a .!PX extension.



Click to change PhotoFinish's virtual memory manager settings.



Choose a unit of measure for your work from the Units drop-down list.



You can open a scanner configuration to load previously saved options before you 
scan.



The scanned image appears in a picture window named "NEW."
Use Save As on the File menu to save the image to disk with a new name.



You can use any unit of measure with a video grabber.



Width cannot be wider than the width of your hand scanner.



For perfect placement, use a Zoom command (not the Zoom tool) to zoom in on the 
picture. Then, use the arrow keys to move the selected area one pixel at a time.



If Save Backup Copy is selected, PhotoFinish saves a backup copy of your picture. The
backup file's name is the same as the original's, except the last letter of the extension is a $.



If the Zoom tool is selected, click the 100% button on the ribbon bar to quickly return 
to normal view.



Click the 100% button on the ribbon bar to quickly return to normal view.



Hold down Shift while you drag to constrain the tool vertically or horizontally.
Press the spacebar to change the direction of the constraint.



Hold down Shift while you drag to constrain the tool to a square.



Hold down Shift while clicking or dragging to constrain the tool vertically, 
horizontally, or at a 45° angle.



The tools may be grouped. Press on the white triangle and drag to the tool you want 
to use.



The Clone tool gives you more precise control than copying and pasting a picture.



The point where you click defines where cloning begins.
To change the source for your clone, point to another area and click the right mouse 

button.



No cloning occurs after you reach the edges of your source picture.
The first click with the clone brush sets the beginning point for painting.
Hold down Shift while you drag to constrain cloning vertically or horizontally. Press 

the spacebar to change the direction of the constraint.



Drag the square handles to reposition the ends of the curve.
Drag a circle handle to bend a portion of the curve.



You can enter more than 400 characters, or about 10 lines of text.
Press Ctrl+Enter to start a new line.
Press Ctrl+V to insert text from the Clipboard.



The text appears in your picture surrounded by the Text Frame box.
Drag the handles on the Text Frame to adjust your margins.
Point to the middle of the Text Frame and drag to move the text to another location 

before you paste it.



Use the ribbon bar to select another font or change the font style, size, and format. 
You can also use the Tool Options command to change the font.

Select different colors from the Palette to change the color of the text, text outline, 
and text shadow.



To make another picture active, click the title bar of the picture you want to edit or 
choose its name from the Window menu picture list.



Double-click an icon to restore the picture to your desktop or choose its name from 
the Window menu picture list.



A check mark appears beside the command to show it is selected.
PhotoFinish applies the best halftone for the picture. Using this command slows down

the program's response time.
You can make other on-screen adjustments with the Calibrate Monitor command on 

the Display menu and VGA Palette options in the Preferences dialog box.



Hold down Shift while you drag to constrain the tool to a circle.



Hold down Shift while defining an area with the Box Selection to define a square.
Hold down Shift while defining an area with the Scissors to constrain horizontally, 

vertically, or at 45 degree angles.
Hold down Shift while defining an area with the Lasso to constrain horizontally or 

vertically. Press the spacebar to change the direction of constraint.
Hold down Shift while defining an area with the Elliptical Selection to define a circle.
Hold down Shift while you drag a cutout to leave a single copy behind.
Hold down Ctrl while you drag a cutout to leave a trail of copies behind.



Key to PhotoFinish Help

Click the left mouse button on an underlined down arrow for additional information.
Click an arrow that points to the right to jump to more in-depth information.
Point to a word with a broken underline and click the left mouse button to read the 

word's definition.
Click words with a solid underline to jump to information about that topic.



Information includes the name of the picture, width and height in pixels, resolution in 
dots per inch and dots per centimeter, picture type, image size, picture format and 
subformat, and whether the picture has changed since it was last saved.



Changing the picture resolution affects how PhotoFinish prints your picture in certain 
modes and can affect how circles and squares look when you draw.

If Vertical and Horizontal resolution are different, circles and squares do not look 
correct on-screen.

This command also is available on the picture's Control menu.



RGB adjusts the amount of red, green, and blue.
CMY adjusts the amount of cyan, magenta, and yellow.
HLS adjusts the hue, lightness, and saturation.



Click in the color slider bar to the right of the color refiner box or drag the color slider 
arrow.

You can also use the mini-scroll bar or type a number in the appropriate text box to 
the right of the slider.

Choose Restore to return to the original values.



The color you click on appears in the color sample box.
You can also drag in the color refiner box to select a color.



Select this option to use PhotoFinish's virtual memory manager. Enable Virtual 
Memory is recommended for standard mode.

Disabling PhotoFinish's virtual memory manager improves program performance if 
you have enough Windows memory for your pictures.



Type a number greater than 64 to specify in kilobytes the minimum amount of 
Windows memory you want to allocate to PhotoFinish.

This option is not available if you have disabled PhotoFinish's virtual memory 
manager.



Type a number greater than 64 to specify in kilobytes the maximum amount of 
Windows memory you want to allocate to PhotoFinish. Generally, if the number is too high, 
you may notice a decrease in program performance.

This option is not available if you have disabled PhotoFinish's virtual memory 
manager. 



You can assign up to four drives for PhotoFinish to use to store temporary files.
This option is unavailable if Enable Virtual Memory is not selected.
List fastest drives first.
Separate paths with a semicolon.
Network and floppy drives are not recommended.
If you are using a disk doubling program, you must set your virtual memory path to 

an uncompressed drive.



Changes a picture to black and white.
Choose Line Art if you do not want a halftone applied.
Choose Printer to use a fatting halftone.
Choose Screen to use a diffused or Bayer halftone.
Some commands and tools cannot be used with black and white pictures.



Changes a picture to 256 color.
Some commands and tools cannot be used with 256 color pictures.



Changes a picture to gray scale.
Most commands and tools can be used with gray scale pictures.



Changes a picture to 24 bit color.
All commands and tools can be used with 24 bit color pictures.



Select a drive from the Drives drop-down list.
Select a directory from the Directories list box.
You can also type the full path and name in the File Name text box.



RGB adjusts levels of red, green, and blue in the selected color.
HLS adjusts the hue and levels of lightness and saturation in the selected color.



All adjusts all the colors in the picture and is the only channel available for gray scale 
pictures.

Choose a single color channel to create special effects or to adjust color balance in 
your image. 



Smoothes distribution and fine-tunes other Styles.
Point to the handles on the curve in the sample box and drag to adjust the curve.



Allows you to draw any shape you want in the sample box.
Point to the curve and drag to draw the curve you want.



Allows you to adjust brightness and contrast of a channel.
Point to the handles on either end of the line in the sample box and drag to make 

adjustments.



To close a single copy of a duplicated picture, use the Close command on the 
picture's Control menu.



Change the numbers in the appropriate text boxes to indicate the size of the area you
want to scan.

You can also drag a frame marker to adjust margins.
If you are using a flatbed or hand scanner, click Default to set the scan area to the 

current scan size.
Click Restore to reset the scan area to the last margin settings you used.



Click to quickly prescan the picture or area so you can identify a portion to scan or 
capture.

Choose Draft or Quality mode from the Prescan drop-down list.
If you are using a video grabber, select a Single mode to prescan the area once or 

select a Multiple mode to continuously prescan the area.



Drag the arrows to adjust Brightness and Contrast while you continuously prescan an 
area.

You can also adjust Brightness and Contrast in the scanning Options dialog box.



Click to display the progress of the scan as you move the hand scanner.



The image appears in the Scan Area box when you prescan.
Point to a frame marker and drag to adjust the size of the final scan.
Drag the frame to change the location of the final scan.



The image you scan appears in the box.
Click OK and the image is loaded into a picture window.



Click to specify the size of the area to be scanned or captured.



Click Info to preview and read information about the picture.
Click Viewer to browse through pictures saved to disk or to manage your picture files.



Choose Yes to save changes to the active picture.
Choose No to cancel changes.
Choose Cancel to continue working.



Select a drive from the Drives drop-down list.
Select a Directory from the Directories list box.



The Basic and Hard Eraser tool types change parts of your picture to the background color.
The Bleach and Soft Bleach Eraser tool types use a lighter hue of the background color. Continue

dragging over the same area to erase to white.



With a hand scanner, you should scan from top to bottom.
You can also open a picture and then use Stitch.



Click available Enhancements options to change your picture during scanning.
Border Erase adds a white border.
Edge Enhance increases definition between dark and light areas. 
Gamma Correct gives an appearance of greater contrast and shows more gray shades.
Line Art Detect preserves black and white areas and uses a halftone pattern on multicolor areas.
Mirror Image flips the image.
Negative Image reverses the colors.
Outline traces the edges of objects.



Select a resolution setting from the Resolution drop-down list.
If Custom Resolution is available, choose it to individually set the horizontal resolution (Horiz) and

vertical resolution (Vert) in the appropriate text boxes.



Select a halftone setting from the Halftone drop-down list if your picture has more colors than 
your scanner supports.

These are the halftone patterns that might be available depending on your scanner:

    None

    Bayer

    Coarse Fatting

    Error Diffusion

    Fine Fatting

    Horizontal Line

    Vertical Line

    Vertical Line

    Mesh

    Scanner Defined 1 and 2



Drag the slider box or type a number to adjust the size of the scanned image if your scanner 
supports variable resolutions. 

Increasing or decreasing scaling may change the look of the image.
Click 100% if it is available to quickly adjust scaling to 100%.



Select a color mode and number of colors for the scan from the Image Type drop-down list.
PhotoFinish supports color, gray scale, and black and white.
Only the image types your scanner supports are available.



Chrominance can be set from -8 to 100.
The smaller the number, the more definition between colors is retained.
If your picture is made up of similar colors, you can use a slightly larger number with acceptable 

results.



It is highly recommended that you check the compression results before you discard the original 
picture.

To check the results of saving, you must open the compressed picture again and compare it to 
the original.



The greater the loss, the smaller the file size, but the more detail is lost from your picture. The 
amount of loss that occurs each time you save the picture again with the same settings, depends on how 
much you change the picture.



The first number represents how many pixels to look at for the Chrominance setting.
The second and third numbers represent two color channels. They determine how many pixels to 

view as a single value.
The larger the subsample, the more detail is retained.



Luminance can be set from -8 to 100.
The smaller the number, the more definition between colors is retained.
If your picture is low contrast, you can use a slightly higher setting with acceptable results.



Use the mini-scroll bar or type a number from 0 to 255 in the Noise text box. The higher the 
number, the greater the effect.

Choose Flat or Bell Curve from the Distribution drop-down list. Flat shows more pronounced 
changes and takes less time than Bell Curve.

Choose the color channel you want to affect from the Channel drop-down list.



You can use textures PhotoFinish automatically copied to a subdirectory named TEXTURES 
when you installed the program.

You can also use any gray scale or 24 bit color picture as a texture.



You can resize defined areas freehand with the Transform Free Resize command.
You can specify the amount to resize pictures or defined areas with the Transform Resize 

command.



With the dialog box displayed, you can quickly experiment with different settings.
Choose Undo Picture to cancel changes to your picture and keep the dialog box opened.
Choose Restore Settings to return the settings to their original values. Cancel becomes available 

to close the dialog box.
Choose Close to close the dialog box and use the new settings.
Choose Info for more information about the selected tool type.



PhotoFinish selects an appropriate halftone pattern if you use an average option with a black and 
white picture.



Hold down Shift while you drag to keep the polygon pointing upward.
To draw concentric regular polygons, draw the largest polygon first. Then, press the right mouse 

button and drag to draw the others.



PhotoFinish scans the picture and builds a printer map to compensate for the difference between 
the scanned picture's response curve and the correct response curve.



24 bit color is available only if your scanner supports 24 bit color scanning.
If your scanner does not support either 24 bit color or gray scale scanning, recalibration is 

unavailable.



If your printer supports color and you want to print in color, choose 24 Bit Color.
If you want to print in gray scale or black and white, choose 256 Gray Scale.



If you are opening a texture, it must be gray scale or 24 bit color.
Use a Convert To command to convert a 256 color or black and white picture. 



The check marks next to the workboxes in the Screen Layout cascading menu disappear to 
indicate that all the workboxes have been removed.



Check marks appear next to the workboxes in the Screen Layout cascading menu to indicate that
all the workboxes are displayed.



The menu bar disappears to give you more on-screen viewing room.
Press Ctrl+F to return to normal view.



Use the Box Selection, Magic Wand, Lasso, Scissors, or Elliptical Selection tool to define a 
cutout.



Choose the color in the cutout that you want to be pasted transparently as the background color.



Move from left to right to adjust the green level. The far left represents 0 (no green). The far right 
represents 255 (maximum green).

Move from bottom to top to adjust the blue level. The bottom represents 0 (no blue). The top 
represents 255 (maximum blue).



Move from left to right to adjust the red level. The far left represents 0 (no red). The far right 
represents 255 (maximum red).

Move from bottom to top to adjust the blue level. The bottom represents 0 (no blue). The top 
represents 255 (maximum blue).



Move from left to right to adjust the red level. The far left represents 0 (no red). The far right 
represents 255 (maximum red).

Move from bottom to top to adjust the green level. The bottom represents 0 (no green). The top 
represents 255 (maximum green).



Move from left to right to adjust the magenta level. The far left represents 0 (no magenta). The far
right represents 255 (maximum magenta).

Move from bottom to top to adjust the yellow level. The bottom represents 0 (no yellow). The top 
represents 255 (maximum yellow).



Move from left to right to adjust the cyan level. The far left represents 0 (no cyan). The far right 
represents 255 (maximum cyan).

Move from bottom to top to adjust the yellow level. The bottom represents 0 (no yellow). The top 
represents 255 (maximum yellow).



Move from left to right to adjust the cyan level. The far left represents 0 (no cyan). The far right 
represents 255 (maximum cyan).

Move from bottom to top to adjust the magenta level. The bottom represents 0 (no magenta). The
top represents 255 (maximum magenta).



Move from left to right to adjust the saturation level. The far left represents 0 (minimum 
saturation). The far right represents 1 (maximum saturation).

Move from bottom to top to adjust the lightness. The bottom represents a lightness value of 0 
(black). The top represents a lightness value of 1 (white).



Move from left to right to adjust the hue. Think of colors as if they were arranged on a color 
wheel. The hues available from left to right in the field range from 0 to 360, where red is 0 (far left), yellow 
is 60, green in 120, cyan is 180 (middle), blue is 240, magenta is 300, and red, again, is 360 (far right).

Move from bottom to top to adjust the saturation level. The bottom represents 0 (minimum 
saturation). The far right represents 1 (maximum saturation).



Move from left to right to adjust the hue. Think of colors as if they were arranged on a color 
wheel. The hues available from left to right in the field range from 0 to 360, where red is 0 (far left), yellow 
is 60, green in 120, cyan is 180 (middle), blue is 240, magenta is 300, and red, again, is 360 (far right).

Move from bottom to top to adjust the lightness. The bottom represents a lightness value of 0 
(black). The top represents a lightness value of 1 (white).



With the dialog box displayed, you can quickly experiment with different settings.
Choose Undo Picture to cancel changes to your picture and keep the dialog box opened.
Choose Restore Settings to return the settings to their original values. Cancel becomes available 

to close the dialog box.
Choose Close to close the dialog box and use the new settings.



Drag an arrow or type a number to adjust brightness and contrast.
If Auto is available, select it to have your scanner automatically set a level. An X appears in the 

check box next to the option to show that it is selected.
For a video grabber, you can also adjust brightness and contrast in the Select Video Scan Area 

dialog box when you prescan.



Click to begin scanning or capturing the area.



Click to adjust some of the settings supported by your scanner or video grabber.



The available command is the opposite of the current Toolbox format.
An ungrouped Toolbox shows all of the tools and is larger than a grouped Toolbox.
A grouped Toolbox arranges similar tools together so the Toolbox is smaller.



The number of columns or rows changes, and the Toolbox remains grouped or ungrouped.



The available command is the opposite of your current Palette layout.



If you are working with a 256 color or black and white picture, the Rubber Stamp option is the 
only option used.



Standard US letter size, 8.50 x 11.00 inches.



Standard US legal size, 8.50 x 14.00 inches.



The size you type in the Horizontal Size and Vertical Size text boxes.



Standard US size, 11.00 x 17.00 inches.



Standard European size, 29.70 x 42.00 centimeters.



Standard European size, 21.00 x 29.70 centimeters.



Standard European size, 14.80 x 21.00 centimeters.



Standard European size, 17.60 x 24.00 centimeters.



A check mark appears indicating that the command has been chosen.



The check mark disappears indicating that the command has been deselected.



Choose Cancel to return to the work area.



    Box Selection, Magic Wand, Lasso, Scissors, Elliptical Selection



    Box, Rounded Box, Circle/Ellipse, Regular Polygon and    Polygon



    Airbrush and Spraycan 



You can use this command with 256 color and 24 bit color pictures.
Use Convert To to change the color mode of a picture.



If there are more pictures in the current drive, directory, and selected format than are displayed, 
use the scroll bar to display additional thumbnails.



You can also double-click a single picture to open it.



A check mark appears beside the command to show it is selected.



Hold down Shift while you drag to proportionally adjust the picture.



Choose Yes to abandon all changes.
Choose No to continue working on your picture.



PhotoFinish displays the type of enhancement that is being applied and the progress of the 
enhancements in the Progress box.

It is a good idea to clean off your scanner's glass before scanning.
If you are scanning an object that is smaller than the scanner's glass, place paper around the 

object to be scanned to cover the glass. This will improve the quality of your image.



PhotoFinish displays the type of enhancement that is being applied and the progress of the 
enhancements in the Progress box.



Choose Cancel to cancel the changes.



You can choose 90, 180, 270 degrees or you can specify a custom rotation.



Select Proportional Resize to have PhotoFinish automatically adjust your picture proportionally.



Select All selects the entire picture, making the entire picture a cutout surrounded by the 
marquee.



The selected area appears in a new picture window.



Select None is a handy way to start the selection process again if you make a mistake.



A copy of the cutout remains behind.
If you are dragging the cutout to a new location, you can release the mouse button and then drag 

again to place the cutout exactly where you want it.
You can also use the arrow keys to move a cutout one pixel at a time.



PhotoFinish displays preset maps, created for the device type, saved in the subdirectory named 
MAPS.



The selected background color is the color that will be used for clearing.



All adjusts all the colors in the picture and is the only channel available for gray scale.
If you are working with a color picture, choose a single color channel to adjust for color balance 

problems.



The Scan dialog box appears.



The second image is added to the active picture and is surrounded by the marquee.



You can also select multiple pictures.
Information about the selection is displayed in the status bar at the bottom of the dialog box.



The selected files appear as thumbnails.



The Progress box indicates completion of each step of the calibration process.



PhotoFinish automatically saves the file in the PhotoFinish subdirectory named MAPS and adds it
to the Preset Maps list.



You can choose to shade vertically, horizontally, or radially.



If you make mistake, click Restore to return to the original colors in your Palette.



Choose Restore to return all settings to the original values.
Choose Cancel to undo all color changes you have made and return to the main PhotoFinish 

screen.



If you are working with a 256 color picture, click Preview to see how the changes will affect your 
picture.

If you are working with a 24 bit color picture, the color changes do not affect the picture. You are 
simply changing the colors displayed in the color set and Preview is not available.



Palette color sets have a .PAL extension.



An X appears in the check box to indicate the option is selected.



This effect is available for 24 bit images only.
Use Convert To to change the color mode of a picture.



Select the option that applies most to the object you are scanning.
You can choose Auto to let PhotoFinish automatically set the color format.
Choose B/W Photo for a gray scale scan.
Choose Text/Line Art to scan text and line art without apply a halftone.
Choose Color Photo for a color scan. If your scanner does not support 24 bit color, PhotoFinish 

automatically converts the picture to 24 bit color before applying the corrections.



An X appears in the check box to indicate the option is selected.
Saturation is not applied to black and white line art and gray scale scans.



If you plan to use the picture for on-screen viewing, choose a Screen option.
If you plan to print the picture, choose one of the printer selections.
The printer resolution PhotoFinish uses depends on the Image Type you select.



The values you should specify depend on the output device for your image. Use the following 
general guidelines to help you determine the appropriate resolution.

If you are specifying resolutions for an ordinary printer, the resolution for Text/Line Art generally 
should match your printer's resolution. The resolution for Photo can be about 1/3 of your printer's 
resolution, depending on the halftones available to your printer.

If you are specifying resolutions for a "high-end" printer such as a film recorder, the resolutions for
both Text/Line Art and Photo should match the printer's resolution.

If you are specifying resolutions for on-screen viewing, both Text/Line Art and Photo settings 
should match your screen's resolution.



If you want to save your settings with a new name, type a description for your settings in the text 
box and choose Add.

If you want to delete the current Output selection, choose Delete.



You can also click the arrow on the right side of the Palette to fold and unfold the Palette.



The dialog box expands to display the additional options.



Use the Amount mini-scroll bar to specify the amount of sharpening you want. The higher the 
number, the greater the effect.

Select Wide Aperture to create a sharper effect. Selecting this option requires more time.



Use the Amount mini-scroll bar to specify the amount of blending you want. The higher the 
number, the greater the effect.

Select Wide Aperture to create a smoother effect. Selecting this option requires more time.



Positive numbers rotate the area clockwise.
Negative numbers rotate the area counter-clockwise.



Select Default Printer to use the current Windows default printer.
Click Specific Printer and select another printer from the drop-down list to use a printer other than

the Windows default printer.



    Line and Curve 



 Locator and Hand 



 Eraser and Color Replacer 



 Blend and Sharpen 



 

The Line and Curve tools may be grouped. Press on the white triangle and drag to the tool you 
want to use.



The Charcoal tool uses darker versions of the selected color to simulate an artist's charcoal.
The Chalk tool uses lighter versions of the selected color to simulate an artist's chalk.



The Zoom tool changes the magnification of a picture.



The Locator centers each duplicate of an image around the area you click.



The Hand moves the picture vertically, horizontally, or diagonally.



The Box Selection defines rectangular areas.



The Magic Wand defines areas with similar colors.



The Lasso defines irregular areas.



The Scissors defines polygonal areas.



The Elliptical Selection defines elliptical areas.



The Text tool adds text to the picture.



The Eyedropper selects a color from the picture.



The Eraser changes areas of the picture to the background color.



The Color Replacer changes the primary color to the secondary color.



The Local Undo tool undoes areas freehand.



The Paintbrush paints freehand with a soft brush.



The Pen paints freehand.



The Charcoal paints with a charcoal effect.



The Chalk paints with a chalk effect.



The Airbrush shades areas with a soft spray.



The Spraycan splatters colors.



The Paint Roller fills enclosed areas with color, a gradient, or a tile pattern.



The Line paints single or joined lines and tile pattern lines.



The Curve paints single or joined curves.



The Box paints boxes. Choose a filled tool type and fill with color, a tile pattern, or a gradient.



The Rounded Box paints rounded boxes.



The Ellipse/Circle paints single or concentric ellipses or circles.



The Regular Polygon paints single or concentric equal-sided polygons.



The Polygon paints polygons.



The Clone paints one area of the picture with another selected area.



The Color Pencil paints with a color pencil effect.



The Marker paints with a marker effect.



The Crayon paints with a crayon effect.



The Contrast Paintbrush adjusts contrast freehand.



The Brighten Paintbrush changes the intensity of colors freehand.



The Tint Paintbrush changes shades of color freehand.



The Blend Paintbrush smoothes areas freehand.



The Sharpen Paintbrush sharpens freehand.



The Smudge Paintbrush smudges colors freehand.



Select a tool type from the Tool Type drop-down list.



Click a button on the ribbon bar to choose a command or options related to the selected tool.



The Eraser and Color Replacer may be grouped. Press on the white triangle and drag to the tool 
you want to use.

The Color Replacer is available for 256 color, gray scale, and 24 bit color pictures.
Use Convert To to change the color mode of a picture.



Click this icon to move to the upper left corner of the picture.



Click this icon to move to the upper right corner of the picture



Click this icon to move to the lower left corner of the picture



Click this icon to move to the lower right corner of the picture.



Click this icon to move to the center of the picture.



Click this icon for more information about the selected tool and tool settings.



Click this icon to undo all changes since the last time you selected a tool or chose most 
commands.



Click an arrow to change the tool width one pixel at a time. 
Point to the middle of the Width mini-scroll bar, press the mouse button, and drag to quickly 

change the tool width.
You can also select the number in the Width text box and type the tool width you want.



Click the Shape drop-down list and select the tool shape you want.



Click to crop the picture. The defined area is copied to a new picture window.



Click to select the entire picture.



Click to quickly deselect a defined area.



Click an arrow to change the color tolerance one unit at a time for the red, blue, and green color 
channels.

Point to the middle of the Range mini-scroll bar, press the mouse button, and drag to quickly 
change the color tolerance.

Use the Tool Options command to select different ranges for each color channel.



Click this button to make the text bold.



Click this button to make the text italic.



Click this button to underline the text.



Click this button to create a text shadow in the primary color. 



Click this button to outline the text in the primary color.



Click this button to align text flush left.



Click this button to align text flush right.



Click this button to center text.



Click the Size drop-down list and select the size font you want.



Click the Area drop-down list and select Single Pixel, 3x3 average, or 5x5 average to set how the 
Eyedropper determines the color you pick up from the screen.



Click the Tool Type drop-down list and select a Paintbrush tool type.



Click the Pressure drop-down list to adjust the pressure of the tool.
If Custom is selected, you can adjust the amount of pressure in the Tool Options dialog box.



Click the Transparency drop-down list to adjust the transparency of the paint.
If Custom is selected, you can adjust the amount of transparency in the Tool Options dialog box.



Click this button to select a different paper type.



Click the Tool Type drop-down list and select an Eraser tool type.



Click this button to Clear the entire picture to the background color. 



Click this button to automatically change all instances of the primary color to the secondary color 
in the picture window. Zoom out if the picture is larger than the desktop.



Use the mini-scroll bar or type a number in the Range text box to adjust the color tolerance. The 
Range mini-scroll bar adjusts the red, green and blue color channels by the same amount. 

Use the Color Tolerance command to adjust the individual color channels by different amounts.



Click the Tool Type drop-down list and select an Airbrush tool type.



Click the Tool Type drop-down list and select a Spraycan tool type.



Click the Tool Type drop-down list and select a Pen tool type.



Click the Tool Type drop-down list and select a Charcoal tool type.



Click the Tool Type drop-down list and select a Chalk tool type.



Click the Tool Type drop-down list and select a Colored Pencil tool type.



Click the Tool Type drop-down list and select a Marker tool type.



Click the Tool Type drop-down list and select a Crayon tool type.



Click this icon to create a hollow shape.



Click this icon to create a filled shape with a border in the primary color. The shape is filled with 
the secondary color if you select Solid Color in the Tool Type drop-down list.



Click this icon to create a filled shape without a border.



Click the Font drop-down list to select another font.



Click the Tool Type drop-down list and select a Line tool type.



Click the Tool Type drop-down list and select a Box tool type. This option is available for the Box 
tool only.



Click the Tool Type drop-down list and select a Paint Roller tool type.



Click the Amount drop-down list and select the zoom level you want.



Click this button to quickly return to normal, one to one view.



Click this button to automatically zoom in or out so that the picture fits on the PhotoFinish 
desktop.



Click this button to automatically resize the picture window to the maximum PhotoFinish desktop 
size. This is useful when you have zoomed in on a picture window. 



Click the Amount drop-down list and select an amount. Use a preset option or choose Custom 
and adjust the Value setting.



If you have chosen the Custom Amount option, use the Value mini-scroll bar to change the 
amount of the tool's effect. 



Click the Tool Type drop-down list and select a Smudge Paintbrush tool type.



Click this icon to paint multiple copies of the clone source. This is the only option used with 256 
color or black and white pictures.



Click this icon to start a new picture. 



Click this icon to open a previously saved picture 



Click this icon to save changes to the picture. Use the Save As command to save a picture for the
first time, with a new name, in a different format, or to a different drive or directory.



Click this icon to cut a defined area from the picture and place it on the Clipboard.



Click this icon to copy a defined area to the Clipboard.



Click this icon to paste the contents of the Clipboard into the picture.



Click this icon to undo changes made to the picture since the last time you chose a tool or most 
commands.



Click this button to automatically enhance the entire picture. This button is available for 24 bit 
color and gray scale pictures only.



Click this icon to automatically straighten the entire picture. This icon is available for 24 bit color 
and gray scale pictures only. 



Click this icon to automatically crop the edges of the picture. This icon is available for 24 bit color 
and gray scale pictures only.



Click this icon to automatically adjust brightness and contrast in the entire picture. This icon is 
available for 24 bit color and gray scale pictures only.



Click this icon to automatically adjust saturation in the entire picture. This icon is available for 24 
bit color pictures only.



Click this icon to automatically remove moiré patterns from the entire picture. This icon is 
available for 24 bit color and gray scale pictures only.



Click this icon to automatically sharpen the entire picture. This icon is available for 24 bit color 
and gray scale pictures only.



Click this button to automatically scan an image. This button is available only if you have installed
a scanner to use with PhotoFinish. 



The larger the percentage, the larger the picture appears.



This is useful when you have zoomed out and then zoom in on a picture window. Click the Fit To 
Zoom button to see as much as the picture as possible on the desktop.



Select values for the Red, Green, and Blue color channels.
Depending on the picture, values that give good results range from about 10 to 50. A value of 30 

is a good place to start.
To affect a single color, set the values to 0.
Select Identical Values to set all the ranges at the same values.



You can select Regular, Bold, Italic, or Bold Italic from the Font Style list.
You can select Underline, Shadow, and Outline in the Effect box.
Underlines are in the secondary color.
Shadows and outlines are in the primary color.



You can select to place text flush left, flush right, or centered.



Use the Range mini-scroll bar to set identical values for the Red, Green, and Blue color channels.
Use the Tool Options command to select different ranges for each color channel.



Choose Basic to fill with color.
Choose Gradient to fill with a gradient that begins with the secondary color and ends with the 

background color. Use the Gradient Type command to adjust the gradient.
Choose Tile to fill with a tile pattern. Use the Tile Pattern command to load a tile pattern.



If you have selected the Basic Paint Roller tool type, click with the left mouse button to fill with the
primary color, the right mouse button to fill with the secondary color.



Select Hollow to paint a hollow shape. The outline of the shape is in the primary color. Use the 
Width mini-scroll bar to adjust the width of the outline.

Select Filled With Border to paint a shape filled with the secondary color and outlined by the 
primary color. Use the Width mini-scroll bar to adjust the width of the outline.

Select Filled Without Border to paint a shape with the secondary color.



Type a number or use the Width mini-scroll bar on the ribbon bar or in the tool's Tool Options 
dialog box to change the tool's size.

If you have selected the Tile tool type, adjust the width to set the distance between the tile 
patterns. The higher the number, the greater the distance between the tile patterns.

Click the Shape drop-down list on the ribbon bar or in the tool's Tool Options dialog box and 
select the shape you want. This option affect the Basic Line tool type only.



Choose Basic Line to paint a line with the primary color.
Choose Tile to paint a line with a tile pattern. Use the Tile Pattern command to load a tile pattern.



Select a preset Amount or choose Custom and adjust the Value setting. The larger the Value 
setting, the greater the effect.



Straighten rotates a crooked scanned image.
Crop trims the edges of a picture. 
Brightness lightens or darkens the picture, similar to dodging and burning when printing a 

photograph.
Contrast changes the contrast in a picture.
Saturation adjusts the intensity of the colors in the picture. This option is available for 24 bit color 

pictures only.
Remove Moiré removes moiré patterns that sometimes occur in scanned pictures.
Sharpen sharpens a picture.



Use Crop to copy a defined area into a new picture window.
Use Auto Crop to automatically trim the edges of a picture. You can use this command with gray 

scale and 24 bit color pictures. Use Convert To to change the color mode of a picture.



Use Tune Brightness and Contrast command on the Image menu to manually adjust the 
brightness and contrast in a cutout or the entire picture.

Use Auto Brightness/Contrast command on the Image menu to automatically adjust the 
brightness and contrast in the entire picture. You can use this command with gray scale or 24 bit color 
pictures. Use Convert To to change the color mode of a picture.



Use Filter Remove Moiré to remove moiré patterns in a cutout or the entire picture.
Use Auto Remove Moiré to automatically remove moiré patterns from the entire picture. 
You can use these commands with gray scale and 24 bit color pictures. Use Convert To to 

change the color mode of a picture.



Use Tune Hue and Saturation to manually adjust saturation in a cutout or the entire picture.
Use Auto Saturation to automatically adjust saturation in the entire picture. 
You can use these commands with gray scale and 24 bit color pictures. Use Convert To to 

change the color mode of a picture.



Use Filter Sharpen to manually sharpen a cutout or the entire picture.
Use Auto Sharpen to automatically sharpen the entire picture. 
You can use these commands with gray scale and 24 bit color pictures. Use Convert To to 

change the color mode of a picture.



Use Transform Rotate to manually straighten a cutout or the entire picture.
Use Auto Straighten to automatically straighten the entire picture. You can use this command with

gray scale or 24 bit color pictures. Use Convert To to change the color mode of a picture.



An X appears on the sample button for unavailable filters.
Diffuse and Remove Spots are the only filters available for 256 color pictures. Remove Spots is 

the only filter available for black and white pictures. Use Convert To to change the color mode of a picture.



A dialog box with samples for the selected command appears. You can select the effect you want 
or choose Advanced to manually adjust the settings.



If the sample buttons display an X, click the Show Samples option to display the samples. 



Use the Width and Height mini-scroll bars to specify the amount of the effect you want. The 
higher the numbers, the greater the effect. You can select a number from 1 to 6.



Use the Width and Height mini-scroll bars to specify the amount of the effect you want. The 
higher the numbers, the greater the effect. You can specify a number from 1 to 6.

If you are working with a 24 bit color picture, select Allow Color Shift to introduce multi-colored 
pixels to the picture.



Use the mini-scroll bar to set the number of colors you want to keep in your picture. You can 
select from 2 to 64 color levels. The picture's color mode remains the same.

Keep in mind that reducing colors can create a "flattened" effect in your picture.



An X appears on the sample button for unavailable special effects.
Black Hole, Crumple, Crystallize, Fisheye Lens, Outline, Pixelate, and Twist are the special 

effects available for 256 color pictures. Outline is the only special effect available for black and white 
pictures. Use Convert To to change the color mode of a picture.



Use the Amount mini-scroll bar to set how much of the paper texture will appear. You can specify 
a number from 1 to 100. The higher the number, the more of the paper appears.

Use the Depth mini-scroll bar to set how deeply the texture is embossed in the picture. You can 
specify a number from 1 to 5. The higher the number, the more the texture is embossed.



A sample of the selected paper appears in the sample box.



Surface determines how many of the peaks and valleys of the paper surface appear in the 
picture.



Click Horizontal or Vertical to set the direction of the grain.
Click Invert to reverse the grain of the paper.



You can use this command with 256 color, gray scale, and 24 bit color pictures.
Use Convert To to change the color mode of a picture.
If you are crumpling the entire picture, first create a new picture that is 25% larger than the picture

you want to crumple. Paste the original picture in the center of the new picture window. Apply the 
command to the new picture, and then crop to remove any unwanted margins.



Use the Amount mini-scroll bar to select the amount of the crumple effect. You can select a 
number from 1 to 10. The higher the number, the more crumpling occurs.

If you are working with a 24 bit color picture, select Allow Color Shift to introduce multi-colored 
pixels to the picture.



Use the Sensitivity mini-scroll bars to adjust how many edges are detected. You can select a 
number from 1 to 5. The higher the number, the more edges are outlined.

Select a color from the Color drop-down list for PhotoFinish to use to fill the outlined areas.
Select the color of the outlined edges you want detected from the Edge drop-down list. Usually, 

Auto gives the best results.



Use the Depth mini-scroll bar to adjust how much pressure is used to emboss. You can select a 
number from 1 to 5. The higher the number, the more pressure is used.

Select a color from the Color drop-down list to determine the overall color used in the embossed 
image.



Use the Speed mini-scroll bar to adjust how much motion blur as added to the picture. You can 
select a number from 1 to 50. The higher the number, the faster the motion appears.



Use the Width and Height mini-scroll bars to adjust the sizes of the blocks. You can choose a 
number from 1 to 16. The higher the numbers, the more distortion appears.



Use the Amount mini-scroll bar to adjust how much of the texture is applied. You can select a 
number from 1 to 100. The higher the number, the more texture is applied.

Click Invert Texture to invert the pattern of the texture.



Use the Size mini-scroll bar to adjust the size of the blocks of pixels that are twisted. You can 
choose a number from 1 to 10. The higher the number, the larger the blocks of pixels.

Click the Angle drop-down list and select the angle for the pixels to be twisted. 
If you select Random as the angle and the picture is 24 bit color, select Allow Color Shift to 

introduce random colors into the picture.



To create a new calibration map, click New in the Calibrate dialog box.



To recalibrate a device, first create a calibration map based on the Default or another preset map.
Click Options in the Calibrate dialog box and then click Recalibrate. 



To edit a calibration map, first create a calibration map based on the Default or another preset 
map. Click Options in the Calibrate dialog box and then click Edit.



Use the Brightness and Contrast mini-scroll bars to manually adjust the brightness and contrast. 
You can select a number from -100 to 100. 

The farther the number is from 0, the greater the effect.
As a rule of thumb, increase contrast about the same amount you increase brightness.



Select this icon to leave a copy of the original cutout behind when you cut, delete, or move the 
cutout.



Select this icon to paste cutouts transparently. Areas in a cutout that contain the selected 
background color are transparent when you paste the cutout.



Use the Hue mini-scroll bar to specify how much the colors should shift around the color wheel. If 
you type 60, you shift all colors 60 degrees: red colors become yellow, yellow colors become green, etc. 
180 degrees reverses the colors in your picture.

Use the Saturation mini-scroll bar to specify the amount of hue you want to add or remove. You 
can use any number from -1 to 1. Negative numbers decrease saturation by adding gray.



This command also is available on the picture's Control menu.



The higher the number, the more light colors appear in the gradient.



You can select a number from -100 to 100.
Brightness determines how light or dark the palette is.
Contrast affects midtones.



Hue determines which color to add to all the colors that appear in the Palette. 



If you are working with a 256 color picture, the picture may change when you load a different 
palette.

If you are working with a 24 bit color picture, the color changes do not affect the picture. You are 
simply changing the colors displayed in the color set.



Choose Apply Paper from the Image menu and click the Paper button to load a new paper and 
apply the paper to the entire picture or defined area.

Choose Paper from the Options menu to load a new paper. The paper appears when you use a 
tool and tool type that uses paper.



Displays labels above the ribbon bar for the available tool options.



This preference option is available if your Windows display driver displays fewer than 16 levels of 
gray.



Hold down Shift while clicking or dragging to constrain the tool vertically, horizontally, or at a 45° 
angle.

The polygonal area can have up to 200 sides.



Hold down Shift while you drag to constrain the defined area to a circle.



Select a preset Amount or choose Custom and adjust the Value setting. Positive numbers 
increase contrast. Negative numbers decrease contrast. The farther the Value setting is from 0, the 
greater the effect.



Select a preset Amount or choose Custom and adjust the Value setting. Positive numbers 
brighten areas you drag over. Negative numbers darken areas you drag over. The farther the Value 
setting is from 0, the greater the effect. 



The Blend Paintbrush and Sharpen Paintbrush tools may be grouped. Press on the white triangle 
and drag to the tool you want to use.

You can use these tools with gray scale and 24 bit color pictures.
Use Convert To to change the color mode of a picture.



For best results, you should calibrate your scanner, then your printer, and finally your monitor.



The duplicate picture appears in a new window at the same magnification as the previous window
and is added to the Window menu picture list.



An X appears on the sample button for unavailable commands.
Hue and Saturation is available only for 24 bit color pictures. 
The only Tune command available for black and white pictures is the Negative command.



If the Zoom tool is selected, click the Zoom To Fit button on the button bar to quickly zoom the 
picture.



Amount determines how much of the selected hue to add to the colors in the Palette.



File Select Source Command -- Selecting a TWAIN Source 

To select a TWAIN source:    

1 Choose the Select Source command on the File menu.    
2 Click the source you want to use.    

Related Topics:
Acquiring an Image with a TWAIN Device
Scanning a Picture



File Acquire Command -- Acquiring an Image with a TWAIN Device 

To scan with a TWAIN device:    

1 Select the source you want to use.    
2 Select the Acquire command on the File menu.    

Related Topics:
Scanning a Picture
Selecting a TWAIN Source



Use the Select Source command on the File menu to select your source.
This command appears only if your scanner or video grabber supports the TWAIN standard 

interface.
If you installed your scanner for PhotoFinish, you can also use the Scan command on the Scan 

menu to scan or capture an area.



Use the Acquire command on the File menu to scan or capture the area you want.
If you installed your scanner for PhotoFinish, you can also use the Scan command on the Scan 

menu to scan or capture an area.



This command appears only if your scanner or video grabber supports the TWAIN standard 
interface.

The dialog box that appears when you choose Acquire differs depending on the brand of your 
scanner or video grabber.

The scanned image is loaded into a new picture window in PhotoFinish.
If you installed your scanner for PhotoFinish, you can also use the Scan command on the Scan 

menu to scan or capture an area.



TWAIN
TWAIN is a standard interface that allows applications to acquire images from many different sources. 
The source may be a scanner, video capture board, or other input device that complies with the TWAIN 
specification. If you want to use PhotoFinish's scanning capabilities, install your scanner with the 
PhotoFinish setup program.



Working with Embedded Pictures 

You can use PhotoFinish to embed or link pictures in other applications that support Object Linking and 
Embedding (OLE).

If you link a PhotoFinish picture, your source picture is in a file that is separate from the 
destination file. You can open the picture in PhotoFinish, make changes and save it using the File Save 
command, and the destination application will automatically update the linked picture.

If you embed a PhotoFinish picture, your picture becomes part of the destination file. You can 
make changes to the picture only by opening the destination file and choosing the embedded picture. 
Double-clicking on the embedded picture automatically opens PhotoFinish with the embedded picture 
loaded in a picture window. If only a portion of the original picture file is embedded, the entire picture 
appears and the embedded portion is surrounded by a box. You use the File Update command to update 
your changes in the destination file.

If you are working with an embedded PhotoFinish picture, several of the commands in the File 
menu change. Save becomes Update, Save As becomes Save Copy As, and Exit becomes Exit and 
Return To.



File Update Command -- Updating an Embedded Picture 

You use the Update command to update the destination file's version of the picture without exiting 
PhotoFinish. 
To update an embedded picture:

Choose Update from the File menu.    

Related Topics:
Saving a Copy of an Embedded Picture
Saving Your Picture with Save
Working with Embedded Pictures



File Save Copy As -- Saving a Copy of an Embedded Picture 

You use the Save Copy As command to save a copy of an embedded picture to a file on disk. This 
command is similar to the Save As command.
To save a copy of an embedded picture:

Choose Save Copy As from the File menu.    

Related Topics
Updating an Embedded Picture
Working with Embedded Pictures



File Exit and Return To Command -- Exiting and Returning to the Destination 
Application 

You use the Exit and Return To command to end your PhotoFinish session and return to the destination 
file. 
To exit and return to your destination application:

Choose Exit and Return To from the File menu.    

Related Topics:
Exiting PhotoFinish
Working with Embedded Pictures



embedded object
Information that is created in a server application and inserted into a client application. You can edit the 
information from within the client file.

PhotoFinish is a server, or source, application. You can create a picture in PhotoFinish and embed the 
picture in a client, or destination, application, such as Windows 3.1 Write.



linked object
A placeholder for information that is inserted into a client file. The information still exists in the server file. 
When the server file is changed, the linked object is updated to reflect these changes.

PhotoFinish is a server, or source, application. You can create a picture in PhotoFinish and link the picture
in a client or destination application, such as Windows 3.1 Write.



Updating does not save the picture as a separate file. 
Use Save Copy As to save a copy of the PhotoFinish picture to disk.
Use the destination application's File Save command to save the updated picture as a part of the 

destination file.



The Save Copy As command does not update the embedded picture in the destination file -- you 
use Update to update an embedded picture.

Unless you save the picture to disk using the Save Copy As command, you cannot load it except 
by choosing the embedded picture in the destination file.



If you have made changes to a picture since the last time you updated it, a message box appears
asking if you want to save the changes before you exit PhotoFinish. 

Choose Yes to update the embedded picture in the destination file. 
Choose No if you want to exit PhotoFinish without making any changes to the embedded picture. 
Choose Cancel if you want to continue to work on the picture.



If you select File Open while working with an embedded picture, PhotoFinish loads the picture 
into a separate picture window that does not affect the embedded picture.



If you are working with an embedded picture, the File Exit and Return To command replaces the 
File Exit command. 




